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About Policy Workflow

Policy Manager enables the management of enterprise policies on a single centralized platform. Organizations can enforce policy and process
standards across different locations, departments, and programs. Policy Manager supports simultaneous policy editing across multiple stakeholders
using a rich WYSIWYG user interface. An organization can automate processes for policy authoring, reviewing, and approval. Policy templates help
enforce consistent formatting and structure. Policy Manager has a highly configurable workflow enabling an organization to enforce change control
and maintain accountability. Policy Manager supports policy awareness campaigns with policy distribution, attestation, and comprehension testing

tools.
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Other RiskVision Applications

Other RiskVision applications are listed in the table below:

ICON APPLICATION

Compliance

Manager

@ Enterprise Risk

Manager

Vendor Risk

Manager

Threat and

B Vulnerability

Manager

Incident Manager

DESCRIPTION

Compliance Manager allows organizations to effectively manage and measure compliance programs
across multiple regulations, standards, and frameworks. It also automates the compliance process
through general computer controls (GCC) and questionnaires. The evidence and control results can
be automatically collected through connectors or questionnaire results from business users.
Copmliance enables data classification, ownership configuration, compliance assessment,
mitigation, and reporting. It supports popular frameworks, standards, and regulations such as ISO
27002, CIS, HIPAA and PCIl, and others. Compliance Manager improves process efficiency and

integrity as well as data quality and reliability.

Enterprise Risk Manager is a comprehensive risk lifecycle management solution. Organizations can
use this application to identify, assess, and mitigate risks using an appropriate risk treatment plan.
Its flexible risk model supports both qualitative and quantitative methodologies, including the
calculation of inherent risk, current risk, and residual risk within the context of mitigating controls. It
features rich reports and dashboards, as well as easy to use risk assessment tools and will help your
orgnization understand and monitor its enterprise risk posture. Enterprise Risk Manager includes

out-of-the-box support for popular risk methodologies, such as COSO, AZ/NZS 4360 and ISO.

RiskVision Vendor Risk Manager enables organizations to audit and manage third-party risks, as
mandated by regulations and standards such as ISO 27001, PCI, and FISMA. RiskVision Vendor
Risk Manager classifies, assesses, and reports on third-party risk based on the standard control
framework from shared assessment programs or an organization's custom control framework. It
provides a portal where vendors participate in assessments and the results are retrieved by an
organization's risk analysts. Vendors are classified automatically into appropriate tiers and
applicable controls are applied based on the vendor tier. Powerful delegated administration and

automation features enable RiskVision Vendor Risk Manager to scale to large vendor populations.

Threat and Vulnerability Manager will help you consolidate your threat and vulnerability programs
onto a single platform. It integrates with vulnerability and early warning data feeds from iDefense
and National Vulnerability, and correlates these feeds with vulnerability scanner results to eliminate
false positives and report incidents. Inferred scans are performed by correlating the vulnerability
data feeds to a company's RiskVision asset database, mitigating risks for assets not reachable by
vulnerability scanners. Once detected, vulnerabilities are assessed and remediated using the

system's workflow for true closed-loop vulnerability management.

Incident Manager helps organizations collect, classify, and manage multiple IT and non-IT incidents.
It is a single collection point for all incidents that are manually and automatically reported. It imports
incidents reported from most monitoring systems and scanners, as well as Security Incident
Management (SIM) solutions. All incidents, including business, operational, and environmental, can
be reported using the incident-reporting portal. Incidents are assessed based on configurable
workflows and automatically created and classified based on rules that are tracked throughout the
incident's lifecycle. Incidents are tied to controls, policies, and risk to provide closed-loop feedback

for policy and control assessment and risk monitoring. Incidents are rated based on their criticality
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so that organizations can respond based on the impact to the business.
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Log into RiskVision

Your login account may be identical to your Active Directory credentials, or a new ID may have been created for you within the RiskVision Enterprise

Risk Manager. Contact your Administrator for your credential information.

For more information on default accounts, please refer to the Installation & Configuration Guide or contact your Resolver Customer Support
representative.

To access the application using a web browser:

1. Open a browser and enter the RiskVision URL.

RISK VISION

RESOLVER

Login

Login ID: ||
Password:

Forgot your password?

The RiskVision login screen.

2. For example, https://RISKVISION, where RISKVISION is the hostname or IP address for the Resolver RiskVision Server.

Depending on your browser, you may see a message like "Web site certified by an unknown authority." To avoid seeing these types of
messages in future sessions, accept the certificate permanently.

Enter the user name or e-mail and password that is specific to your domain, select a domain if the Domain drop-down list is available, and
then click Log In.

The first time you log in, the License Agreementis displayed.

4. Click Accept to continue. The Welcome page is displayed.
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Log in as a Delegate

You can log into the account of another user if that user or a RiskVision administrator nominates you to access the delegation. To learn how to
delegate your RiskVision user account, see Delegating Your RiskVision User Account.

To access a delegated user account:
1. Open a browser and enter the RiskVision server URL.

2. Enter your Login ID and Password, then click Log In.

3. Click Login as and select a user account other than Myself, then click Log In. Myself will log you in to your user account.

RISK VISION

powered by RESOLVER

Some users have delegated their access to you please select user account to login.

Out of Office Delegation

Login as | Myself V|

Log In

The Out of Office Delegation screen.

When you are logged into a delegated user account, you can perform any task permitted by that user's account permissions on behalf of that user.

When the delegated user logs into RiskVision, the Current User will appear as Logged in as: delegated by [username].
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Reset Your Password

If you've forgotten your password, you can set a new one right away with no assistance required from your RiskVision administrator.

To reset your password:
1. Open the login page.

2. Click the Forgot your Password link.

3. Enter the email address that has been registered in the RiskVision Server in theEnter Email Address field.

Forgot Password?

We'll send you a message with a special link
that will allow you to reset your password.

Enter Email Address | |

The Forgot Password page.

4. Click Submit. An email containing the link to reset your password will be sent to your mail box.

5. Click the link in the email to open the Change Password page.

Change Password

New:

Confirm: |

The Change Password page.

6. Enter a new password in the New and Confirm fields.

7. Click Submit.

To log on with your new password, see Logging in With Your New Password.
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Log in With Your New Password

After you reset your password using the Forgot Your Password link on the login page, you can log in with your new password. Make sure that you
close all your browser windows and then launch the application in a new browser window.

16



Get Started with RiskVision

All logged in users of any RiskVision application are directed to the Welcome page, on the Home menu. The Welcome page contains active tasks
and messages which require your attention. The tasks are divided into categories and displayed as sections with links. If you're not a stakeholder in
any task, you will not see any links in the sections.

By default, each section will show up to five items, although you may own more tasks. By clicking the Go to... link below the section, you will be
navigated to the respective page of that section, on the Home menu, to view the exhaustive list of items. Besides accessing sections, the Welcome
page also provides Quicklinks to pages so that you can be directed to the desired area instead of having to manually navigate trough the RiskVision
applications.

Here's the complete list of pages on theHome menu, which appear based on your role and the RiskVision application you're using:

e Welcome
e Message Center
e Findings
e Risk Register
e Risk Responses
e Questionnaire
e Submitted Questionnaires
® Tickets
e Exception Requests
The pages above will help you to view, edit, or update the list of do-able items, and these tasks can also be accomplished from other points in

RiskVision applications. Stakeholders who will not need to participate in ITGRC projects can access these pages on the Home menu. The user
interface of each page can be customized to fit your business needs.

Before moving on, we recommend familiarizing yourself with the navigation, tree and grid, actions, user settings, and advanced search. For more
information, see Navigating in RiskVision.
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Navigate RiskVision

RiskVision Policy Manger pages use a consistent interface, to easily navigate no matter where you are in the application.

R IS K VI SI 0 N pU“Cy Manager | Wewe 4 | UserSettings | [GF|Configure Ul | Help | Log Out

LT Content | Entities | Assessments | Analytics | Configuration

Welcome  Message Cenier Quesfionnaires Submitied Questionnaires Tickets Exceplion Requesis

The navigation ribbon in Policy Manager.

Selecting a different application changes the menus. The specific menus and submenu choices available depend on the current application and the
permissions assigned to your user role.

Hovering the mouse over a menu, such as Home, displays a dropdown submenu of items. You can quickly view a snapshot of the available pages by
moving the mouse over each menu.

Clicking a menu selects it and displays its submenu items. If your browser window is narrow, there may be more submenu items under the menu
than what is visible.
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Using the Tree and Grid View

Many pages in the RiskVision solution display a hierarchical tree on the left and a tabular grid on the right side of the screen. The tree and grid
function in the familiar way that files and folders are shown in Operating Systems like Microsoft Windows.

For more information about the grid side of the tree and grid view, see Using the Grid View.

¢ Confrols & Questi aires Choice Template: Choice Templates
Choice Templates Actions w

1-4 of 4
=" Controlzs & Cuestionnaires

=l RiskVision Content

Mew Choice Template l [ Delete l [ Details ] | More Aclions... ‘l'i

=l Contrels

|| Type Order a Title
=l Automated Controls

I+ Vulnerabilities

J 1 Default Choice Template
I+ Standards o IE .
I+ Cuestionnaires
o L IE 2 Moles Choice Template
=l Organization Content
=l Organizational Document IE
J 3 PassfFail Choice Template
I+ Contracts o F
Contrels
. L IE 4 Yes/Mo Choice Template
e' =l Choice Templates

'@ m Default Choice Templ
m MNorves Choice Templ
m PassiFail Choice Tem
m ‘Ves/MNo Choice Templ

Cuestionnaires

+| By Category

The Tree and Grid view.

1. Selected node

2. Actions pulldown
3. Root node

4. Folder

5. Object

To adjust the width of the tree view, click the splitter, the vertical bar between the panes, and drag it to right or left. To hide the entire tree view,
move the splitter all the way to the left, or click the minimize button at the top of the tree pane. To view the tree again after it has been minimized,
click the splitter—parked on the left edge of the window—and drag it to the right.

Clicking on an item in the tree pane will display its name in the Selected Node window. Clicking the Actions will bring up a list of actions that can be
performed on the selected item, such as refreshing, copying, or deleting it. The contents of the tree pane vary considerably. Some pages use the tree
to differentiate read-only content from read-write Organization content, for example. Some trees group the objects you own--My Dashboards, for
instance--separately from shared objects and archived objects.

Certain trees include objects. When you click on an object in the tree, the detail pane for that object replaces the grid pane. In other cases, the tree
only includes folders. Clicking on a folder or a dynamic group usually displays the objects it contains in the grid pane.

Selecting different nodes of the tree have different effects:
Target Description

Root / May display a grid view showing all objects, or may display a landing page (such as Analytics> Dashboards). The initial view
Initial is usually similar to selecting the root of the tree. Selecting the root of the Entities tree is special: it displays a details view

view for all entities, summarizing the set and providing a convenient place for manually creating an Entity.

Folder = The contents of the folder appear in the grid.
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TSRt pEb&hriaits view for the selected object replaces the grid view.

Certain root or initial view pages include action buttons, such as thelmport Content (XML) button on the Content > Controls and Questionnaires
page the Import Policies (XML) button on the Content> Policies page.

20



Use the Grid View

The grid view is used throughout RiskVision to display a table of objects (users, programs, connectors, and so on) and their attributes. Each row in the
table represents an object, and the columns reflect some of the object's attributes. In some cases, you can customize the columns and how they
display particular attributes.
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Sort the Table

To sort the table by any visible attribute, click that attribute's column heading. To reverse the sort (ascending order instead of descending), click the
column heading again. To make a hidden attribute visible, see Customizing the Columns in the following sections.
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Refresh

The table represents a snapshot of the underlying data at the time it was first displayed. Some data, such as Charts in Progress, are more dynamic,
but all objects can change over time. To update the display with the latest data, click the Refresh button.
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Limit the Number of Rows

The grid view may show all objects of a particular kind, such as Ownership Types, or it may show only the contents of the selected dynamic group.

Filter by | Title v | [cErT —

Filtering the grid.

Enable Focus

To focus on objects of interest:
1. Click the Filter by dropdown and select an object attribute.

2. Enter a value. Press Enter. For text attributes, the value is a case-insensitive, "begins with" query.

To remove the filter and show all rows, select Show all from the filter pull down list, or clear the value and hitEnter.

Enable Grids

Certain grids, such as Entities, Vendors, and all grids on the Vulnerabilities menu, contain the Advanced Filter to help you locate the objects using one
or more advanced search conditions.

To enable the advance search feature in a grid:

1. Select Advanced Filterin the Filter by dropdown list or click the . icon next to the Filter by drop-down list. You can also click Float to
perform a search in the Search dialog.

2. Optional: Click + to add more search conditions. You can add a maximum of six conditions. Depending on the field selected, comparison
operators and search input varies, and appears in their respective dropdown lists. The search value must be either entered in the text box or
selected from the dropdown list.

Example: To search computer entities owned by a user named Administrator:

1. Select Primary Owner in the first dropdown list.

2. Select Equals in the second drop-down list.

3. Select Administrator in the third drop-down list.

4. Select 'Type' 'Equals' 'Computer,' and click Search.

5. Optional: If you're performing a search in the Search dialog, click OK after the selecting the search conditions. The results matching the
search conditions are displayed in the grid.

™ Vulnerabilities

< [Owner v | [ Equals v | [Administrater | [ search | [ minimize | [ Fioat |

X [ severity v | [ Mot equals v | [Hignl |

The Advanced Search filter.

6. Click Minimize.

7. Optional: To re-expand the Advanced Filter, click
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Change the Grid Header Mode

A RiskVision object grid can have various numbers of rows on any page. As a result, you can only view a certain number of rows in a browser, whose
dimensions vary according to your monitor's size. When you scroll down the grid in a browser to view the remaining objects, the grid header row
moves along with other rows.

Page 1 2 Goto-_ ] |
Fitter by | - Show all - |+ | | Refresh @

I
|Switch between fixed and Foating header I

Click the icon next to Refresh to select a
fixed header.

To prevent the header row from moving, click the icon next to theRefresh button.
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Actions

Grid views often have buttons such as New, Details, or Delete. The appearance of these buttons depends on the context, the current application, and
your user privileges. If you are allowed to create objects here, for example, the New button will be shown. To delete one or more objects, check the
box to select the rows to remove and click Delete.

The More Actions... dropdown list offers other, context-specific actions, such as import, export, copy to, or move to. Actions such aslmport are
general, but most actions require selecting one or more rows. In the Home > Questionnaires view, each row has an Actions dropdown.
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Details

There are multiple ways to display and update an object's attributes. From the grid view, check the box to select the desired object and then click

Details. In some cases, the Details action is found in the More Actions... dropdown list. In many grid views, the object's name or title is a link that
serves as a shortcut to its details.

Some kinds of objects do not have details. Some, such as the Home > Questionnaires view, have links to more than one kind of object (in this case,

entities and questionnaires). Details can be displayed in the lower half of the grid view in a popup window, or the details view can replace the entire
grid view. Click Back to return to the grid view from the details view.
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Customize the Columns

In most grid views, you can specify exactly which attributes must be displayed as columns in a given grid view, and you can choose whether
attributes must be shown graphically or as text or other options.

To customize the columns:
1. Open the More Actions... dropdown list.

2. Click Customize.

Customize Grid Columns b4

e
Available Columns Selected Columns
[ICON
[='  Available Columns IE.Iame]
O [ ncony Tves
B Subtype
¥ (] Name
o T Cwner
- D ype » Description '
(] El Subtype
U [ citicatity 4= ‘
(] El Owner
1 [ ] Description
(] El Tracked since
Column Formatting Sorting
Header [Criticality | Order
Style | Bar Criticality Percentage v
Supgested width pixels
Truncate to :l characters
Alignment | Default T
Font type | Helvetica v
B - - -
m ( Cancel )

The Customize Grid Columns dialogue.

In the Customize Grid Columns dialogue, the object attributes that can be used as grid columns are listed in the Available Columns box
The current columns are listed in display order in the Selected Columns list.

3. Optional:

a. Add a column to the Selected Columns list:
i. Check the box next to a column in the Available Columns list.

ii. Click the right arrow pointing from the Available Columns to the Selected Columns list.

b. Remove a column from the Selected Columns list:
i. Select a column in the Selected Columns list by clicking on it.

ii. Click the left arrow that points from the Selected Columns back to the Available Columns list.

c. Specify the format details of a column:
i. Click a column name to select it in the Selected Columns list.

ii. Optional: Edit the Format > Header field to change the column name.

iii. Optional: Click the up or down arrow to change the order.

Customizing Grid Columns has no effect on the underlying data.
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Pagination
Large numbers of rows are shown in pages at a time. When the grid view is not displaying all rows of a table, the following pagination controls
appear.

3 Email Templates
1-20 055 Show [20 ¥ | rows Page 123 GutalIl
[ New] [ Details ] [ Delele] | More Actions... ‘l':

Fiter by - Show all- v |[ Refresh | @

RiskVision's pagination controls.

The controls on the left adjust how many rows are displayed per page (between a minimum of 5 and a maximum of 500). The controls on the right
allow for page navigation. The currently selected page is displayed in the text box. To navigate to another page, click the desired page number or the
right and left arrow keys (for more than 5 pages). If the desired page number is not visible, type the number into the text box and click Go to navigate
to that page.
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Common Features

A number of common features can be seen in many objects throughout the RiskVision application. Here is a list of common features you should
understand before learning about other RiskVision features:

e User Settings

e Delegation

e Advanced Searching
e Documents

e Applications

e Rich Text Editor

e Actions

e Visualization
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View Your Team

You often work in a team no matter what task you perform in the application. If you're handling multiple responsibilities, you may be associated with
more than one team. Knowing the members of teams can help you pose questions to users who have worked on the same projects in the past, or
who are currently working on similar projects in a different team.

To view your team:

1. Click User Settings in the upper right corner of the application, then click the Teams tab.

User Settings

W Teams
1101

A Not secure | hitps)//10.11.1.59/spc/detail jsp?id =HBOeHz JCNEQRrBuYekOFe2 IMmk)JgXyzt W3Zp2p34idSSVEUAKgWpA
[of Edit %5

&L Team: Incident Response Executive Team

| Information ‘

User Information
Change Password

Team:
Dashboards

Click to view te:

General

Name IRT Executive
. ame Incident Response Executive Team
S Lol tion Incident Response Executive Team

W Team Members
1-10f1

Add Team Members | = Details | | Remove

Middle Name

Filter by | - Showall- ¥ | | Refresh '

Domain

Last Name Roles

Ticket Administrator,
Technical Analyst,
Questionnaire
Responder, Internal
Auditor, Incident
Administrator, Finding
Administrator,
Executive, ConfigUl,
Asset Owner, Analyst,
Administrator

[ FirstName

O admin Admin NiA

The Teams tab.

2. Click the display name of a team to view the other members of that team.

3. Click the first name of a user to view their teams. Depending on your role and permissions, you can add or remove members from a team,
modify general settings of a user, or manage roles assigned to a user.

For information about roles and teams, see the RiskVision Administrator's Guide. For information about roles and teams, see Configuring a Role,

Managing Teams and Creating Teams.
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Delegate Your RiskVision User Account

The access delegation feature allows you to take vacation while enabling others to complete your tasks when you are out of the office. Prior to the
availability of this feature, you either had to provide your login credentials to another user to substitute for you while you were gone, which is not a

secure practice, or your tasks would remain uncompleted. With this feature, workflows will no longer need to stall, and your other RiskVision-related
responsibilities no longer need to remain unfinished because you are absent.

Note: To enable and manage delegations, you must have the System User Access Delegation permission.

To delegate your RiskVision user account

1. Click User Settings at the upper right corner of the RiskVision application. The User Information tab appears.
2. Click the Access Delegation tab and click Edit at the upper right corner of User Settings page.
User Settings

n ’ Delegate to Another User

0 Delegated user will be able to login and take actions based on assigned permissions on behalf of the

0 Save o Cancel

Enable Access Delegation ® Yes O No

Delegation Start Date |2013_10_23 |

Delegation End Date |2013_10_30

User Information
Change Password

Teams
Dashboards

. ¥ Assigned Access Delegations
Access Delegation >

Select an user to delegate access I User G

Filter by - Show all - | Refresh [

[ First Name - w:::;e Last Name Start Date

End Date

0 No delegations found.

The Access Delegation tab.
3. Select Yes next to the Enable Access Delegation option.

. Click the calendar icon associated with the Delegation Start Date field and select a date to specify when account delegation must start. If you
do not set the Delegation Start Date, your account will be delegated the moment after you save the settings.

. Click the calendar icon associated with the Delegation End Date field and select a future date to specify when the account delegation must
end. You are permanently allowing the delegate to access to your account if no date is specified in the Delegation End Date field.

. Select a user in the Select a user to delegate accessdrop-down list and click Save at the upper right corner of the User Settings page.

To read instructions for how to access the delegations and work on behalf of another user, see Logging in as Delegate.
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Receive Delegations From Multiple Users

Multiple users can delegate their accounts to you. When you log in, you will see a list of all of the users who have delegated their access to you from
the names other than Myself that appear in the dropdown list of users. You can also see which users have delegated their accounts to you using the
Assigned Access Delegations section in the Access Delegation tab. You can also see the date on which each access delegation expires.

User Settings

D)/

User Information
Change Password
Teams
Dashboards

Access Delegation >

[ Edit
Delegate to Another User
o Delegated user will be able to login and take actions based on assigned permissions on behalf of the

Enable Access Delegation No
Delegation Start Date N/A
Delegation End Date N/A
Select an user to delegate access N/A

W Assigned Access Delegations

1-3 0f 3
Filter by | - Show all - |« | Refresh @
[1 First Name - w:iil: Last Name Start Date End Date
[ Agiliance R User 2013-10-1 20131015
[0 Demo user iz B 2013-10-12 A,
[ John A Doe MiA MiA

Delegated user accounts in the Assigned Access Delegations section.
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Change the Grid Header Mode

A RiskVision object grid can have various numbers of rows on any page. As a result, at any given time, you can only view a certain number of rows in
a browser whose dimensions vary according to your monitor's size. When you scroll-down the grid in a browser to view the remaining objects, the
grid header row moves along with other rows; hence, you may not perceive the data correctly.

Page 1 2 Goto &}
Fiter by | - Showe all -+ | | Refresh @

|
|Switch between fixed and floating header i

To avoid this type of circumstance, you must click the icon next to the Refresh button to prevent the header row from moving.
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Manage Your User Account

Beginning with version 7.0, you can delegate your RiskVision user account to another user. When you delegate your user account, either you or your
delegate can access your objects in the RiskVision application and perform actions, such as transitioning workflows and change object attributes, on
your behalf. When the delegation expires, the delegate will no longer be able to access RiskVision objects and make changes on your behalf.

If your account has been delegated, you will see a ! next to the User Settings link.

Administratar |mUserSeﬂings | |,IC-:|nﬂgure Ul | Help | L-jg-:lutl

The !icon shows that your account has been delegated.

Note: When you delegate your account to someone, your administrator will know which operations are performed by you or your delegates.
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Advanced Search

The search box can be used to search for simple terms as well as for more structured queries. This section describes the syntax for advanced queries.

An advanced query consists of terms and operators. Terms can be single words (such as "test" or "hello"), or a phrase enclosed in double quotes
(such as "hello dolly"). Single terms (but not phrases) can include wildcards, * and ?, anywhere except the start of a term.

In addition to terms and operators, gMakeueries can refer to specific fields, such as "assetType:computer."

A term that ends with a tilde (~) is a proximity search. Fielded range searches, such as likelihood:[1 TO 4], are supported. When searching for more
than one term, a query can "boost" the relevance of a particular term.

Terms are combined with Boolean operators to form more complex queries.

Search Type Example
Basic server
Phrase "cvss score"

serv* (matches server, serving, serves)
Wildcard
te?t (matches test, text)

Fielded assetType:computer

The following Boolean operators are supported:
e terml1 AND term2

e +terml termZ2 (+ indicates that term 1 must exist to match)
Boolean Operators

e termINOT term2

® terml -term2

Fuzzy server~ (matches server, swerver, fever, fervor, etc.)

impact:[1 TO 4] (inclusive - matches impact 1, 2, 3, or 4)
Fielded range
impact:{1 TO 4} (exclusive - matches impact 2 or 3)

Additional Information
For more information about the advanced searching features built in to RiskVision, see Apache Lucene - Query Parser Syntax.

Using special characters to search objects might not return correct results. Instead, you can use the Advance Filter in the Filter by drop-down
list if you have to perform a multi-criteria search.

Supported Fields

The following fields can be used to narrow the scope of a search to a particular field for certain objects. In the context of a grid of Policy objects, for
example, you can search for specific policy types:

policyType:
Asset/Entity
e assetType
® assetSubtype
® name

® organization

e division



subDivision

assetNumber

address.name

address.address

address.physicalPosition

address.floor

address.building

address.city

address.state

address.region

address.postalCode

address.country

assetTags.name

assetTags.category

assetTags.description

assetTags.createdBy

assetTags.createdTime

assetTags.displayName

customAttributes.stringl (to) customAttributes.string25
customAttributes.textl (to) customAttributes.text2
customAttributes.Istringl (to) customAttributes.Istring3

customAttributes.extendedCustomAttributes.stringl

Computer System

Kind of Asset/Entity; adds:

applicationLinks.cpe.description
applicationLinks.cpe.title
applicationLinks.cpe.part
applicationLinks.cpe.vendor
applicationLinks.cpe.version
operatingSystems.cpe.description
operatingSystems.cpe.title
operatingSystems.cpe.part
operatingSystems.cpe.vendor

operatingSystems.cpe.version

Exception Request

name
justification
startDate
nextReviewDate
requestedBy
approvedBy
status

restart
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reEnd

risk

gap.createdBy

gap.creationTime

gap.name

gap.status

gap.priority

customAttributes.stringl (to) customAttributes.string25
customAttributes.textl (to) customAttributes.text2
customAttributes.datel (to) customAttributes.date3
customAttributes.booleanl (to) customAttributes.boolean5
customAttributes.longl (to) customAttributes.long3
customAttributes.Istringl (to) customAttributes.Istring3
customAttributes.extendedCustomAttributes.string1 (to) .string25
customAttributes.extendedCustomAttributes.textl (to) .text2
customAttributes.extendedCustomAttributes.datel (to) .date3
customAttributes.extendedCustomAttributes.booleanl (to) .boolean5

customAttributes.extendedCustomAttributes.long1l (to) .long3

Incident

title

description

timeStarted

timeDetected

timeReceived

uilncidentld

incidentNumber
currentWorkflowStageName
incidentType.typeName
incidentType.typeDescription
incidentSubtype.subtypeName
incidentSubtype.subtypeDescription
incidentDetail.severity
incidentDetail.priority
incidentDetail.status
incidentDetail.preventiveMeasures
incidentDetail.causeAnalysis
incidentDetail.confidentialityAffected
incidentDetail.integrityAffected
incidentDetail.availabilityAffected
incidentDetail.businessCriticality
incidentSubmitter.caption
attachements.name [Note misspelling]
attachements.pathld [Note misspelling]

attachements.url [Note misspelling]
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attachements.version [Note misspelling]

customAttributes.stringl (to) customAttributes.string25
customAttributes.textl (to) customAttributes.text2
customAttributes.datel (to) customAttributes.date3
customAttributes.booleanl (to) customAttributes.boolean5
customAttributes.longl (to) customAttributes.long3
customAttributes.Istringl (to) customAttributes.Istring3
customAttributes.extendedCustomAttributes.stringl (to) .string25
customAttributes.extendedCustomAttributes.textl (to) .text2
customAttributes.extendedCustomAttributes.datel (to) .date3
customAttributes.extendedCustomAttributes.booleanl (to) .boolean5

customAttributes.extendedCustomAttributes.long1 (to) .long3

Policy Set

title

description

descriptor

definitions

scope

purpose

audience

supportinglnformation

keyPoints

policysetType

policysetSubtype

parentPolicySetlds

policySetCategorylds
currentWorkflowStageName
workflowUserDefinedStatus

tags.name

tags.category

tags.description

tags.createdBy

tags.createdTime

tags.displayName

customAttributes.stringl (to) customAttributes.string25
customAttributes.textl (to) customAttributes.text2
customAttributes.Istring1 (to) customAttributes.Istring3

customAttributes.extendedCustomAttributes.string1

title
description
descriptor
policyType

checkFunction
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Ticket

parameters

checkType

checkDescription

organization

parentPolicySetlds

policySetCategorylds

tags.name

tags.category

tags.description

tags.createdBy

tags.createdTime

tags.displayName

customAttributes.stringl (to) customAttributes.string25
customAttributes.textl (to) customAttributes.text2
customAttributes.Istringl (to) customAttributes.Istring3

customAttributes.extendedCustomAttributes.stringl

name
displayName
description
reportOn
reportFocus
reportType
reportChartType

reportCreationType

name
description

plannedStartDate

startDate

owner

priority

createdBy

updatedBy

exceptionExpireTime

incident.title

submitter.userid

attachements.name [Note misspelling]
attachements.pathld [Note misspelling]
attachements.url [Note misspelling]
attachements.version [Note misspelling]
customAttributes.stringl (to) customAttributes.string25
customAttributes.textl (to) customAttributes.text2

customAttributes.datel (to) customAttributes.date3
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customAttributes.booleanl (to) customAttributes.boolean5
customAttributes.longl (to) customAttributes.long3
customAttributes.Istringl (to) customAttributes.Istring3
customAttributes.extendedCustomAttributes.stringl (to) .string25
customAttributes.extendedCustomAttributes.textl (to) .text2
customAttributes.extendedCustomAttributes.datel (to) .date3
customAttributes.extendedCustomAttributes.booleanl (to) .boolean5

customAttributes.extendedCustomAttributes.long1 (to) .long3

Vulnerability ID

captionDB (vulnerability title)
identifier (use title if available)
description

abstractText

analysis

recovery

defaultSeverity

cvssVector (matches value to first ')
likelihood

source

sourceFlags (string from int; for example, 3 is 'nvdbidefense')
assessmentCheckSystem
assessmentCheckName
assessmentCheckHref
recordType
vulnerableProducts.description
vulnerableProducts.title
vulnerableProducts.vendor
vulnerableProducts.version
data.data

tags.name

tags.description

tags.type

tags.referenceType

Vendor ID

Kind of Asset/Entity; adds:

vendor.vendorType
vendor.vendorTier
vendor.vendorStatus

vendor.vendorPreviousName
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The Rich Text Editor

The Rich Text editor is similar to word processing applications in that it allows users to enter text, and contains options to format the text with
options, such as bold, align, indent, lists, font color, font size, text highlight, and more. The Rich Text editor is found throughout RiskVision in
locations where more than simple text entry is required, such as when explaining an answer choice in a questionnaire, and when drafting a
questionnaire, content pack or policy. Typically, the Rich Text editor is available for use in the fields of objects that show the Click to enter text
informational message. When working with the Rich Text editor, you will notice that not all of the options appear for each field. For example, the
table options mainly appear only in fields of the questionnaire object.

|
L B R | 11 I I 5
I U#— |EEZZE S = | Fontkemly |~ FontSze =
15 1.6 3!7 18 19 20 212 23 24 25_6 27 28 29
La@ado e SEIA-Y.w

The Rich Text editor.

The following table lists all the options available in the Rich Text editor.

Option  Description

1 Makes the selected text bold. Use Ctrl + B as short-cut key.
2 Makes the selected text italic. Use Ctrl + | as short-cut key.
3 Underlines the selected text. Use Ctrl + U as short-cut key.
4 Draws a line through middle of the selected text.

5 Draws a horizontal line at the cursor position.

6 Aligns the text to the left.

7 Aligns the text to the center.

8 Aligns the text to the right.



Option
9

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

32

88

Description

Justifies the left and right alignments.

Makes the text a bulleted list.

Makes the text a numbered list.

Choose the font family for the selected text.

Choose the font size for the selected text.

Cut the selected text. Use Ctrl + X as short-cut key.

Copy the selected text. Use Ctrl + B as short-cut key.

Paste the text that is cut or copied. Use Ctrl + V as short-cut key.

Paste the text without any formatting.

Paste the text which is copied in the Microsoft Word application.

Revert the changes. Use Ctrl + Z as short-cut key.

Reverse undo changes. Use Ctrl + Y as short-cut key.

Insert or edit an image. Allows modification of image properties, such as dimension, space, border, and more.

Allows uploading of image from your computer.

Allows embedding the link to the selected text.

Allows to deactivate working links.

Adds space between the margin and the beginning of the text on a line.

Removes space in the indented line.

Allows choosing the text color.

Highlights the selected text.

Checks the spelling and grammar of the text.

Inserts a table in the editor. Use the General tab to specify the number of rows and columns, alignment, padding, border,

and more. Use the Advanced tab to set the advanced properties.

Updates the current, odd, even, or all rows in a table.

Updates the current cell, all cells of a row, all cells of a column, or all cells in a table.

Inserts a row before the cursor position.

43



O:i:tion Description .
4 Inserts a row after the cursor position.

35 Deletes a row

36 Inserts a column before the cursor position.
37 Inserts a column after the cursor position.
38 Deletes a column.

39 Splits the merged cells.

40 Merges the cells.



Actions

This section covers the most common options available in the Actions or More Actions drop-down list, seen throughout RiskVision. These drop-
down lists are sensitive to the page and the current selection. They can be seen in the tree on the left side of a page, in the center of a page, in the
details pane of a page, or at the top-right corner of a page.

f Control Target Profiles
Organization Content Actions

= Control Target Prof] Refresh
+ RiskVision Colf Cut
+  Organization  copy
Paste

Delete

The Actions menu.

[ Mew l [ Details l [ Delete ] |l'."|ore Aclicns... ¥
More Acfions...

o Name Copy template
Import....
Expaort..

O Alert Notification | Save as LSV
Customize

The More Actions menu.

This article covers how to perform the following actions:

e Refreshing the data;
e Cutting, copying, and pasting;
e Saving the grid as a CSV file; and

e |mporting and exporting the data to an XML file.

For information on transitioning bulk findings, tickets, exceptions, or incidents in a workflow, see theBatch Workflow Transitions article.

To refresh the tree view:

1. In the page where a tree view is available, select the folder. The Actions menu appears.

2. Click Actions and select Refresh. The tree is updated.

To cut the selection:

1. In the page where a tree view is available, expand the tree and select the object of interest. The Actions menu appears.

2. Click Actions and select Cut. The object is now ready for paste action.

To copy the selection:

1. In the page where a tree view is available, expand the tree and select the folder of interest. The Actions menu appears.

2. Click Actions and select Copy. The object is copied.

To paste the cut or copied action:

1. In the page where a tree view is available, expand the tree and select the folder of interest. The Actions menu appears.

2. Click Actions and select Paste. The object is pasted.

To delete the selection:

1. In the page where a tree view is available, expand the tree and select the folder of interest. The Actions menu appears.

2. Click Actions and select Delete. The object is deleted.



To save fewer rows in the grid or the complete grid in CSV format:

1. Open the page of interest in which the More Actions drop-down list containing the Save as CSV option is available.

2. Do one of the following:
o To save the complete grid, select Save as CSV in the More Actions drop-down list.

o To save the row(s) in grid, select the row(s) of interest and select Save as CSV in the More Actions drop-down list.

3. Adialog appears, displaying the options to open or save the file. Follow the instructions displayed by your browser to save the file.

To import a file in XML format:
1. Open the page of interest in which the More Actions drop-down list containing the Import option is available.

2. Select Import in the More Actions drop-down list. An import dialog sensitive to the object type appears. For example, if you are importing an
email template, the Import Email Templates dialog will be seen.

3. Click Browse to select the file.

4. Click OK on the dialog after the file is selected. The dialog is exited and the object(s) is imported.

To export the object(s) or the complete grid in XML format:
1. Open the page of interest in which the More Actions drop-down list containing the Export option is available.

2. Do one of the following:
o Select Export in the More Actions drop-down list to export the complete grid.

o Select the row(s) of interest and select Export in the More Actions drop-down list to export the row(s) in grid.

3. Adialog appears, displaying the options to open or save the file. Follow the instructions displayed by your browser to save the file.
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Documents

The Documents tab allows you to attach entity-related documents, such as service contracts. You can attach documents from your local system or

document repository, or provide a web link or network link to external information as a reference. The Documents tab can be found in the details page
of an object, such as an entity, entity collection, program, or control. Note that shared documents cannot be added to all objects.

Documents

Mew Document ] [ Mew Web Link / Network Path l [ Delate ] [MureAcﬁons...

Filter by| - Show all- v | Refresh |
|| Name a Caption

Description Uploaded By Uploaded On  Size Expires On Private

'ﬂ Mo Documents found.

The Documents window.

Other resources allow the attachment of documents in order to document findings, tickets, exception requests, and for other needs. For example, the
Findings option supports attaching documents in the context of a questionnaire.

To attach a document:

1. Select an object to open its details page, then click the Documents tab.

2. Click New Document. Select one of the following options:

Add Documents X

You can chooge one or more documents from your computer or from the Document Repository.

(® Add new documents from computer

(' Add new decuments from Document Repository

{From the Document Repository, you can choose documents or document collections.)

m ! Cancel ]

The Add Documents window.

e Add new document from Computer.
o Click OK.

o Fill out all fields, including Document Caption, Description, and Expires On.
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Add Document{s) x

To add one or more new document(s), select one or more files on your computer by
clicking on the Browse button.

Document Location® Mo file chosen
Document Caption | |

Description | |

Expires On | |

m ( Cancel ]

The Add new documents from computer window.

o Click OK.

e Add new document from Document Repository.
o Click OK.

o Select the required document collection.

Select one or more Document Collections »®

=" Document Collections
+ | #BTest DC
ABC
+  FAG
m ( Cancel ]
The Add new documents from Document Repository window.
o Click OK.

To attach a web link or network path:

1. Select an object, then click the Documents tab.
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2. Click New Web Link/Network Path.

Add Web Link / Network Path b4

New Web Link/Network Path
To add a new web link or network path, choose type, enter a caption and type in the
URL to your document.

Choose Link Type o Web Link () Metwork Path

URL® nttp:1/ |
Link Caption | |

Description | |

Expires On | |

a . Cancel .

The Add Web Link/Network Path window.

3. Click the URL field and type the complete URL or Network Path.
4. Optional: Enter a Link Caption and Description, and click the calendar icon to set the Expires On field.

5. Click OK.

To delete a document, web link or network path:
1. Select an object, then click the Documents tab, or go to the user interface area where documents are located.
2. Check the box next to document(s) and web link(s) you want to delete.
3. Click Delete.

4. Click OK.

The UNC path will display in all browsers but is only be clickable in Internet Explorer because other browsers block direct connection to the UNC path
for security reasons. If you're using another browser you will need to manually navigate to the appropriate location on the external file system.
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Control Object Visibility

Many default and user-defined objects contain the Applications tab in their details page to help you control the visibility of an object in RiskVision.
Objects will not be visible to you if the application you're using is not selected in the object's details page..

To control an object's visibility:
1. Click the object containing the Applications tab.
2. Click the Applications tab.
3. Click Edit and select boxes next to application(s).

4. Click Save. The object is now visible in the application(s) you have selected in the previous step.



Batch Workflow Transitions

The Batch Workflow Transition action makes it possible for users to move multiple objects to another workflow state in bulk. Once objects have
successfully transitioned, entries are recorded in each object's Workflow History, but a single entry is logged for each bulk-transition on the
Events page in Administration. Depending on the application you're currently working in, these objects include:

e Findings;
e Tickets;
e Exceptions Requests; and

e Incidents.
When using this action, note that:

e Up to 50 objects can be bulk-transitioned at one time.

e Only objects in the same stage from the same workflow can be transitioned in bulk, which are grouped and selected in the By Stage folder
and its sub-folders. If needed, the workflow settings can be modified in Configuration > Workflows.

e |f one or more objects cannot be transitioned due to an error, the transition will fail.
e Bulk transitions cannot be performed on closed or terminal objects. Reopening objects in bulk is not supported.

e Only users with View and Update permissions on the objects can perform this action.

Move Workflow

The Move Workflow window, which allows you to transition multiple objects at once.

Batch workflow transitioning supports the use of the Groovy programming language. If
you wish to use Groovy for bulk-transitioning workflows, contact Resolver Support.

In order to support batch workflow transitioning, users upgrading to RiskVision version
9.3 or higher must include the following method signature in the DetailPane Groovy file
of the desired object: public boolean isTransitionActionAllowedForBatch(String
transitionAction, String toStage, boolean forceTransition, List payloads).

In addition, any Groovy customization files that implement

PayloadScriptAction must provide implementation for
isTransitionActionAllowedForBatch () in theDetailPane Groovy file.

To bulk-transition objects:

1. Click Home, then navigate to the object you wish to perform the action on (i.e., Findings, Tickets,
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Exceptions, or Incidents).

2. Click the + icon beside the By Stage folder in the tree view to display its sub-folders.

FI} Tickets FI} By Stage Tickets
By St i
y Stage Actions w 1-40f4
=l My Tickets . )
My Undelegated Ticksts [ Mew ] [ Details ] [ Delete ] | KMore Actions... A |
My Ticketz Delegated To Othe = . .
|| TicketlD Title Sta
=l By Status
Open Tickets o
| TKTOOOO3 T4 Mev
Clozed Tickets
Il By Stage -
| TKTOOOO2 T3 Mev
Il By Type
=1 All Tickets -
| TKTOOmO1 T2 Mev
All Undelegated Tickets
All Delegated Tickets o
| TKTOODOO T1 Mev
Il By Type

The By Stage folder in the tree view.

3. Click a sub-folder under By Stage to display objects in the grid based on their current stage.

4. Select the checkboxes beside the appropriate objects or select the checkbox in the far-left of the
grid's header to select all objects.
R Tickets & Now Tickets
New Actions v 12002
= | My Tickets
N Z‘;;::;sm\egatedhoms ¥ TicketID Title Status Type owner ::’;::‘“gy Entities Risk Progress Cmahdﬂmavl;ms;jga :Tm"‘e"“"‘
Open Tickets lity Control e 2019-08-27 Default Ticket
Closed Tickets b R Rt - — A A — 0100827 Defeull T
= By Stage lity Control M 2019-08-27 Default Ticket
s < TKTO0000 i New FupConil - - A NA — R 20190827  Detaut T
+ | ByType
Selected objects in the New sub-folder.
When selecting objects in bulk, review theWorkflow Name column on
the far-right of the grid to ensure all objects belong to the same
workflow definition. If a workflow's name was recently modified,
the workflow must be synchronized before it will display its
current name in the column.
A maximum of 50 objects can be selected for a single bulk
L transition. Closed objects cannot be selected.
5. Click the More Actions... dropdown menu, then click Batch Workflow Transition to display the Move

Workflow window.



T& New Tickets
1-20f 2
[ New ] [ Details ] MMore Actions... v
More Actions...
- Batch Edit Tickets
@ TicketID Delegate
Batch Workflow Transition
Customize
v TKTO00000 vdf New

The Batch Workflow Transition option in the More

Actions... dropdown menu.

Select an option in the Actions section to transition the objects to another state.

Enter any notes in the Comments text box as required.

Move Workflow x

Current Stage: New
Actions™: (®) Accent
O Reject
Comments:
icket is accepted
Cox JE

The Move Workflow window.

Click OK to complete the transition and refresh your browser to see your changes.



Visualize Objects

This section provides an overview of visualization tool options available in RiskVision. For case-specific information about how the RiskVision
visualization tool helps understand the pattern with respect to workflows and relationships, see Visualizing Relationships and Visualizing Workflows.

RiskVision has integrated a visualization tool in the objects of entities, entity collections, and workflows to help users visualize relationships between
entities, entity collections, and workflow stages. This tool has been incorporated as a separate tab on the details page of the respective objects - the
Relationships tab for entities and entity collections and the Stages tab for Workflows. A default graphical layout is displayed by clicking on the
Relationships tab and then selecting "Relationship Report" for entities and entity collections, it's also displayed by clicking on Stages tab for
workflows.

The following tool options are available to enhance your visual experience:

Option Description

Click to magnify the layout. Continue selecting this icon until you have achieved the desired magnification level.

Click once to revert the layout to its original size.

Click to reduce the size of the layout. Continue selecting this icon until you have achieved the desired magnification

b B

level.

Click once to make the content fit in the layout.

Selecting
Select a desired layout option in the drop-down list at the top of the window.
layout

Click once to revert the layout to its original size and to properly align the layout.

Click once to show the labels.

Click once to hide the labels.

Click to open the layout in a new browser tab for printing purposes.

GRIIRCNG

Click to reload the graph with changes you have applied.

<]

For visualizing workflows in RiskVision, you need a web browser with HTML5 support.
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Move the Layout

When a layout contains several nodes, you may want to zoom in on the layout to clearly read the nodes. However, this action limits the number of
nodes in views. In order to view the other nodes with same zoom in level, use the Overview pane to move the layout.

.r::. Wiarkflows » ::1. AssessmentWiorkflow: Agiliance Assessments
A Assessment Workflow: Agiliance Assessments

(& )L (= (& J|[ Hormene ][5 )I[ & (% )|

Definition
Applications

To move the layout:

® In the zoomed layout, move the cursor into the rectangular shaded region of theOverview pane at the right-hand side of the window. Hold
the left button of the mouse, and move the mouse in the required directions.

e Use the vertical and horizontal scroll-bars around the layout which appears when you expand the layout beyond the best fit.
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Bulk Export Evidence

RiskVision allows users with the Assessment Manage permission to bulk export evidence from assessments. To perform the bulk export, clickMore
Actions > Export All Evidence. This option is visible in the Assessments Details page > Evidence Log tab.

:'| Assessment: RRV-2909
Assessment Details  Enfity Details  Propagation

W Evidence
General
Summary 1-10f1
Control Results Moare Actions... v ] ¢ .
: Filter by| - Show all - v |[ Refresn |
Workflow More Actions... \ )
Export All Evidence .
T J
Findings Zave as CEV k escription Owner Documents Controls
Customize
Tickets Lo
1. 2909 _Oracle.png
Responses 2. 9.2 10 9.3 upgrade fif
pe Linked from 3. RRV-3648.png.fif 1. Survey - RRV-
tion Document - 4. AfterMergeCategeorylLevel png 2909, question -
Exceptions s Repository Document ®% 5 scan_Reporl_cil_server_exploits_rv_cigru_rb_20120403aml  RRV-
T e pository 6. RRV-3648- b 2809_Subcontrol
P 7. ExploitsAndFireEye pphx
Charts 8 @31

= Logs
¥ Evidence Change Log

Evidence Log

Workflow Log Results as of 2019-07-24 11:26:38
Archives 1-37 of 37 Show rows

[ Save as CSV ] [ Customize ]

Filter by| - Show all- ¥ | Refresh ]

Change Who When -
Added Evidence wsr — b 2019-07-17 05:13:14
Removed Evidence dc -t 2019-07-17 08:13:03
Removed Evidence REV-2909_Subcontrol e » 2019-07-17 08:13:03

The Evidence Log tab on the Assessment Details page.

When you perform a bulk export of evidence, you will get a single downloaded zip file. For assessments, the zip file name shall be Program -
Assessment Name.zip. This zip file will contain multiple folders, one for each question.

If a document is used as evidence for more than one question within that assessment, all the documents are downloaded where user can open and
save all the documents.



Bulk Exporting Documents

Users can also export documents attached to entities, findings, and tickets using More Actions > Export All Documents. This feature requires object
Manage permissions for the object you performing a bulk export from. You can access the bulk export option in the object's Documents tab.

@ Computer: RRV-2909 7 Faverites
Documents
= General
Owners 1-10f1
Descnpnon Mew Document ] [ Mew Web Link / Network Path ] [ Delete ] More Actions. .. v § i 1
: Fiter by| - Showall - v | [ Refiesn |
Addresses More Actions. . \ /
. . Document Properties 2d . . .
Classification 8] Name  a Caption Tags  Description | - " Size Expires On Version
part Al Do ents
Costs & Impact :
pa O[] testdocx  test NiA Data for the | Customize 4 1KB  2019-0725 1

import
Relationships e

Propagation

Documents
Assessments
Vulnerabilities
System Details
Data Feeds

Exceptions

Accessing the Export All Documents option on an object's Documents tab.

This option is located in a similar position on the Findings and Tickets Documents tabs. Bulk exporting of documents results in a single zip file. The
name of the zip file depends on the object from which the files have been exported. For entities, the zip file is the entity name, for findings the file
name is Finding ID - Finding Name - Entity Name.zip, and for tickets, the file name is Ticket ID - Ticket Name.zip. The Bulk Export Documents feature
applies to documents, but not to network paths and web links.
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Maximum Zip File Download Size

By default, downloaded zip files for both evidence and documents cannot exceed 200 MB in size.

The maximum file size can be adjusted through the attachments.export.maxAllowedSize property. For example, to change the maximum
file size to 1 GB, you would set the property as follows: attachments.export.maxAllowedSize=1024 .
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User Picker

You can add users as owners to objects such as entities, tickets, and findings using the User Picker window to search for users. This feature allows

you to search for users by Source, User Role, First Name, Last Name, User ID, and Email Address. Each search will return a maximum of 200 user

records.

The Source dropdown menu appears in the User Picker window when the
com.agiliance.security.agluserintegration.label=Search External Users
from the Authentication Connector, which connects to your LDAP directories, into RiskVision.

To search for users:

property is enabled, which allows importing users

1. Open a page of interest in which the owner or primary owner must be added. Click the + icon to open theUser Picker window.

2. Pick the appropriate source, if the property is enabled.

3. Enter the search criteria.

Select a User b4

Source

Internal Users ¥ | UserRole

| Any user role

v | Search for users

First Name JULE0ERLVEES

I Last Name |

Authentication Connector

User Id | Email Address |

Available Users

Filterby - Show all- v | | Refresh =

Userld = First Name Last Name

0 Mo matching users found.

Email Address

B

o

Selected User

@ Cancel

-

4. Click Search for users. The result appears in the Available Users list.

5. Add a user to the Selected User list by selecting the user in the Available Users list and clicking the right arrow pointing from the Available
Users to the Selected User list. To remove a user from the Selected User list, select it in the Selected User list by clicking on it, then click the
left arrow that points from the Selected User list back to the Available Users list.

If the user selected from Authentication Connector does not exist in RiskVision, the new user account is created within the application before

assigning them to the object.

Using Search Criteria

1. Search results are filtered using an AND condition between the fields

2. Depending on the Source selected internal users or LDAP users, the use of the wildcard character is different:

example: *test* , *test, test * and test

For Internal Users, the search field supports a single word in which the wildcard of "*" can be used before and/or after the search term. For

For LDAP users search, the search field supports a single word that includes the wildcard of "*" at the beginning and/or end of the search

terms as well as anywhere within the search term. For example: *test, test*, tes*t, te*t, and t*est

Note: If you are not making a wildcard search, your search terms will be exact match terms for each of the terms you are using.
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About the Welcome Page

Each RiskVision application has a Welcome page that can be customized for each individual user and their specific roles. The components of this
page change based on the selected application.

When you log in, a summary of items assigned to you, such as questionnaires, tickets, exceptions, and notifications, will be displayed. Clicking on any
of these items on the Welcome page opens a navigation pane with details specific to your selection.
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My Assessments

The My Assessments section in the Welcome page provides a glimpse of questionnaires that were recently assigned to you, because the assessment
workflow has entered the stage in which you are a stakeholder. Based on the due date of a questionnaire, click the subject to begin answering a
questionnaire instantly without requiring you to search for the questionnaire in the Questionnaires page. Clicking the Go to Assessments link at the
bottom of the section will direct you to the Questionnaires page on the Home menu, where questionnaires with relevant action options are shown in
a grid.
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To-Do List

The To-Do Listis a component of the \Welcome page that displays exception requests, tickets, findings, and other requests for action (except
assessments and questionnaires). The items displayed depend on your role, the current status of the system, and the selected application.

/~To-Do List

List all the To-Do items you have pending other than my guestionnaires

Type Subject

m Finding: Priority One Finding

w Finding: Doable Findings

£f  Ticket: Oct-03-2013-11

Exception: Mo name - - Oct-03-2013-1

Exception: Mo name - - exception1234

Stage
Mew
Mew
Mew
Review

Review

Assign Date b
2013-10-04
2013-10-04
2013-10-03
2013-10-03
2013-10-03

More To-Do Iltems

The To-Do List on the Welcome page.

Click on an item to view more details. ClickMore To-Do Items to see all to-do items. As with other grids or tabular displays in RiskVision, click on a

column heading to sort by that column.
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Message Center

The Message Center is a short summary of your most recent notifications, and is displayed on the Welcome page.

L) Message Center

Displays nofificafions of events that require a user’s attention, such as the delivery of new and confrol qu
a user manages.

1-50f3

Subject

Created On

failure of controls, problem reports or fickets, new and updated vulnerabiities. or specific changes in entities that

Assessment Launched: RRV-2909 - RRV-2909

Assessment Launched: 33 - AC-1 AGCESS CONTROL POLICY AND PROCEDURES

Assessment Launched: 33 - AC-1 ACCESS CONTROL POLICY AND PROCEDURES

Assessment Launched: 33 - AC-1 ACCESS CONTROL POLICY AND PROCEDURES

Assessment Launched: 33 - AC-1 ACCESS CONTROL POLICY AND PROCEDURES

2019-07-16 06:32:07

2019-07-16 04:00:19

2019-07-16 04:00:14

2019-07-16 04:00:14

2019-07-16 04:00:14

The Message Center.

To view a message:

1. Click a message to open the Alert window with the message's contents.

2. Click one of the following buttons:

o Archive & Close: Dismiss the window and remove the message from the Message Center.

o Cancel: Keep the message in the Message Center.

3. Optional: To view all messages, click Go to the message center or go to Home > Message Center.

For more information, see Understanding the Message Center.

Go to the message center
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Quicklinks

Quicklinks is a component of the Welcome page that provides a categorized set of links to other pages in the RiskVision system. The set of links

change depending on the selected application (such as the RiskVision Application) and your user account's role.

. Quicklinks
Entities Entities | Entity Collections | Group Definitions |
Entity Management

Assessments fssessments | Programs | Motifications and Alerts
| Data Feeds

Content Controls and Questionnaires |
Control Target Profiles | Risks |
Document Repository

Analytics RE Dashboards and Reports | RE Charts |
R& Report Templates | RE Report Status |
RT Analtics (Early Release)

Configuration Wworkflows | Questionnaire Fresentation Options |
Email Templates | Escalation |
Ticket Management Preferences | Filters |
Cwnership Types | Assessment Configuration |
Entity Configuration | Findings Configuration

=~ Quicklinks

= 3 & a in

1209 unread Messages 499 Tickets 12 Assessments 177 Questionnaires 94 Entities

H

2 Risk Responses

71N

1 Risks
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Understanding the Message Center

The Message Center is a page that displays notifications, such as an alert that a workflow has advanced to the next stage. The notifications in the
Message Center page are always relevant, because of certain criteria. For example, the system only sends alerts to the stakeholders of a particular
workflow stage.

[ Messages
1-Bof &
Detail Delet Maore Aclions... ¥
[ eals” eee]| ore Actions... ¥ | Filter by| - Show all - '|[Reﬁeshl@
s
|| Subject Entity/Assessment Status Created On w Description Error Message
Rizk Aszessment:
Version = RRM-2908-
RRV-2909-2019
Assessment Entity Type = Zending email to
|| Launched: RRV-25059 RRV-2909 Do not send 2019-07-16 06:32:07  Computer Entity T T petl e & e
- RRV-28049 Mame = RRV-2909  failed. Mot connected
Current Status =
Information
Gathering
Rizk Assessment:
Aszsessment Version = 33-v12333-
Launched: 33 - AC-1 2019 Entity Type =  Sending email to

| ACCESS CONTROL w12333 Do not send 2019-07-16 04:00:19  Vendor Enlity Name B Bapaanalillesssoms s
POLICY AND = 12333 Curmrent Talleq. Mol conneciea
PROCEDURES Status = Information

Gathering

Rizk Aszessment:
Assszsment Version = 33-E12§-
Launched: 33 - AC-1 2018 Entity Type = .

[ ACCESS CONTROL E123 Do not send 2019-07-16 04:00:14 ﬁf’“"p“_'eéfz'g"? g"l'.J"’”‘ connect to host, port: bb,
POLICY AND ame = ; fimeout 600000
PROCEDURES Current Status =

Information
Gathering
Rizk Assessment:
Version = 33-Default
Assessment Engagement-2019
Launched: 33 - AC-1 Enfity Type = Viendor Sending email to

|| ACCESS CONTROL Default Engagement Do nof send 2019-07-16 04:00:14  Service Enfity Mame B Shapanassiilsssaions s
POLICY AND = Default failed. Mot connected
PROCEDURES Engagement Current

Status = Informatinn

The Message Center page.

In the Message Center page, you can perform the following tasks:

e Clicking the subject of a message will help you view the details in a pane below the grid.

e Simultaneous deletion or archiving of multiple messages is possible.
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About Questionnaires Page

The Home > Questionnaires page lists all of the questionnaires assigned to you in a grid, where actions specific to the state of the assessment
appear in that questionnaire's row.
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About Table Columns

The table columns display the following questionnaire-specific information:

Column

Program

Assessment

Questionnaire

Status

Complete By

Progress

Delegate to

Delegated By

Actions

Action Items

Description

Displays the program name.

Displays the assessment name.

Displays the content name assigned to the entity for evaluation
in the program. Tool tip displays the path to the content on the

Controls and Questionnaires page.

Displays the stage name.

Displays the questionnaire due date.

Shows the percent complete of the stage.

Shows the username to whom you have assigned the

questionnaire.

Shows the name of the stakeholder who delegated the

questionnaire.

Dropdown that allows you to initiate an action. See below.

Shows icons that indicate action items set for the questionnaire
questions, such as exception requests, and identifies

questionnaires with attachments.
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About Action Options

Actions are questionnaire preferences chosen by the Program Owner. An option may be available for one questionnaire but not another. Also, the
action options corresponding to each questionnaire do not appear by default in the dropdown list after the questionnaires are rendered in the grid.
Click Select, then click the dropdown list to make the actions visible in the dropdown list of the corresponding questionnaire.

—Select- ivl

Resume Questionnaire
Delegate

Delegate (Multiple users)
Revoke Delegated Qluestionnaire
Lock Questionnaire

Export Questionnaire

Import Questionnaire

Results Summary

Assessment Workflow

Option

Work on this Questionnaire

Resume Questionnaire

Delegate

Delegate (Multiple users)

Revoke Delegated Questionnaire

Lock/Unlock Questionnaire

Export Questionnaire

Import Questionnaire

Results Summary

Description

Opens the questionnaire and allows you to answer and delegate
questions. Only displayed when no questions have been

answered.

Opens the questionnaire and allows you to answer and delegate
questions. Only displays if one or more questions have been

answered.

Transfers the responsibility of completing the questionnaire to
another user or a team. The questionnaire will disappear from the
stakeholder's list and will be forwarded to the new user with the

answers you have already provided, if any.

Transfers the responsibility of completing the questionnaire to
multiple users and/or a team when the control contains multiple

questionnaires.

Stakeholders or users with revoke delegate permissions can
revoke the responsibility of a user and/or team for answering the
questionnaire.The delegated questionnaire will disappear from
your list and will be forwarded to the stakeholder with the

answers the delegated user or team has already provided, if any.

When locked, prevents users from changing answers.
When unlocked, allows any user to open the questionnaire and

change answers without first unlocking it.

Exports the questionnaire to Excel, including all questions and

corresponding choices.

Allows you to import answers from an Excel spreadsheet.

Shows the risk and compliance scores based on the
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Option DULKSHiRIgIRire answers provided.

Displays the assessment's current workflow stage, allowing you
Assessments Workflow
to move the workflow to the next stage.

The Revoke Delegated Questionnaire option appears when the questionnaire is delegated to a user or team.

70



About the Submitted Questionnaires Page

The Submitted Questionnaires page displays inactive questionnaires for which you were a stakeholder. Typically, these questionnaires are inactive
because you have completed the questionnaire and advanced it to the next workflow stage - generally, Review. This page allows you to follow the

progress of completed questionnaires. You will not be able to view the Submitted Questionnaires page on the Home menu unless you have the

Questionnaire View Submitted Questionnaires permission.

[] Submitted Questionnaires

Fiter by [- Show el - | Refrash |
Program Entity Duestionnaire Submitted Archived Status Progress
1 AgiTest-aGRCPT AglTest-E1 AolTest-eGRCT 2010-03-01 L\\\ Cortrol Design =100%
2 test? slapplication 001 8.1 2Information security o, o g Reviews 10"
co-ordination

See also Using the Grid View.

71



About the Tickets Page

The Tickets page is a grid consisting of tickets in which you are a stakeholder. If you own the responsibility of managing the tickets in your
organization, you can view all tickets, regardless of ownership. Depending on your permissions, you can use the Tickets page to perform the
following tasks:

e Create a new ticket

e Synchronize the changes made to the ticket workflow;

Delete a ticket; and

e Open a ticket to view the details and to perform the following tasks:
o Update the general information.

o Transition the workflow.
o Add comments.
o Manage attachments.
o Link or detach entities and vulnerabilities.
o View workflow history and changes.
When you access the Tickets page, you can view all tickets that need your attention, as well as all closed tickets. Tickets can be filtered usingBy

Status, Stage, Type and My Tickets Delegated To Others. For example, you can click the Review group under the Tickets tree to work on tickets in
the Review stage.

Groups under By Stage appear only when tickets enter a particular stage. For example, if there are tickets in the "New" and "Assigned" stages, only
those stage groups appear to the stakeholder.
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Creating a New Ticket

Use tickets to assign tasks to system users and track progress. Create a ticket for each item that you want to track. For each task, the RiskVision
solution creates a single ticket and sends the notification to all stakeholders of the initial stage. Each person views, modifies, and transitions the same
ticket. Creating a new ticket requires you to have the Ticket View, Create or Manage permissions.

By default, all tickets use the Default Ticket Workflow template.
To create a new ticket:

1. Go to Home > Tickets.

2. Select the My Tickets folder.

3. Click New. The New Ticket window displays.

New Ticket E x
Basic Details
Enter Ticket Information * = required

Title* I'I'rac:lcing Mobile Devices Owner* | v |

Type* [ Entity Control Resolulion v

Planned
A 2019-10-29
Description | Effort to track Mobile Devices Starfl |
Planned End |2El19-1|—12 |
Priority [ High v
4 Risk [ High v

== =

The New Ticket window.

4. Enter Title and Description. Select Type, Owner, Priority, and Risk. Also, specify Planned Start and Planned End dates. For information about
the description of the fields in the New Ticket wizard, see Setting General Ticket Information.

5. Click OK.

A new ticket is created and displays in the My Tickets folder. Next, link the ticket to an entity.

You can create a ticket for a finding using the Tickets tab on the finding details page, and for a vulnerability using theAffected Entities tab on the
vulnerabilities details page, and for an incident using the Actions and Tickets tab on the incidents details page. Creating a ticket manually,
automatically marks the vulnerability as acknowledged. If the system (Affected Entities Notification Sender job) creates the ticket automatically, an
unacknowledged vulnerability remains unacknowledged.
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Batch Edit Tickets

The Batch Edit Tickets action makes it possible for users to edit most of the fields in multiple tickets at one time. The fields that cannot be edited
include:

e Name;

e Status;

e Export Status;

e Submitted By;

e Ticket ID;

e Created Time; and

e Ticket Age.

Once the tickets have been successfully modified, the logged event will include the Ticket IDs of the modified tickets, the user who performed the
action, records of the modified fields, and the time and date of the action.

When using this action, note that:

e Up to 50 tickets can be bulk-edited at one time.
e Batch edits cannot be performed on closed or terminal tickets. Reopening tickets in bulk is not supported.

e Only users with View and Update permissions on tickets can perform this action.

Batch ticket editing supports the use of the Groovy programming language. If you wish
to use Groovy for bulk-editing tickets, contact Resolver Support

To bulk-edit tickets:
1. Click Home > Tickets.

2. Click a folder in the tree view to view the tickets in the grid.

& Tickets TR AN Tickets
All Tickeis Actions w 1-3 of 4
— My Tickets - -
My Undelegated Tickets [ Mew l [ Details l [ Delete ] |l'."|ore Acfions... '|
My Tickets Delegated To Othe . .
| | TicketID Title Status Type
— By Stafus
Open Tickets Enfity Contral
|| TKTOOO0D3 T4 New "
Closed Tickets - Resolufion
= BySiage Enfity Contral
New || TKTOOO0D2 T3 New Resolufion
+ By Type Eniity Control
o RIS || TKTOO0D1 T2 New Resolufion
[ TKTooo00 T New Entlly Control

Existing tickets.

3. Select the checkboxes beside the appropriate objects or select the checkbox in the far-left of the grid's header to select all objects.



I Tickets & By Stage Tickets
By St
y Stage Actions w 1-4of 4
= My Tickets ; .
- . -
My Undslegated Tickets [ Details l [ Delefe ] | More Aclicns J Fiter by| - Show all- ¥
My Tickets Delegated To Othe N ~ Awaiting 5 . N In Stage
& [ By Staus [ TicketID Title Status Type Owner Action By Entities Risk Progress Created Time~ ¢ =
Open Tickets Entity Control 20190704
Closes Tiokats [ TkToooos T4 New EAiy COTIOl st e @ NA [ nia e 2907 2019.07.04
L by Stage 4 TKTODDO2 T3 New Eniity Confrol et St & N/A [ ] nia o 20T 2019-07-04
[ By Type e Resolution - 01:46:09 a
= AllTickets "
Entity Cantral 2019-07-04
¥ TKToooo1 T2 New ; L L NIA HiA % 2019-07-04
All Undelegated Tickets - Resalution e - & O 01:45:59
All Delegated Tickets Entity Control 20190704
=Y — [ TkTosooo  T1 New ool e - NA [ nia [E— Tl 2019-07-04
Mew
I+ By Type
Selected tickets.

A maximum of 50 tickets can be selected for a batch edit.

4. Click the More Actions... dropdown menu, then click Batch Edit Tickets to open the Editing Multiple Tickets window.

A AnTickets

1-4of 4

[ Details ] - ::Iole:;lmns... v Fillerbym
jore: ions... e

|| Ticket D Title zow Type Owner a;valtmg Action Entities Risk Progress Created Time w In Stage Since

Delegate

[0 TKT00003 T4 gﬂ"f 35 CSV Entity Control (S Pam § NA [ Mia [ T0%  2019-07-04 014521 2019-07-04
ustomize

[ TKTO0002 T3 Hew Eg" Control e [——] NiA [ i [ 10%  2019-07-0401:46:08 2019-07-04

|#| TKT00001 £ New Eniity Control o B NA e [ 0%  2019-07-0401:4559 2019-07-04

[0 TKTo0000 T New Enlity Conirol o » Pa—— R V1Y m [ 10%  2019-07-0401:45:45 2019-07-04

The Batch Edit Tickets option in the More Actions... dropdown menu.

5. Click Edit in the top-right corner of the window.

Editing Multiple Tickets: 2 Tickets |:Jr Edit
W General
Description N/A Owner Famass =

Type Enfity Control Resolution Start M/A
Status New Expiration date M/A
Export Status Mot exported to external Planned Start N/A
system Planned End N/A
Category NIA Exception Expiration Date N/A
Disposition N/A Priority M/A

Progress [ | 0% Risk [ Unknown
Submitted By MN/A Ticket Age M/A

Custom String N/A
10

Custom String 4 E123

¥ Comments

0 No comments have been entered.

The Editing Multiple Tickets window.

6. Make changes to the fields and add comments as required.

7. Click Save when finished and refresh your browser to see your changes.



Editing Multiple Tickets: 2 Tickets

General

¥ General

Description

Type | Select a ticket type v |
Status New
Export Status Not exported to external system
Category | |

Disposition |__ Salect — r |

Progress a: F

Submitted By N/A
Custom String 1D| |

Custom String 4 [E123

¥ Comments

Q Save 9 Cancel

Owner
Select a user v

Start [3p19-07-24

Expiration date |2019-0?-31

Planned Start |

Planned End |

Exception Expiration |
Date

Priority [ Medium
Risk | Low
Ticket Age N/A

Applied a medium priority and low risk

0 No comments have been entered.

Editing the fields of multiple tickets.
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Exception Requests Page Overview

The Exception Requests page is a grid consisting of both local and global exceptions for which you are a stakeholder. The operations that you
perform in this grid depend on the permissions assigned to your role. You can use the Exception Requests page to perform one or more tasks
described below:

e Create a global exception;

e Update the general information;

o Transition the workflow;

e View workflow history;

e Enter additional comments in addition to the comments that you enter while transitioning the workflow;

® Manage attachments;

e Synchronize the changes made to the workflow of an exception; and

Delete an exception.

Local exceptions can be created in the Questionnaire window or Control Results tab of Assessment Details page. For more information, refer to
Questionnaire Responder's Guide.
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Request Global Exceptions

This section explains how to request global exceptions for entities that are out-of-compliance with a control or subcontrol and you want to override
the questionnaire and check results in the compliance and risk scores. The RiskVision solution applies the exception to all assessments with the
entity-subcontrol pair. Setting an exception at the control level propagates the override to the subcontrols. If the questionnaire contained a subcontrol
only, the global exception applies. You can also create an exception for a finding to override the finding's risk score. In order to request an exception,
you must have Exception View and Exception Request permissions.

To request Local exceptions, that is, exceptions for a particular assessment, use the questionnaire. Stakeholders can access the questionnaire from

Folder Sub-Folder
My By Stage Review
Exceptions Sign-Off
Closed
By Type Control
Vulnerability
My Exceptions Delegated To Others
My Undelegated Exceptions
All Exception | By Stage Review
Sign Off
Closed
By Type Control
Vulnerability
All Delegated Exceptions
All Undelegated Exceptions

Note:

1. The folder name under the By Stage depends on the workflow stage names

2. All Exception folders are available only if users have the object Mange permission privilege.

To request an exception:

1. Go to Home > Exception Requests.

2. Click New. The Exception Request wizard appears.



Exception Request

* = required

Step 1: Enter Exception Regquest Information

2. Attach File Title*| |

Affected Entities

Control |

Reason for Exception

Start Date (3070 0512 [T
End Date | |
Next Review Date | |

Override Compliance Score I:I (%)

[ Cancel | [ < Back ] Next >

The Exception Request wizard.

3. In the Basic Details wizard page, enter the exception information. For more information, see Exception Request Basic Details.
4. Click Next to continue.

5. Optional: Add a document from your desktop, link to a document in the repository, or URL. For more information, see Exception Request
Attachments.



Exception Request E x

1. Basic Details

Step 2: Optionally Attach File

* =required

r— Add a Document or Link

® Add a document

Document Location®

Choose Files | No file chosen

Document Caption

Description
| 4
Expires On

OAdd a link to a document in repository

() Add a web link

) Add a Network Path

Y

— Added Documents and Links

Name . Caption Uploaded Uploaded

Tags Description By on Size

Expires

On

Version

ﬂ Mo Documents found.

-

’Cant'.el‘
The Attach File section of the Exception Request wizard.
If you cancel the attachment, it will appear to cancel the entire exception request.
Wait a few moments and the exception request will appear without the attachment.

6. Click Finish to exit the wizard and to add an exception onHome > Exceptions page.

The exception has been created, but not requested. Go to the workflow page and submit the exception request. SeeManaging Your Exception

Requests
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R6 Report License

Resolver is preserving R6 Reporting for long-time RiskVision customers who have legacy reports in R6 Reporting that they have not been able to
transition to RiskVision's JasperReports Server. As of Version 9.0, customers will need to request a license key with R6 Reporting enabled from

Resolver Support.

The following table shows the differences in RiskVision’s behavior when the R6 license is enabled:

FEATURE

Menus Available in the

Analytics Tab

Configure Ul

Permission

Enabled Properties

Viewing R6 Charts,
Dashboards, and

Reports

New Group and Export

Group Actions

Home @ Entities

Analytics and Reporting

Assessments

R6 Dashboards and Reports

WITH R6 LICENSE

e Analytics and Reporting

e RG6 Dashboards and Reports
e R6 Charts

e R6 Report Templates

e RG6 Report Status

Required for creating an R6 Custom Query chart.

e To create R6 Charts, enable
allowNewReport=true

e To create R6 Dashboards and Reports,
enable allowNewDashboard=true

Users can access R6 Dashboards and Reports, R6

Report Templates, and R6 Report Status.

Users can select New Group and Export Group

under My Charts and My Dashboards.

Content CGELG (S

R6 Charts

The Analytics tab with an R6 License.

RE Report Templates

WITHOUT R6 LICENSE

e Analytics and Reporting

Required to view and create R6 charts. Only table-

type charts with custom queries can be created.

e To create R6 table-type charts with custom
queries, enable allowNewReport=true

e To view archived R6 Charts, enable
showArchivedReports=true

e To view archived R6 Dashboards and
Reports, enable
showDashboardPage=true

Users cannot execute New Group or Export

Group.

Configuration

R6 Report Status

Home | Entities

Assessments

Content

The Analytics tab without an R6 License.

Configuration
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About Policy Manager

Policy Manager enables the management of enterprise policies on a single centralized platform. Organizations can enforce policy and process
standards across different locations, departments, and programs. Policy Manager supports simultaneous policy editing across multiple stakeholders
using a rich WYSIWYG user interface. An organization can automate processes for policy authoring, reviewing, and approval. Policy templates help
enforce consistent formatting and structure. Policy Manager has a highly configurable workflow enabling an organization to enforce change control
and maintain accountability. Policy Manager supports policy awareness campaigns with policy distribution, attestation, and comprehension testing

tools.
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Policies

Policies are the rules and standards that an organization creates for itself. RiskVision Policy Manager tracks compliance with an organization's policies
as well as other Policies and Controls.

Policies can include workflow and recurrence rules, and modifications to policies are saved as a version for later comparison.

Policies are hierarchical documents. Within the top-level Policy, there are blocks called Sections. Each Section can have Subsections, and so on. The
overall outline is auto-numbered (these numbers can be hidden while viewing or printing).

The Policy feature is designed to be flexible so that online policies can closely mimic offline policy documents. Each block (section or subsection) can be
managed separately. Unlike offline documents, each section in a Policy can refer to Controls and can have attached documents.

% Policies AFEdit Subsection: Change Control @ one  #Back
Change Cortral Actions v g New Subsection X Delete Subsection View: [ ] References [] changes
anization Contert ~
|l Document Outline Templates Change Control
|l Policies
|1l SANS Information Security Policy Templates
|1l Standard=
t ﬂgiﬁ: . Developmept and_ testing _must be performed on non-produd_iolj "’_ Edit m Ad‘_j Comrr_‘ent "33 Chances
systems prior to introducing neve systems or changes to existing systems in the, foduction environment.
+ &Arl_ElankCompllance_aglllance * All system and application changes must be approved and submitted through approved change
+ [ g &H_BankComplisnce_agiliance-toditied management systems.
| it + Major changes to systems and applications must be approved by the asset owner(s).
+ | | TestSpecs
| Group-1
+ | AglTest-Grpd
= [ rpre Change management systems Change Control Systems
=] Ll Systems and Operations Management Se
— %) TABLE OF CONTENTS Rz ClREmE = oS
% Purpose RequestiT Changeman IMF
Scope
g Systems Management Radia
+ E Metweork Management & Security
Woice Security EDM
g Modem Security
= é Change Management D
% Change Contral
= psset and Configuration Manage Change EPS
ad Logging & honitaring
Anti-wirus * Al change tickets must be approved by a designated approver before changes can be implemented in production
EE g Backup & Recovery environment.
Review & Revision * A&l change tickets must be assigned to an individual administrator responsible for the change.
g Enforcement
" sl .E-Ex:aﬂnﬂ‘ ot A et N et A A A g ot ot gl

The policy tree on the left of the screen provides easy access to Organization Content, including the Document Repository, Document Outline
Templates, and Policies. Within each Policy, the tree shows the layout of the sections and subsections that make up the Policy.

e To author your own policy, see Creating a New Policy.

e To group policies, see Creating a New Group.

e To save policies, see Saving a Policy.

e To delete a policy, use the Actions drop-down menu on the policy tree on the left. Select the policy to delete and choose Delete from the
Actions menu.

e To move a policy from one group to another, select the policy to move and choose Cut from the Actions menu on the policy tree. Select the
destination group and choose Paste from the Actions menu.

e To copy an existing policy, select the source policy and choose Copy from the Actions menu on the policy tree. Select the destination group and
choose Paste from the Actions menu.

e To export policies, see Exporting Policy Documents.
e To import policies, see Importing Policy Documents from Word and Importing Policy Documents from XML,

Each policy has a change history, and internal versions are automatically created when a policy moves to a new workflow stage. Changes are
automatically tracked when a policy is updated. Tracking changes can be disabled.
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Create A New Policy

RiskVision provides organization content, including templates, that help create policies that you can tailor to your organization's individual needs. You
can also create policies from scratch and import existing policy documents. In order to perform these operations, you should have the Policy View
and Policy Author permissions. Users with Policy Manage permission can also create new policies.

To create a new policy, select the destination policy group in the Organization Content tree, then click New. Policies can also be created under
content packs or control groups.

The Create a Policy Documentwizard includes the following steps:
e General;
e Workflow;

e Ownership; and

e Review Recurrence.

Create Policy Document

Step 1: Create a Policy *= required

2. Workflow Create a palicy by entering the general infarmation first.

3. Ownership Hame*

4. Review Recurrence IUSE i =R B et

Template*

IAgiIiance Default b’
ldentifier

IUse of Emergency Equipment

Description

Click to enter text

Cancel < Back m

General

Enter a name, identifier and description for the new policy and choose a Policy Template that will define the initial structure of sections and
subsections for the new policy.

Workflow
Workflow is optional for policies. You can create a policy without workflow, or associate a workflow with a policy later.

To apply a workflow to a policy, select an existing Workflow Template, or click Create a new template. The wizard displays the workflow stages
(such as Draft, Review, Approval, Deploy) from the template for your review.

Creating a New Policy Workflow Template
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When you create a new policy workflow template, you can identify a number of stages and a set of stakeholders for each stage. Stakeholders can
include specific users, policy roles (such as Policy Approver or Policy Author), or teams.

New Policy Workflow @ s=ve © Carcal

Workflow Template Hame | Add Mews Stage Add Terminal Stage

= —

Assign Stakeholders

Owner [ Team [ Search | Stakeholders
> Policy &Approver Q Palicy Author
Palicy Author

Policy Reviewver

Add az Stakeholder==

Motify Remove

Actions
Label Hext Stage Email Template Status
|Submn for Review | | Review v | [ Do not send Emai v| |In Revisw | Presview

O ‘ | | | Preview
| I I | Preview
O I I | Preview

WWorkflow Start hatification

O Motify selected stakeholder uze Email Template:

Aoy Delegation

Delegation Label: |Delegate use Email Template: | Do not send Email | Preview

Allowy addtional stakehalders to be added

For more information, see About Policy Workflow.

Ownership

The user creating the policy is the primary owner by default, but you can choose another user to be the primary owner. To add additional owners,
click Add Owners. The wizard displays the list of all owners for your review. Primary owners are the stakeholders who will receive notifications when
the policy enters a particular stage.

Review Recurrence

Policies are often re-evaluated on a regular basis. Specify how often the policy is to be reviewed (for example, Never, Monthly, Quarterly, and so on).

Click Notification E-mail Template from the dropdown menu to be used to remind policy owners of the need to re-evaluate the policy.
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View A Policy

There will be many times when you will need to view policies, such as when you are drafting, reviewing, approving, and deploying policies. In order
to view a policy, your user role should have the Policy View permission. Not all options can be accessed with the Policy View permission. The options
that you see in the graphic below are possible when your user role has Policy View and Policy Author permissions.

To view a policy:
1. Open RiskVision Policy Manager.
2. Go to Content > Policies.
3. Expand the Policies group in the Organization Content group.

4. Click a policy.

Policies > 4 policy: Agiiance Information Security Policy + Back
ey Policy: Agiliance Information Security Policy E Save as PDF ’ Sawve as HTML a\\l’&f!iﬂﬁs :g;FIuat L:“[' Edit 5";.
view: [ ] ownership [] workflow [] Documents [] References [] Categories [ ] Changes
T Display Options Rl
I:I Attachments

[[] miine References
b [ inline Categories
] automatic numbering

[] show icons

Options to view different
objects attached a policy

5. Select the following checkboxes to view objects attached to a policy:

e Ownership: View owners. You can define who can view, author, review, and approve a policy.

o Workflow: View details such as review recurrence and history. If the review recurrence details are not set at the time of policy creation, you
can use the Review Recurrence section to set how often a policy should be reviewed and the email template that should be sent when a
policy is to be reviewed. After you set the options, click Save.

e Documents: Attach any necessary documents that stakeholders should refer to.

e References: Map references to a policy, such as industry, policy and organization.

e Categories: Assign a category from the existing set of categories, or create a new one.
e Changes: View details, such as what, when, and who changed the policy.

e Display Options: Use the display options below to show what information should be available to stakeholders when a policy is saved. You
should check the box available next to each option to make that option visible.

o Attachments: Documents that are attached to a policy will be shown. Note: when a policy is saved as PDF, only the name of the
document will appear; you will not be able to open the document from the PDF. Instead, you can direct the users to view the
attachment in the document repository.

o Inline References: Shows references that have been provided in the sections or subsections of a policy.
o Inline Categories: Shows which category a policy is assigned to.
o Automatic numbering: Automatically numbers all of the sections and subsections in a policy.

o Show icons: Shows icons next to all of the sections and subsections in a policy.




Edit A Policy

When creating a policy from scratch, attach a workflow to the policy to allow stakeholders to work on it. If you want to edit a policy that is already in
place, restart the policy workflow so that stakeholders can edit the policy. Whether drafting a policy from scratch or editing an existing policy,
stakeholders should update the content in the sections and subsections, or use the options described in this section.

You can edit a policy if your user role has Policy View and Policy Author permissions, or Policy View and Policy Manage permissions.

To edit a policy:

1

2

Go to Content > Policies.

. Go to the Organization Content group, then expand the Policies group.

Click a desired policy.

. Click Edit in the upper right corner of the page.

Folces

4 poiicy. ADEENEE MTprmation Securly Folicy 4 Back

A Lot Pollzy: Agillance IMTAMMEton Secunty Policy @ cone
+ Mew Seclicn " Pearder Sections X Delet= P iy wiew: | ownershio [ workhow (] Documents [ Retersnces [ categaries [ hanges

Policy Statement

Agiliance End Usar Softwara License Agreamant X f@ [ oo commens By Cranges

Purpose

This Agiliance End Liser Saftware License Agresment ("Agresment”) is a legal agreement hetwsen you individualhy if you are agreeing to it in your own capacity, or i yau are
authonzed to acquirs the Scfiware on behalf of your company or anciher organization, betwean the company or organization for whose bansft you act {“Customer’), and
Agiliance, Inc. (“Agiliance”)

Scope
BY CLICKING ON THE "ACCEPT' BUTTON, OPENING THE PACKAGE. DOWHLOADING THE SOFTWARE. OR USING THE EQUIPMENT THAT CONTRINS THIS
PRODOUCT, YOU ARE CONSENTIMNG TO BE BOUND BY THIS AGREEMENT. IF ¥ 0OU DO HOT AGREE TO ALL OF THTERMS OF THIS AGREEMENT, CLICK THE DO

MOT ACCEPT' BUTTOM AND THE INSTALLATION PROCESS WILL NOT CONTINUE, RETLIRK THE PRODUCT TO THE PLACE OF PURCHASE FOR A FULL REFUND, OR
DO NOT DOWNLOAD THE PRODUCT.

Definitions

CUSTOMER MAY HAVE A SIGNED WRITTEN AGREEMENT RECTLY YIMH AGILIAMCE (E.G.. AN ENTERPRISE OR MASTER LICENSE AGREEMENT) THAT
SLPPFLEMENTS OR SUPERSEDES ALL OR PORTIONS OF THIS AGREEMENT

Identifier

|

5. Click any of the following buttons:

o

o

New Section: Creates a new section based on the settings defined in a template.

Reorder Sections: Reorder custom sections in a policy. Drag and drop a section on to the top or bottom of another section to change
the order.

Edit: Change the title of a section and subsection. When theEdit button is clicked in the area below the section or subsection, a rich-
text editor is displayed so that content can be entered. For more information, see Using Rich Text Editor.

Add Comment: Allows adding the comment to a section and subsection to help you explain the reason behind for making a change.
Changes: View changes, such as comments entered and other changes in the sections and subsections by the stakeholders.

New Subsection: Creates a new subsection in a section based on the settings defined in a template. This option appears only in the
custom created section.

Delete: Delete a section or subsection. This option appears only in a custom created section and subsection.

6. Click Done.
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Save A Policy

You can save a policy to PDF or HTML format, only if you are an owner of that policy or if you have the Policy View permission to view a policy.

To save a policy:
1. Open RiskVision Policy Manager.

2. Go to Content > Policies, then click a policy.

Folicies > 4 polizy: Infrastructure Palicy for Finance +JBack
¥ Policy: Infrastructure Policyfor Finance 1) save as POF 0 Save as HTML 9, varsions (@ Foat [ Edit ‘G

View: Jwvnership Wark o |:| Documents |:| References |:| Categories D Changes Dizplay Options -~

3. Perform one of the following options:
o Click Save as PDF. Click Save File to save the policy.

o Click Save as HTML. Click Save File to save the policy. The policy is compressed and saved inthe .zip format.



Render Fonts in PDF

During the draft stage, policy authors create sections and sub sections to write the content that describes a policy. Authors can use different fonts to
highlight notes and headings that will help them differentiate the text from other contents in a policy. This also enables policy viewers to search the
content in the policy that is relevant only to them. A policy generated in PDF uses built-in fonts by default - Times New Roman, Arial, and Courier.
When a policy is created using different fonts, as a policy author you will need to ensure that fonts in the PDF files match with the fonts used in the
policy in RiskVision.

If a font is not rendered in PDF, even when it is available in the operating system and RiskVision, perform the following steps to change the font
directory location to render fonts correctly in PDF:

1. Gotothe S%AGILIANCE HOMES%\Tomcat\webapps\spc\WEB-INF\classes\ directory and openthe pd4font.properties fileby
using a text editor.

2. Locate the following property and set the property to point the fonts directory to the location where your operating system is installed. By
default, the property is setto as: font.dir.location=C:\Windows\Fonts
For example, if you have installed your operating system inthe D:\ directory, then you should set the property to as
D:\Windows\Fonts .

3. Restart the RiskVision Tomcat service. The PDF should now be able to render the fonts correctly.

If a font is still being substituted with a different font after changing the fonts directory location, the font is not available in the operating system, or
the PD4ML tool that generates the PDF does not support the font. In both the cases, the fonts in PDF are substituted according to the fallback tables
of the font group. To learn how a fallback rule is applied for substituting a font, visit the following URL:

http://pd4ml.com/index.htm
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Document Outline Templates

Document outline templates specify fonts, colors, backgrounds and other formatting styles. Document Outline Templates allow you to easily change
the look of an existing policy or contract.

You can save your policy or contract as a document outline template for later reuse. Because each section and subsection can be created using a
template, you can build complex documents by embedding templates. Document outline templates are divided, by default, into {policy or contract},
Section, and Subsection groups. In order to create a custom document outline template, you need to have the Policy View and Policy Author
permissions.

To create a document outline template:
1. Go to Content > Policies.
2. Go to the Organization Content tree.
3. Click the Document Outline Templates group, or expand and select the Section or Subsection group in which a template is to be created.

4. Click New in the group details page.

5. Enter a Title and Description.

New Template X

Title* |aBL_SecurityPolicy

Description | This template =hould be used for creating a
security policy.

m Cancel

6. Click OK. The template is created with default headings and with no styles and formatting.
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Edit a Document Outline Template

A newly created document outline template will have the default headings with no styles and formatting. You can edit the template to match your
organization's document standards. The Policy View and Policy Author permissions, or Policy View and Policy Manage permissions are required in
order to make changes to the Document Outline Template.

To edit a document outline template:

1

2.

Go to Content > Policies.

Go to the Organization Content tree.

. Click the Document Outline Templates group, or expand and select the Section or Subsection group in which the template to be modified is

available. Check the box next to the template and click Details.

. Click the Edit link in the upper right corner of the details page.

. Click the Configure link in the upper left of the details page to access the Configure Template dialog in order to change the following

settings:
Display

e Click the icon to configure the following display settings using the Configure attribute dialog:
o Display name - Enter a name of the section.

o Type - The section types can be Rich text or String. Note that this field is not editable.

o Hidden - Clear the check box if you want to make the section visible in the template.

Configure Template X

| Title EN
Policy Statement #| A
=
| Purpose =) A&|
Scope #| Ay
E]
Configure attribute X

Display name |Definitons |

yoe
Higgen B

e Click OK to exit the Configure attribute dialog.

Styles and formatting

Ay
e Click the icon to apply the styles and formatting to the heading and content of a section using theEdit Attribute dialog. Note
that settings to apply the styles and formatting to the heading and content are available individually; under the Heading or Content,
select a setting:
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Setting Description

Font Select a font type in the drop-down list.

Font Size Select a font size in the drop-down list.

Font Weight Select a weight, such as normal or bold, in the drop-down list. By
default, the font weight is normal.

Font Style Select a style, such as normal or italic, in the drop-down list. By
default, the font style is normal.

Color
Click E to select a font color in the palette. In the palette,
mouse hover on a color to know the name of that color.

Background
Click E] to select a background color for the font in the palette.
In the palette, mouse hover on a color to know the name of that
color.

Border Select a border, such as thin, thick or dashed in the drop-down list.
By default, no border is applied to the fonts

Edit Attribute X

Heading
Font | select v
Font Size | 20 v
Font Weight [ _ Select - »|
Font Style | - Select — b |

]
e [
w

Content
Font| - select - v
Font Size | — select— ¥
Font Weight | — Select — b |
Font Style | - Select — . |

]
woond ] [
b

Border | — Select —

Border | T ——

@ oo

e Click OK to exit the Edit Attribute dialog.

5. After you finish editing the template, click OK to exit the Configure Template dialog.

Changes to templates affect policies that are based on those templates.

Templates can be exported (saved) in PDF or HTML format. For more information, see Saving a Policy.
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Export Policy Documents

You can export policies to save in XML format in RiskVision Policy Manager.

To export a policy document:
1. Go to Content > Policies, then select a folder that has privileges to export a policy.

2. Select one or more policies, then click More Actions > Export.

2) Control Object Export Status - Mozilla Firefox

B N

htbps:fi10,100,16. 3/spcfpolicy AglPolicy ObjExportStatus. ﬁ |

Export status
Progress count: 4

The export has completed. Click here to download the file.

Done =]

The Control Object Export Status window.

3. Click Click here to download the file

RiskVision application will always generate a single XML file, even if you select more than one policy to export.

RiskVision application isolates all the documents attached from the main policy after it has been exported and provides you a compressed file,
allowing you to save all the attachments separately.



Import Policy Documents From Word

Large policy documents can be imported directly into RiskVision from word processing applications such as Microsoft Word, saving considerable
time. In addition, a policy document can be maintained in parallel outside RiskVision, and re-imported to update the system.

When importing from a word processing document (.doc, .docx, .odt, and .rtf formats are supported), RiskVision will attempt to create a hierarchy of
sections and sub-sections. For tips on creating a source document, see Creating Policies Based on Microsoft Word Documents.

To import a policy document for the first time:

1. Go to Content > Policies, select a folder in which you have privileges to create a policy.

2. Select Import Policy from Word in the More Actions drop-down list.

More Actions ... i

T More Actions..

| Mew Content Pack
Save Policy as template

- Conwert Policy to Contrals
Maorve To

Copy Ta
Expoart
Delete

Browse Wersions
Synchronize Yorkflow
Save az CSY
Customize

3. Select your source document, then click OK. The import process will not modify the source document.

Once the policy has been imported, you can edit, delete or edit it like any other policy document.

To re-import from Word to update a policy.
1. Follow the above directions for importing a policy document for the first time.
2. Select the folder containing the policy document to update. The system will detect the document by name and will update the contents of

sections and subsections.

Major changes, such as document reorganization or deleted sections will not update
smoothly. In this case, rename the source document and import as new.
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Create Policies Based on Microsoft® Word Documents

If your policies are already available in a Word document, it can be faster to import the policies, rather than recreating them. You can import
documents in .doc, .docx, .odt, and .rtfformat.

To create a policy document:
1. Open a document using Microsoft Word.

2. Set the title, heading and top-level sections to the Heading 1 style type.

Document1 - Word

Insert  Design  Layout  References Q £ Share [

B o R S AcBbCeD
Cambria 48 -|A A A~ e AaBbCeDe AaBbCcDe | AaBbC(| AaBbCcl AQD AaBbcer AaBbeche AaBbCcD AaBbCcD. AaBbCcDC AaBbCcD: AaBbCCD: AABSCCDC .

TNormal T No Spac... | Heading 1 | Heading2  Title Subtitle  SubtleEm.. Emphasis IntenseE..  Strong Quote  Intense Q.. Subtle Ref.. =

Paste . S
T Fomat pater (BT U e A W A

Clipboard [} Font [} Faragraph [} styles 3

TEST
SECURITY
POLICY

3. Set the subsection heading styles as Heading 2, Heading 3, and Heading 4. Set the body text associated with various sections to Normal
style.

4. Create a multilevel listing. Select the heading and set the heading type asH1. Select the second level heading and right click on it.

5. Click Home tab > Numbering > Change List Level. This will automatically set up the numbering in a format that RiskVision can recognize. If
you don't set the top level heading to H1, or H2, or H3, change list level will not be active. Manually creating the numbering format may create
formatting issues.
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Mailings [ Grammarly Q Tell me what you want to do

o =-ERE == 0

Document] - Waord

AaBbCcDc  AaBbCcDe |1 AaBl 1.1 AaBl /—\aB AaBbCcC AaBbCcDi AaBbCc

A - | =Ry TNoSpac.. | Heading 1| Heading2  Title Subtitle  SubtleEm.. Emphasi
& T Styles
Mone 2 2
3| |y
[ A a)
I B. b)
i C. c)
a. |
b. ii
C. 1
& Change List Level C ‘ 4t ‘
Define New Mumber Format... -
%3_2 Set Mumbering Value... ‘ 1.1 Heading 2 ‘
‘ 1.1.1.1.1.1!—55:';5 ‘
"‘ IR R I I [T — ‘ .

£

7. Optional: To remove any undesired numbers, click the text, then click Home tab > Numbering > None.
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Q Tell me what you want to do

Documentl - Word

Grammarly
b Z-EErts EE AT pasben
— |= Numbering Librai
A- =8B ) 5

5 1. 1)
MNone 2 )
3 )

. A a)

II. B. b)

1. C. c)

Define Mew Mumber Format...

AaBbCecDe | 1 AaBt
1Mo Spac. | Heading 1

1.1 AaBl Aalj AaBbCcC AgBbCcDt AaBbCcDt AaBbCcDt
Heading 2 Title Subtitle  Subtle Em...

Test

Styles

Emphasis  Intense E...

8. Save the file with a.doc extension.

9. Log into RiskVision Policy Manager.

10. Go to Content > Policies and click More Actions > Import Policy from Word.

11. Verify if the headings are broken into the correct sections and the numbering format is properly aligned.

When adding page breaks to Word documents, remember to press tBEater key to add a
paragraph space after each page break. Otherwise, page breaks may not translate
properly when exporting to .pdf format.
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Import Policy Documents From XML

Importing previously exported policies provides a convenient way to copy policy documents between development and production environments,
from one RiskVision server to another, or when your organization has multiple domains with similar objectives. Exporting a policy document to XML
format also allows you to make changes to a policy outside RiskVision. Export the policy document, edit the XML file directly, and then import the
policy into RiskVision using the Import Policies (XML) command.

Policy documents in XML must conform to the RiskVision schema. If importing an XML file generates a syntax error, correct the XML text and import
the file again.

You can import policy documents in XML format if your user role has Policy View and Policy Manage permissions.

To import XML policy documents:

1. Open RiskVision Policy Manager.

2. Go to Content > Policies. The Policies page is displayed.

Home MHLIEHIM Entities | Assessments | Analytics | Configuration L [Poiicy name | Search |
Policies = Confr d Questionnaires  Control Target Profiles  Document Repository About this page
“ policies L4 Group: Policies
Policies Actions v

Description: User defined policies

=/}l Organization Content
i org 1-10f1

+ [}l Decument Outline Templates ) )
# Lil Policies New: Policy | | New Group | | Details | More Actions. - Fiter by -Showall- » | Refresh
+ [ By Category

] Type = Titie Template Description status
B 2 Policy Document Word Template: WA Drat

The Policies page.

3. Click Import Policies (XML).

4. Click Browse to select the desired XML policy file from your local network, then click Start Import. Ensure that you have appropriate privileges
for importing files from the remote network.

) Import Policies - Mozilla Firefox

B8 https://gas1/spc/policy/AglPalicyImportipload. jsp?objMame =Policies

Click Browse to select the file on your computer.

File * Agiliance_Defaultxmil

[ Start Import ][ Cancel

Importing a policy.

Once the import is complete, the Import Policies window displays details about the imported file, such as policy count and the number of policy
groups, policies, sections, and subsections.

A logged in user importing a policy into RiskVision will become the policy's primary owner, and all the references, categories, and display options
associated with the policy are inherited. For policies with attached documents, extract the zip file, double click the data folder, double click the
attachments folder, and copy the folder to the %AGILIANCE_HOME%\data\attachments directory before you start importing the XML policy
document.

RiskVision encrypts files that are uploaded to the RiskVision server. The files are encrypted in transit using SSL and are also encrypted at rest.

If you have any attachment for another policy, extract the zip file, double click the data folder, double click the attachments folder, compare the
current folder path with the existing folder path. Copy the folders which are not common to the common folder path.

EXAMPLE
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You're importing policy with attached documents for the second time. Compare the additional
attachment unzipped folder in the existing path

( $AGILIANCE HOME%\datalattachments\201\0090\5223\5251\0151\7696 ) with the current
path

( $AGILIANCE HOME%\datalattachments\201\0090\5223\5251\0151\7697 ) in a second

computer. Copy the folder 7697 to the folder 0151 in the existing path.
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Add Images to Policies

Advanced users may want to embed images in policies and policy templates. Use the following methods to add URLs pointing to images or upload
images into policies.

e Insert/Edit Image button in the Rich Text editor: Inserts a link to an external image (e.g. on the web).

e |Insert URL pointing to an image in a document repository: This technique inserts a reference to an image in the local document repository.
Using the document repository is often preferable to link to external objects that are not under your control.

e Upload Image button in the Rich Text editor: Uploads an image from your local computer at the cursor location.

To insert a URL pointing to an image on the wek:

1. Open the Rich Text editor.

2. Click the icon to open the Insert/Edit Image dialog.

Inszert/Edit Image »
Insert/Edit Image

Im=zge URL |h1:tp:_l"_-"vw.rw.FreedigitaIphotos.net-"im4

Im=zge Description |Insert Image |

Alignment Laft W
Dimensicns

Border

= = £
(=)
o

Verticzl Space

Haorizontzsl Space

The Insert/Edit Image dialog.

3. Enter the following details:
o Image URL: The URL pointing to an image on the web.

o Image Description: Any additional information that helps understand the use of the image in the policy.
o Alignment: Set the image direction.

o Dimensions: The size of the image.

o Border: The width of border around the image.

o Horizontal Space: The white space to the left and right of the image.

4. Click Insert.

To insert a URL pointing to an image in a document repository:
1. Open the destination document collection, then click New Document.
2. Locate the local file to upload and enter a description, if desired.

3. Click OK. The image can now be referenced by its URL. For example, if an image file called picture.jpg is uploaded into the document
collection dc101 of group2, the image's URL would be /group2/dc101/picture.jpg .

4. Open a policy.

5. Enter a call to the renderDocumentRepositorylmage function. The prototype is:

PT.renderDocumentRepositoryImage (url, width, height, css)

Parameters other than the url can be null. For example:

$PT.renderDocumentRepositoryImage ('/gl/dc2/picl.png', '500',null, 'border: 1lpx solid black;"');

Images in policy templates can be overridden at the policy level.
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To upload an image into policy:

1. Open the Rich Text editor.

2. Click the icon to open the Select an Image dialog.
3. Click Browse, select a file on your computer to upload, then click Open.

4. Click OK.
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About Policy Workflow

A workflow is a set of stages, such as Draft, Review, Approval, and Deploy. Each stage has a list of possible actions that move the workflow to a new
stage. For example, the Review stage might have an action labeled Approve that moves the workflow from the Review stage to the Approval stage.
The Review stage might also have an action labeled Deny that moves the workflow back to the Draft stage. The creator of the policy workflow
template can create complex graphs that accurately model real-world practices.

Policy workflow is optional; you can create a policy without a workflow and you can add workflow to an existing policy.
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Configurations Overview

Any assessments you run in RiskVision involve various objects available on the Configuration menu. You should carefully examine each object and
configure only the options required to meet the needs of your assessment because you may want to choose a different strategy for each assessment.
The following objects should be configured before launching an assessment:

e Workflows: If you don't want to use the default workflow, you can choose a different one using the assessment and policy creation wizards.
If you want an exception, ticket, or finding to follow a different workflow pattern from the default workflows, you must configure the selection
criteria within those workflows. For more information on workflows, see the following topics:

o About Workflows;

o Modifying Stage Settings; and
o Specifying Multiple Workflows.

e Escalations: Used to notify the requester, owner, and manager, that a ticket is overdue. For more information, see Creating an Escalation
Configuration and Managing Escalation Configurations.

e Email Templates: Used for stakeholder notifications. Several default email templates are available for selection or are already in place to
handle notifications. If your organization prefers to follow a specific procedure for its internal communications, you can design an email
template. For more information, see Configuring E-mail Templates.

e Filters: Contain a set of conditions used to match records in reports, limit membership to dynamic groups, and more. Examples of filter types
include Assessment, Dynamic Group, Entity, Exception Request, Incident, Program, Response, and Risk. For more information, see About
Filters.

e Ownership Types: Link workflow stage stakeholders to system users assigned to an entity or policy. This allows processes such as programs,
tickets, and policy pack approvals to run automatically. You can restrict which user can be assigned as a type of owner based on the user's
role assignment. For more information, see About Ownership Types.

e Entity Configuration: Depending on the RiskVision application, a common threshold range criteria can be established for assessment, finding,
vulnerability, risk or incident objects. When assessments are run, the risk, vulnerability and incident scores are derived according to the default
range. Before you run any assessment, ensure that the threshold range is configured according to the assessment objective and meets
auditing guidelines and policies. For more information, see Configuring a Threshold Range for Risk, Vulnerability and Incident Scores.

e Questionnaire Presentation Options: Instead of provisioning too many options in the questionnaire Ul, you may want to consider creating a
new questionnaire presentation option that allows responders to submit the questionnaire without completing all questions. For more
information, see Setting Questionnaire Presentation Options.

e Ticket Management Preferences: Usually, notifications are sent when a ticket is overdue. Ticket Management Preferences allow you to add a
disposition to avoid sending the escalation. For more information on setting the ticket preferences, see About Ticket Management
Preferences.
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Workflows

A workflow divides compliance, risk and other related business processes into stages and allows you to pre-assign participants (stakeholders), define
requirements for transitioning between stages, and automate run-time process controls and activities, such as sending e-mail notifications and

updating status.

The workflow initiator, such as a program owner, manages their own workflow and performs actions like reassigning, adding stakeholders, and

forcing a transition to another stage. To view workflows on the Configuration menu, you must have the Workflow View permission to create, update

or modify a workflow stage, you must have the Workflow Update permission.

The following table lists the RiskVision default workflows. The type of workflow that you see on the Configuration > Workflows menu depends on

the RiskVision application.

Type
Exception

Assessment

Policy

Ticket

Object
Entities and/or
Controls

Entities

Controls

Entities

Description

Specifies the stages of approving or rejecting an exception to a control
that is requested by a user taking a questionnaire or from the Exceptions
page.

Specifies the stages in the process of evaluating compliance of an entity
or group of entities against a set of controls or gathering risk related
information. Successfully launching a program initiates the workflow.

Advanced: Workflow can allow questionnaires to advance workflow
stages independently.

Specifies the stages for developing, reviewing, and approving
organizational content (Policies, Controls, Subcontrols, and
Questionnaires). Saving a new policy pack or changing an existing policy
pack initiates the workflow.

Specifies the stages for reporting and tracking various types of required
actions.

Initiate the ticket workflow from an incident using the Remedy connector,
and

by manually creating one on the Ticket page.
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Modify Stage Settings

This section explains workflow stage options. When you start a new process, such as an assessment or content pack development, RiskVision copies
the selected workflow and creates a separate workflow instance that belongs to the process. Instances and workflow templates are related but
require synchronization in order to have instances that are related to templates reflect the latest template modifications.

Users can modify templates if they have Workflow View and Workflow Update permissions.

For assessments, any change to the template alerts the program owner by displaying an informational message on the assessment details page. The
owner can synchronize the workflow settings with the assessment workflow instances. This overwrites the instance settings with the new workflow
settings.

For example, if the template has changed after an assessment has launched, the user will be unable to advance the workflow and will see the
following message displayed:

Unable to move assessment. The workflow template was changed after the Program was
launched. Please synchronize the workflow.
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Configure Stage Transitions & Actions

This article provides instructions on configuring the workflow transition and action options for the following objects:

e Tickets;

e Incidents;

e Exceptions;

e Findings; and

e Policies.

A stage transition moves the process from the current stage to another stage. The transition is typically associated with a user action, such as
approve or reject. For Assessment workflows, the transition can also have questionnaire taking conditions. The stage transition options display as
buttons on the workflow page.

By default, a workflow uses at least two actions in each stage. Since you may not need two actions on all occasions for each workflow stage, you
may want to use the following properties so that actions can be selected depending on the context of need.

PROPERTY DESCRIPTION

Enter a number which specifies the actions in the workflow stage. If this property value is not set, the
workflow.min.transitions=
default value is 2, meaning there must be at least two transitions for every non-terminal stage.

Enter a number so that you will have the choice to select more transitions when needed. By default the
workflow.max.transitions=
value is 4, meaning there can be no more than four transitions for every non-terminal stage.

For example, if you need just one action in a workflow stage, you must set the workflow.min.transition propertyto 1and
workflow.max.transitions property to an appropriate value so that you can continue to select more actions in stages depending on the
context of need.

Only users withWorkflow View and Workflow Update permissions can modify workflows.

As of version 9.5, the workflow.max.transitions value for exception workflows will
be the entered value plus 1. This extra transition will allow the workflow to expire.

To configure a workflow's transitions and actions:

1. Click Configuration > Workflows.

2. Click a workflow on the grid to open the workflow settings. If needed, use the tree to the left or the filter dropdown menu on the far right to
filter the results on the grid.
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Home | Entities | Assessments | Content | Analytics QeI

Workflows Quesfionnaire Presentation Options Email Templates Escalafion Ticket Management Preferences

}3 Workflows 525 Exception Workflows
Exception Workflows Actions 4 130f3
1=/ Workflows
Details Delete Import... Export... e -
Exception Workflows [ ] [ ] [ & l [ P ] Filter by | - Show all
Assessment Workflows
B o Type Name a Stages
Paolicy Workflows
Ticket Workflows
o =] Exception Alternate Template [Requested. Review, Pre-Approval. Approved,
Finding Workflows Closed]
o Exception Exception Workflow [Requested, Review, Sign Off, Clesed]
o Exception Test Waiver [Requested, Review, Sign Off, Clesed]

The Workflow settings in Configuration.

3. Click Definition in the pane to the left if it's not already selected.

}5 Exception Workflows » Exception Workflow
Exception Workflow

Workflow Template Name Exception Workflow

4] Back

b Export ) Import [ Edit

Definition
Stages

Selection Stakeholders

q Exception Requester/Reopener

Q Primary Owner

Actions
Mext q Exception
Label Stage Email Template Status
Request Review Exception Review [Defaulf] Approve
Close Closed Do not send Email Cancelled
Delegate To Exception Delegation [Defaulf]
Options

MNotify selected stakeholder
Motify requester
Allow additional stakeholders to be added

Allow submi quester to make ch

Motify by sending single email to all stakeholders

Comment
Required

Waorkflow advance to the next stage when any stakeholder performs the action

Exception Expire
Transition

No

No

Workflow details.

4. Click Edit in the top-right of the workflow screen.
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A Exceplion Workflows » Excepfion Workflow

Exception Workflow

Workflow Template Name Exception Workflow

Add New Stage [ Add Terminal Stage

Definition
Stages I | =
Selection Assign Stakeholders
Owner Team Search Stakeholders
Buginess Cwiner - [1 Exception Requester/Reopener
Custom Ownerl
Custom Owner2
Executive Owner Q Primary Owner
Incident Viewer
Primary Cwner
Security Owner
Vender Contact hd
Add as Stakeholder=>
Email Only Motify Remaove
Actions
. Exception
. 9 Hide Comment F
Label Next Stage Email Template Exception Status = = Expire
Action Required i
|Request | [ Review w | [ Exception Review [ v | | Approve ~| 0O
[Close H Closed ~ |[Donot send Email_w | [ Cancelled | O O
O ~ W W
D w w w
O ~ W W

Workflow Start Motification

Allow Delegation

Delegation Label: | Delegate To

Allow additional stakeholders to be added

(] Molify selected stakeholder use Email Template
O Molify requester use Email Template

| use Email Template | Exception Delegation [Det v | Freview

Comment required

4] Back

o Save o Cancel

Preview
Preview
Preview
Preview

Preview

The Workflow edit screen.

5. Click a stage to display its Actions settings.

6. Enter a name for the stage in the Label text box. This is the label that will appear on the button that users click to move the object to another

stage.
Actions
. Exception
. - Hide Comment .
Label Mext Stage Email Template Exception Status 5 = Expire
Action Required e
|request | [ Review ~ | [ Exception Review [1 v | [ Approve v [ O Preview
|Close | [ Closed ~ | [ Do not send Email_w || Cancelled v [ O Preview
O W v v Preview
O W v v Preview
O W v v Preview
Workflow Stari Nofification

D Mofify selected stakeholder use Email Templale|

D Mofify requester use Email Template| w |

Allow Delegaficn
Delegation Label: |Delegate To

Allow additional stakeholders to be added Comment required

| use Email Template | Exception Delegation [Det v | Preview

The Actions settings.

sent, select Do not send Email

9. Enter a status for the object once it transitions in the Status field.

Select the stage the object will transition to from the Next Stage dropdown menu.

Optional: Select a template to define which email is sent to stakeholders when the notify settings are enabled. If you do not want an email
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_ For exceptions, this field is a select list called tlkException Status field. Users will
choose the appropriate status from a predefined list created on the Exception
Management Preferences page. All other workflow types will have users enter in
their own status values.

10. Select the Hide Action checkbox if the transition button should be hidden from end-users in the Workflow section of the object. This option is
useful when the transition is automated and does not require any action from the user.

11. Deselect the Comment Required checkbox if the transition does not require end-users to enter comments in the Workflow tab before the
object transitions. This checkbox is selected by default.

5 Exception
Hide Comment Expire

Action Required eI

O ] Preview
Cancelled W D D Preview
b

Exception Status

Preview
~ Preview
w Preview

The Hide Action and Comment Required checkboxes.

12. Optional: Click Preview if you selected an email template in step 8 above and you wish to preview it.
13. Repeat steps 5 to 12 to modify the settings of additional stages as needed.

14. Click Save to save your changes.

Existing objects must be synchronized to reflect changes to the workflow settings. To

synchronize, navigate to the objects (e.g. Home > Tickets) and select Synchronize
Workflow from the More Actions... dropdown menu or open an individual object to
synchronize it from the Workflow section.
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Rename the Stage

The stage name is displayed on the workflow pages of an assessment, policy, exception, ticket, incident, and so on. To change a stage name, select
the stage and click Edit. Enter the new name and click Save.

e For assessment type workflows, you can only modify the stage name if there are no programs already in progress that use the workflow.

e For policies, exceptions, and tickets, the new workflow stage name appears if the process began after you completed the change.
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Configure Stakeholder Settings

A stakeholder is responsible for performing the actions defined in the workflow stage and can transition the process to another stage.
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Assign Stakeholders

You can include roles, specific users, and teams as stakeholders in every workflow stage.
Stakeholders assigned to workflow stages are classified into the following two categories:

1. Task-performing stakeholders

2. Task-aware stakeholders

Task-performing stakeholders: This type of stakeholder performs different actions when the workflow enters a stage. By default, the stakeholders

assigned to a workflow stage are task-performing stakeholders and have the icon next to their name.

Task-aware stakeholders: This type of stakeholder cannot perform any action when the workflow enters the stage. Notifications are sent to this
type of stakeholder so that they are aware of the workflow progress. To assign a user, team, or owner as task-aware stakeholder, add the user as
_—

stakeholder first, then select the stakeholder and click Email Only. Task-aware stakeholders have the icon next to their name.

You must assign at least one task-performing stakeholder to every workflow stage. However, you can assign more than one stakeholder depending
on your use case. The following table describes the selection options for assigning stakeholders to workflow stages:

Option Description

Provides a list of ownership types. When selected, the user assigned to the Entity or Policy with the selected ownership type is

Owner . .
automatically assigned as a stakeholder for the workflow stage.

Team Provides a list of available teams.

Search Allows you to search the User Directory to select users.

n Infarmation Gathering

Assign Stakeholders

Owner l Team t Search ‘ Stakeholders
M Executive Owner
Business Owner
Custom Owner1 Ll Primary Owner
Custom Owner2
Executive Owner Ll Business Owner
Incident Viewer
Primary Owner
il L

Add as Stakeholder==

Email Only Motify Remaove

For assessment workflows, the program must be re-synchronized in order to add a
L stakeholder.

To assign stakeholders:

1. Open RiskVision Policy Manager.
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2. Go to Configuration > Workflows.

3. Click the name of a workflow to open.

4. Click Edit at the top-right corner of the workflow details page.
5. Click a stage.

6. Perform one of the following options:
o To add an ownership type as a stakeholder, click an owner type on theOwner tab.

o To add a team as a stakeholder, click a team on theTeam tab.
o To add a user as stakeholder, click the Search tab, enter the search criteria, and click Search. Under Search Results, select the user.

7. Click Add as Stakeholder. The assigned stakeholders are indicated with a user icon next to their name.

If you have to assign a team in each workflow stage, ensure that the number of stakeholders in a team is less than 200. Otherwise, it may not be
possible to advance a workflow stage when the workflow is assigned to an object such as policy, program, and so on.

To remove a stakeholder:
1. Go to Configuration > Workflows.
2. Click the name of a workflow to open.
3. Click Edit at the top-right corner of the workflow details page.
4. Click the stage to open its details.

5. Under Assign Stakeholders, select the stakeholder, and click Remove. To remove multiple stakeholders within a stage, press and hold CTRL
button on your keyboard, click the stakeholders to select them, and click Remove. The stakeholder(s) is removed.

6. Click Save.
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Allow Stakeholders To Delegate

For each stage, except the terminal stage (closed), you can allow stakeholders to delegate their responsibility to another user or team. The delegate
action adds the delegatee as a stakeholder and notifies them of their new task. The delegatee then acts as the original stakeholder.

To allow delegation:

1. Open RiskVision Policy Manager.

2. Go to Configuration > Workflows.

3. Click the name of a workflow to open.
4. Click Edit.

5. Click a workflow stage to open.

6. Click the Allow Delegation checkbox.

7. Optional: Enter a name in Delegation Label to change the button name.

Allorsy Delegation

Delegation Label: |Delegate uze Email Template: EDD nat send Email % | Preview

Allowy sclditional stakeholders to be added

8. Click Save. New workflow instances will be created from the revised template.
The Delegate label displays in dropdowns, questionnaire taking windows, and other process related places.

Workflow instances that are already in progress are not changed.
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Allow Stakeholders to Add Other Stakeholders

You can allow users to add stakeholders. New stakeholders must perform the requirements defined by the workflow stage. For example, if a
stakeholder is added to the information gathering stage of an assessment, a questionnaire will be sent to them.

Stakeholders can add other stakeholders to workflow definitions, depending on permissions, but not to workflow templates. Synchronizing a
workflow definition with its original workflow template will remove any additional ad hoc stakeholders.

If stakeholders are added to an assessment workflow definition, they will be automatically included the next time the assessment runs.

To allow stakeholders to add stakeholders:

1. Open RiskVision Policy Manager.

2. Go to Configuration > Workflows.

3. Click a workflow name to open. Click Edit.

4. Click a workflow stage to open.

5. Click Allow Additional Stakeholders to be added

6. Optional: To send an email when a stakeholder is added, click the name of an email template from the Notification dropdown.

7. Click Save. New workflow definitions will be created from the revised template.

Workflow instances that are already in progress will not be changed unless they are synced
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Send to Next Stage

Assessment workflows have a 'Send to Next Stage' section with the following options:

Option Description

Allow incomplete sub- Allow responders to submit the questionnaire even though all questions have not
mission been answered.

Automatically move If checked, the workflow automatically advances to the next stage only when all
gffgfﬁﬁgﬁsaﬁféngs"m the questionnaires have been completed and the user submits the questionnaire
tionnaires are complete by clicking the "Submit’ link.

This option works effectively when an assessment has only one questionnaire. In
the case of multiple questionnaires, a workflow stage must have the branching cap-
ability.

Automatically submit If checked, automatically submits questionnaires that require no further input.
Questionnaires that are
answered by automated
controls
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Deleting Workflow Stages

It is possible to delete a workflow's stage in the event it was created in error, or it is no longer needed. Once the stage has been deleted, it will no
longer be possible to assign anything to that stage.

As of RiskVision version 9.3.5, assessment workflow stages can also be deleted. An assessment workflow stage can only be deleted if no
assessments are currently assigned to it. Attempting to delete an occupied workflow will result in the following message being displayed: "You
cannot delete a workflow stage from this workflow because at least one assessment is in this workflow stage. Please contact RiskVision
Support with any questions you may have."

‘You cannot delete a workflow stage from this workflow because at least one assessment is in this workflow stage. Please contact RiskVision Support with any questions
you may have.

[[]Prevent this page from creating additional dialogs

The error message displayed when a user attempts to delete a workflow stage with an assessment assigned to it.

To delete a workflow stage:

1. Navigate to Configuration > Workflows.

Home Entities | Assessments | Content | Analytics [ uh el

Workflows Quesfionnaire Presentation Oplions Email Templates Escalafion Tickei Management Preferences Fitters Ownership Types Assessment Configurafion Enfity Configuration
gxg Workflows 535 Assessment Workflows

Assessment Workflows Actions 1-20 0f 20
= Workflows
M Details Delete Import... Export...
Exception Workflows [ ] [ ] [ & l [ P ] Filter by | - Show all - ¥ ﬁ
Assessment Workflows -
) o Type Name a Stages
Paolicy Workflows
Ticket Workflows [Complete Questicnnaire, Review of
. o Assessment ACME Assessment Workflow Questiennaire, Create Findings. Risk
Finding Workflows Response, Review Mitigations, Closed)
[} Assessment Alternate Assessmemt Workflow gr;‘:n;rmalmn Gathering, Review, Sign Of
[} Assessment Assessment with Scoring gr;‘:n;rmalmn Gathering, Review, Sign Of

The Workflow settings in Configuration.

2. Click a workflow on the grid to open the workflow settings. If needed, use the tree to the left or the filter dropdown menu on the far right to
filter the results on the grid.

3. Click Definition in the pane to the left if it's not already selected.
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,35 Assessment Workflows > ,35 A 1t Waorkflow: ACME t Workfl 4] Back

5:5 Asseszment Workflow: ACME Aszsessment Workflow * Export * Import G’ Edit
Workflow Template Name ACME Assessment Workflow
Definition N
n Complete Questionnaire
Stages
Applications Stakeholders
fl Executive Owner
fl IT Cwiner
Send to Next Stage

Allow incomplete submission

ti Automatically move assessments to the next stage when all Questionnaires are complete

Automatically submit Quesfionnaires that are d by automated coniral
Actions
Label Next Stage Email Template Prompt Credentials
Submit for Review Review of Q i ire Do not send Email No
Delegate Do not send Email

The Workflow Details page.

4. Click Edit in the top-right of the workflow screen.

}5 Assessment Workflows > ,35 A 1t Workflow: ACME t Workfl 4] Back

A Assessment Workflow: ACME Assessment Workflow @ save ) cancel

Workflow Template Name |ACME Assessment Workflow 3 Add New Stage [[J Add Terminal Stage

Definition
n Complete Questionnaire
Stakeholder{s): Executive Owner, IT Owner

Stages
Applications
ﬂ Review of Questionnaire

Stakeholder{s): Risk Oversight Team
[E create Findings

Stakeholder{s): Risk Oversight Team
Risk Response

Stakeholder{s): General Manager
El Review Mitigations

Stakeholder{s): Risk Oversight Team

= I —

Assign Stakeholders

Owner Team Search Stakeholders

Attestafion Owner -
Business Cwner

Chief Risk Officer (CRO)

Cls

150

Custom Owner2

Executive Owner

General Manager hd

Add as Stakeholder=>

Email Only Assign To Remove

Options

] Show Private Comments

The workflow edit screen.

5. Click the e icon next to any stage to delete it.

118



6. Click Save to finalize your changes.
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Other Stage Options

Assessment, Policy, Ticket, Incident, Finding, and Exception workflow stages (except as noted) present the following additional options for advanced

settings.

Option

Workflow Type

Description

Notify selected stakeholder

Ticket, Policy, Finding and Exception

Notify the stakeholder selected in
this stage.

Notify owner

Ticket Finding, and Exception

Notify object owners regarding the
object creation.

Allow submitter/requester to make
changes

Ticket and Exception

If checked, the original submitter or
requester can change the ticketor
exception request.

Note:
e The workflow option has no bearing
on the ticket's owner, who can always
make changes to the ticket.

e |f a user has the object Manage
permission or is a stakeholder then
user will be able to make changes to
the object regardless of whether the
option is checked.

Allow additional stakeholders to be
added

Ticket and Finding

If checked, allow additional
stakeholders to add to the stage.

Allow owner to make changes

Finding

If checked, allow owners to make
changes in the findings

Note:

e |[f a user has the object Manage
permission or is a stakeholder, they will
be able to make changes to the object
regardless of whether the option is
checked.

e The workflow option should only be
applicable if there are stakeholders
mapped.

Add option

All

Click to add reminder and escalation
options. For more information, see
Sending Reminders and Escalations
to Stakeholders

Notify by sending...

All

Notify by sending an e-mail to each
stakeholder individually, or by
sending a single e-mail to all
stakeholders.

For example, if a workflow stage has
2 normal stakeholders and 3 email,
only stakeholders and the user select
the below option:

e Notify by sending email individually
to each stakeholder: 2 emails are sent
to normal stakeholders in TO list with
no one on the CC list and 1 email is
sent to email only stakeholders on the
CC list with no one on the TO list.

® Notify by sending single email to all
stakeholders: 1 email is sent which
includes 2 normal stakeholders in TO
list and 3 email only stakeholders in CC
list.

Allow each questionnaire to advance
workflow stages...

Assessment only

Allow each questionnaire to advance
independently, or require that all
questionnaires must advance
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together. Specify "branch" and "join"
stages that mark the beginning and
ending of independent transition
zones in a workflow. For more
information, see Allowing
Independent Stage Transitions.

Enable preferred user matching

Assessment only

If this option is checked, RiskVision
will send questionnaires to preferred
users. If a preferred user is not found
for a particular entity, a related
option specifies whether to send a
questionnaire. For information about
how to set up the preferred

ownership, see Preferred Ownership.

Allow Control test authoring

Assessment only

If checked, respondents can author
control tests.

Allow Control test evaluation

Assessment only

If checked, respondents can evaluate
control tests.

Read Only Stage

Assessment only

Click and select to prevent
modification of the entire
questionnaire or answers. For more
information, see Locking Answers in
a Questionnaire.

Notify primary owner when
assessment is accessed

Assessment only

If checked, sends the primary owner
of the entity or asset an email when
the assessment is accessed. For
configuration steps, see Notifying
Assessment Owner.

Show Private Comments

Assessment only

If checked, show private comments.

Allow all question scoring

If checked, allow all question
scoring.

This is Review Stage

Check to indicate that the status of
the current stage is in review.

Auto Advance after n days; Action

Advance the assessment workflow
automatically using the specified
action if it is still in this stage the
specified number of days since the
start.

Advance to the next stage
when...

Finding, Ticket and Exception

Automatically advance to the next
stage when any, all, or a specified
percentage of stakeholders have
performed the specified action
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Send Escalations and Reminders to Stakeholders

RiskVision Server allows you to send of escalations and/or reminders to stakeholders when a workflow does not move forward within a specified
time. These notifications can be sent from any stage of any type of workflow. In each workflow stage, you can add a combination of up to ten
reminder and escalation options. Escalations and reminders are sent based on different date fields for different objects. For example, a ticket
workflow allows you to remind a ticket stage stakeholder n days before a ticket will expire. The available escalation and reminder options and the
date types for different workflows are as follows:

WORKFLOW

Assessment

Exception

Finding

Incident

Policy

Ticket

ESCALATE/REMIND OPTIONS

Remind Stakeholder, Escalate to program owner,

and Escalate to stakeholder's manager

Remind Stakeholder and Escalate to

stakeholder's manager

Remind Stakeholder, Escalate to owner, and

Escalate to stakeholder's manager

Remind Stakeholder and Escalate to

stakeholder's manager

Remind Stakeholder, Escalate to owner, and

Escalate to stakeholder's manager

Remind Stakeholder, Escalate to owner, and

Escalate to stakeholder's manager

DATE TYPES

Due date, Recurrence date, Stage start date, and custom

dates

Expiration, Start, Stage start date, and custom dates

Last modified date, Stage start date, and custom dates

Due Date, Time Detected, Time Received, Stage start date,

and custom dates

Stage start date and custom dates

Created, Exception Expiration Date, End, Start, Planned Start,

Planned End, Stage start date, and custom dates
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Add Escalations or Reminders

Most of the workflows in RiskVision Policy Manager have default settings for escalation and reminder notifications within each workflow stage. The
default settings are provided based on the real and practical use cases. The default reminder and escalation settings for each stage in different

workflows are given in the table below:

Workflow Stages
Assessment Stage 1, Stage 2, Stage 3
Stage 4
Exception Stage 1
Stage 2 and Stage 3
Incident Stage 1, Stage 2, and Stage 3
Policy Stage 1, Stage 2, and Stage 3
Ticket Stage 1, Stage 2, and Stage 3

Default Option Settings

Remind stakeholder 7 days after the workflow stage start
date using the Questionnaire Reminder email template.
No reminder or escalation options.

No reminder or escalation options.

Remind stakeholder 7 days after the workflow stage start
date using the Exception Reminder email template.
Remind stakeholder 7 days after the workflow stage start
date using the Incident Reminder email template.

Remind stakeholder 7 days after the workflow stage start
date using the Policy Reminder email template.

Remind stakeholder 7 days after the workflow stage start
date using the Ticket Reminder email template.

You can add more escalation and/or reminder options if the default settings mentioned above do not fulfill your criteria.

To add an escalation or reminder option:

1. Go to Configuration > Workflows. The Workflows page is displayed.

2. Select the workflow to open its details page.

3. Click Edit at the top-right corner of the details page.

4. Click the workflow stage in which you will want to add an escalation or reminder. T

5. Click Options > Add Option.

e Click Add Option to add a

notification type
Add Option

Remind Stakeh « | |7

days  after v

6. Select the reminder or escalation option.
7. Enter a number in the days field.
8. Sselect on, before, or after.

9. Select a date type.

Stage start date v | Email Template | Content Pack Revie v Preview X

10. Select the email template that will be used to send reminders or escalations.
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Edit Escalation and Reminder Settings

You can edit escalation and reminder settings one at a time.

To edit an escalation or reminder:

1

2.

Go to Configuration > Workflows.

Select a workflow to open its details page.

. Click Edit at the top-right corner of the details page.
. Click the workflow stage in which you will want to edit escalations and/or reminders.
. Change the value or select the value in the row corresponding to the reminder or escalation option.

. Click Save after editing the escalation and/or escalation options.
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Delete Escalations and Reminders

You can choose to delete an escalation or reminder notification in as many stages as you want when you no longer need to notify your stakeholders.
Navigate to each stage within a workflow and delete the escalation and reminder options.

To delete escalations and reminders:
1. Go to Configuration > Workflows.

2. Select the workflow to open its details page.

3. Click Edit at the top-right corner of the details page.

4. Click the workflow stage in which you will want to delete escalations and/or reminders.

5. In the reminder or escalation option row, click
6. Repeat step 4 and step 5 to delete escalation and/or escalation options in other stages.

7. Click Save after deleting the escalation and/or escalation options.
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Send Reminders and Escalations to Task-Aware Stakeholders

By default, the configured reminder and escalation options are sent only to the task-performing stakeholders and not the stakeholders who receive
emails only and cannot transition workflows. However, if you want to copy task-aware stakeholders on all of the reminder and escalation
notifications, then you can add the com.agiliance.reminderOrEscaltions.notifyEmailOnlyUsers property to the agiliance.properties file and set it to
true. When this property is added, the reminder and escalation notifications are sent out to task-aware stakeholders for all stages and workflow
types. For information about task-aware and task-performing stakeholders, see Assigning Stakeholders.
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Delegation & Delegation Revocation

Users with Manage permissions on an object can read, create, modify, and update instances of that object. These users can also delegate, revoke
delegation, and force workflow transitions. Workflow stages can be delegated to any RiskVision user or team. In order to delegate a stage in the
workflow, delegation must be enabled. Delegation and delegation revocation is controlled on a per-stage basis by the Allow Delegation option.

It's good practice to add a comment/reason for delegation or revoking delegation in the Comment section. The comments added are visible to all
users who have read access to the Workflow tab of the object and can view the comments in the Workflow History section as show below.

Name: Default Ticket Workflow

[ Legend I Current Stage Stages Visited Yet to visit Stage
m 2 InProgress | 3 Review | 4 Closed l
Since: 2021-05-19 07:30:19
Current Owner(s):
Stage Actions: 1 of 1 needed for moving workflow te “In Progress”

1 of 1 needed for moving workflow to "Closed”

D Force Transifion

To use your elevated permission to force workflow fransitions, please check the check box to force a transition,
and then select the button below for the padicular transition that you would like to force.

[ Accept ] [ Reject ] [ Delegate To ] [ Revoke Delegation ]

b comments
P Documents

P Linked To

| Workflow History

1-20f2

) Force
Date w Stage Action To Stage Transition User Target User Comment

2021-05-19 :De|egaten o
133949 MiA User(s) M No

The Workflow History section of a delegated workflow.

The delegation option that is discussed in this section is available for the below objects:

Not all of the below objects will be available in each application.

e Tickets

e Findings

e Incidents

e Exception Requests
e Controls

e Policies

For Tickets, Findings, Incidents and Exception Requests, workflow stakeholders can view delegated objects in the My Tickets Delegated To Others,
My Findings Delegated to Others, My Incidents Delegated to Others and My Exceptions Delegated to Others column of their respective grids.

For Tickets, Findings, Incidents, and Exception Requests, stakeholders can perform bulk delegation and delegation revocation from the More
Actions dropdown list.
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Welcome Message Center Tickets Exceplion Requests
& Tickets & Open Tickets
Open Tickets Adtions v o
= My Tickets
- S
My Undelegated Ticksts [ Details ] More Actlions... Filter by| - Show all- ¥ |
More Actions... e
— T . Synchronize Workflow Awaitin: - . In Stage
My Tickets Delegated To Cthers || TicketlD Title lem Edit Tickets pe Owner Action gy Entities Risk Progress Created Time Sinceg
=/ By Status Delegate x 20190817
w Save as CSV d -03- 09
Open Ticksts O TKTo0093 Ticket_01 it Finding o NiA s [ — o 2019-09-17
Closed Tickets 2019.08.47
| By Stage [J TKT00092 T Assigned Audit Finding & HiA [ wim [ — 16:02:33 2019-09-17
I+ By Type
F AN Tickets
The Delegate option in the More Actions dropdown.

Any stakeholder of a stage that permits delegation can delegate to another user. The workflow designer can allow team Delegation at each stage. For
example, the In Progress and Review stages may allow for delegation, whereas the Approval stage might be designed not to allow delegation. The
workflow designer can choose another label to describe delegation, such as "Delegated To" or "Transfer Authority" and can select an email template
used to notify the delegate.

Name: Default Ticket Workflow

[ Legend I Current Stage Stages Visited Yet to visit Stage
m 2 InProgress | 3 Review | 4 Closed l
Since: 2021-05-19 07:30:19
Current Owner(s):
Stage Actions: 1 of 1 needed for moving workflow te “In Progress”

1 of 1 needed for moving workflow to "Closed”

D Force Transifion

To use your elevated permission to force workflow fransitions, please check the check box to force a transition,
and then select the button below for the padicular transition that you would like to force.

[ Accept ] [ Reject ]l Delegate To I[ Revoke Delegation ]

The Delagate To button.

Delegation Revocation

The original stakeholders can revoke a delegation at any time, regardless of how many times delegation has occurred. This is true regardless of
whether the current delegate is the original delegate.

Name: Default Ticket Workflow

[ Legend [ Current Stage Stages Visited el to visit Stage
m 2 InProgress | 3 Review | 4 Closed l
Since: 2021-05-19 07:30:19
Current Owner(s):
Stage Actions: 1 of 1 needed for moving workflow to “In Progress"

1 of 1 needed for moving workflow to "Closed"

D Force Transifion

To use your elevated permission to force workflow fransitions, please check the check box to force a transition,
and then select the button below for the padicular transition that you would like to force.

[ Accept ] [ Reject ] [ Delegate To ]l Revoke Delegation I

The Revoke Delegation button.
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Lock Answers in a Questionnaire

The Assessment workflow type allows you to put a questionnaire in read-only mode when the workflow is in certain stages. Stages after the first
stage of the assessment workflow can be designated as a Read Only Stage. When setting a stage as a Read Only Stage, you have two options:

1. Make the entire questionnaire read only; and

2.

Make answers read only.

Your selection will depend on how much freedom you want to give workflow stakeholders who are not responsible for answering questionnaires. If
you want to allow reviewers and approvers to add evidence, comments, and other information, make answers read-only. If you don't want to allow
this, make the entire questionnaire read-only.

To lock answers in a questionnaire:

1.

2.

Go to Configuration > Workflows.

Click the Assessment Workflows group under the Workflows tree.

. Click a workflow to open.

. Click Edit in the upper right-hand corner.

. Navigate to the stage of interest, excluding stage one.
. Go to Options.

. Check the Read Only Stage checkbox, then click Make answers read only in the dropdown list.

Options

Add Option
Remind Stakeh v days |after v || Stage stari date v | Email Template | Questionnaire Remi v |Preview =

' Motify by sending email individually to each stakeholder
' Motify by sending single email to all stakeholders

" Allow each guestionnaire to advance workflow-stages independently
"' All guestionnaires must advance workflow-stages together

| Enable preferred user matching. If no matching users found.
Send Questionnaire Don't Send Questionnaire

I Allow Control test authoring
) Allow Control test evaluation

¥/ Read Only Stage | Make answers read only v

=) Show Private Comments

) Allow all question scoring

I#| This is Review Stage

) Show mitigation requests

) Auto Advance after I:I days; Action v

8. Optional: Repeat steps 5 and 6 if you have to put answers in ready-only mode in other stages of the workflow.

9. Click Save.
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Force Stage Transition

Any user with appropriate permissions can force the stage transition of a workflow for objects such as tickets, exceptions, findings, or incidents,
when the stage stakeholder fails to transition the workflow to the next stage in time. Only a primary policy owner can force a stage transition in a
policy workflow. When a workflow stage is set to advance automatically to the next stage after a certain number of stakeholders have performed a
particular action, force transition allows you to override this requirement. The following table lists the objects and the permission or ownership criteria
required to force a stage transition.

Object Criteria

Ticket Manage permission

Exception =~ Approve permission

Incident Manage permission
Finding Manage permission
Policy Primary ownership

To force a stage transition:

1. Select an object.
2. Go to the Workflow section.

3. Check the Force Transition checkbox, then the desired action to complete the transition.

=& Ticket: Restart Oracle Server

W Workflow

Name: Default Ticket Workflow

= iini 2 InProgress | 3 Review | 4 Closed

Since: 2016-05-10 11:30:12
Current Owner{s): e (Details B )
Stage Actions: 1 of 1 needed for moving workflow to "In Progress™

1 of 1 needed for moving workflow to "Closed”

H

[ Force Transition

To use your elevated permission to force workflow transitions, please check the check box to force a transition,
and then select the button below for the particular transition that you would like to force.

Aﬁ:ce;ﬂ-t_: . Iieject ;- E]e.léga.t.e_'l-'_o _ Revoke Delegation
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Determining Stage Transition Mode

Users can transition the workflow stage if they are the stage stakeholder, or if they possess the ownership or appropriate permissions. The
Workflow History section shows how ticket, exception, incident, and policy workflow stages were transitioned and by whom.

The Force Transition column indicates whether the transition was forced and the User column displays the stakeholder who completed the transition

or action.

¥ Workflow History

1-10f 1

Date - Stage Action To Stage Force Transition User Target User Comment
2018-0817 ] Ticket workflow
16:02:56 T Start Workflow Assigned Mo TEY started

The Workflow History section.
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Manage Workflow Escalations

Workflow stages can be configured to send escalations to the program owner, the stakeholder’'s manager, or both, for further action if the workflow
does not advance to the next stage within a specified time. Each workflow stage can be configured separately with a number of days before
automatic escalation. For example, you might configure a compliance assessment workflow to notify the program owner seven days after a
questionnaire enters the Review stage. The notification email will use the Questionnaire Escalation template, and will only be sent if the
questionnaire stays in the Review stage for more than seven days.

To configure escalations in a workflow:

1. Go to Configuration > Workflows, select a workflow, and then click Details.

2. Click a workflow stage, then click Edit.

Options

Add Option

Remind Stakeh ¥ |2 days | after ¥ | | Stage start date ¥ | Email Template | Default Ticket Assig ¥ |Preview x
Escalate o own ¥ IT days| after ¥ | | Stage start date ¥ | Email Templaie ¥ |Preview x
Escalate fo stak ¥ IS days| after ¥ | | Stage start date ¥ | Email Templaie ¥ |Preview =

The Options section.

3. Check the Escalate to owneror Escalate to stakeholder's managerto send notifications.
4. Enter the number of days, the date, and whether it should be sent before, after, or on the date.

5. Select the email template from the dropdown list to use for the notification. You have the option to send notifications to both the program
owner and the stakeholder's manager.

6. Click Save.

If the ticket does not have an owner, configuring a ticket workflow for the escalate to owner option will not send notifications to a recipient. In a
Policy workflow, selecting the Escalate to Owner option sends a notification to the policy's primary owner. If a stakeholder does not have a a
manager, Escalate to stakeholder's manager will not send a notification.

To assign a manager to a stakeholder:
1. Open the RiskVision Administration application.

2. Click the Users tab.

3. Click the stakeholder's username to open their account.

4. Click Edit.

5. Click the Manager dropdown and select the appropriate user.

6. Click Save.
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Notify the Assessment Owner

To notify the assessment owner, stakeholders must access the assessment at the first stage of the workflow. If you are a program owner and want
your assessment owners to receive notifications, you must perform the following steps before you create a program:

1. Gotothe $%AGILIANCE HOMES$\config directory,openthe agiliance.properties file using a text editor, and add the following

properties:
o notify.assessment.owner.enabled=true - setthis property as 'true' to enable the effect of the Notify primary owner

when assessment is accessed option.

o com.agiliance.assessment.surveystart.notifyowner.emailTemplate= - specify the email template's name with
which you want to notify stakeholders when a questionnaire is accessed first.

2. Restart the Tomcat application server to update to the latest changes.

3. Once the Tomcat application has restarted, open the assessment workflow details. ClickEdit to bring the workflow into edit mode, scroll
down to the details of the first stage, and select the box next to the Notify primary owner when assessment is accessed option.

When assessments are accessed for the first time, a notification is automatically sent to the primary owners of the respective assessments.
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Specify Multiple Workflows

RiskVision allows you to switch between workflows. Different workflows can be selected based on the actual value of the runtime property. This is
particularly useful for tickets, exceptions, and incident workflows. Multiple workflows allow you to create a fast track ticket workflow. For example,

with a single workflow, a ticket would always use the default ticket workflow.

You can specify conditions under which the new workflow will be used in the Selection tab.

To define a selection condition:

1. Open a workflow that will be selected under certain conditions. Workflows without selection criteria will be selected by default, as before.

2. Click the Selection tab, then click Edit.

3. Select an attribute, operation, and value. For example, Priority Equals High.

Ticket Workflow

v |[Hgh v ]

Definition 7 | Priority v | Equals

a Save a Cancel

v | | Containg

Stages M

v | |Delelion Required

Selection

The Selection tab in Edit mode.

4. Click Save.

You can import the selection criteria of workflow templates created in RiskVision version 6.0 SP2 or higher.
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Define More Complex Selection Conditions
The Selection Criterion editor can be used to specify complex AND and OR conditions. In addition, parentheses can be used to specify sub-
conditions.

For example, if you create three conditions, such as Priority =/= Medium, Owner = John, and Type = Audit Finding, you can choose:

CONJUNCTION DESCRIPTION
AND All conditions must be true to select this workflow.
OR This workflow will be selected if any of the conditions are true.
XOR

Exclusive OR. Select the workflow if one of the conditions is true, but not if more than one is true.

535 Waorkflows » Ticket Warkflow

Ticket Workflow

#] Back
Q Save g Cancel

Definition 7< | Priority

r || Medium ¥

Stages

7 [ owner v | Equals v |[John
. OR ¥
Selection 7 | Type v | Equals v | | Audit Finding v

The Selection Criterion edlitor.
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Specify Sub-Conditions

EXAMPLE

You want to select this workflow whenPriority > Medium, when Owner isJohn, or whenType
is Entity Control Resolution, Risk Assessment Mitigation, or Other. To specify the last three

sub-conditions, you use the + { }button.

‘35 Waorkflows » Ticket Workflow 4] Back
Ticket Workflow @ save @) cancel

Definition 7< | Priority v | Not equals ¥ | [ Medium v |

Stages 7< | owmner v | Equals v |[Jahn |

Selection

ol |Type v | | Equals v || Entity Control Resolution v |

OR ¥ < [Type v + || Equals v || Risk & Mitigation ¥ |
7 [anD v |
< [Type v | Equals v || Other v

The Selection Criterion editor with sub-conditions.

Sub-conditions can be nested as deeply as necessary. The OR and AND of the first example might be inverted. You might want to select the
workflow when Priority > Medium AND when one of a set of sub-conditions is true.

‘!2‘ Warkflows » Tickef Woridflow 4] Back

Ticket Workflow @ save @ cancel

Definition < | Priority v | Mot equals ¥ || Medium ¥ |
Stages 7< | owner v | Equals L HJohn |

Selection
> |Type T | | Equals

¥ || Entity Control R v

> |Ty|:e T | T || Risk Assessment Mitigation v |
> | Category | Equals v ||Crit |
X [AND ¥ 7< [ Category | Equale ¥ | [critical |
< [xor v |

Fat |Category r | | Is null r |

-0

0

The Selection Criterion editor with two layers of sub-conditions.

In the previous example, the workflow will be selected only whenPriority does not equal Medium, the Owner is John, and one of the following
conditions is true. Either the Category is Null, it starts with Crit, or it ends with Critical. If the Category starts with Crit and ends with Critical, the
workflow will not be selected because you used the Exclusive OR (XOR) operator.
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Allow Independent Stage Transitions

Questionnaires associated with an assessment can advance through workflow stages independently. Note that prior to version 4.1, questionnaires
had to transition through workflow stages in unison. By default, questionnaires still advance through workflow stages together. Questionnaires all
start in the first stage of a workflow ("Information Gathering," for example) and must reach the Terminal stage together. You can create custom
templates that allow independent stage transitions, also known as branching.

Relationships with a set of standard workflow templates, including "Assessments with Branching," which supports independent stage transitions.
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Create Workflows With Branching

Workflow stages have actions that transition questionnaires to different stages. Typically, questionnaires advance through stages 1, 2, 3, and so on,
but returning to previous stages is common. Review or Approval stages, for example, might include a ‘Reject’ action that reverts to an earlier
workflow stage.

When you create a custom workflow template, specify the number of stages you would like and end with a Terminal stage. Each stage includes
notifications and other options. While planning your workflow template, decide which stages will allow questionnaires to advance independently and
which will not.

EXAMPLE

In a five-stage workflow, you want to allow independent movement in stages 2 through 4. Set
stage 2 to “branch” and stage “4’ to “join” by selecting the Allow each questionnaire to
advance workflow-stages independently option in stage 2 and théll questionnaires must

advance workflow-stages together option in stage 4.

Surveys can transition between stages
independently

Terminal Stage

“Branch® “Jaoin"

{Allow each survey to advance {All surveys must advance
workflow-stages independently) workflow-stages together)

Rules

1. Every "branch" stage (Allow each questionnaire to advance workflow-stages independently) must have a matching "join" stage (All
questionnaires must advance workflow stages together) later in the workflow.

2. A workflow can have more than one branch-join pair, but they cannot overlap.

EXAMPLE

Correct: 1 - 2 (branch) - 3 - 4 (join) - 5 - 6 (branch) - 7 - 8 (join) - 9 (terminal)

Incorrect: 1 - 2 (branch) - 3 - 4 (branch)

Solution: Join the first branch before starting second branch

Incorrect: 1 - 2 (branch) - 3 - 4 (terminal)

Solution: Join the branch before the terminal stage

3. A'branch" stage (Allow each questionnaire to advance workflow-stages independently) can have actions that transition to stages before
the branch stage, but no questionnaire can to advance past the "join" stage until all questionnaires have reached the "join" stage.

4. Stages after a "join" stage (All questionnaires must advance workflow-stages together) cannot have actions that transition to stages before
the "join" stage.
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Options

[ remind Stakeholderl:l days after start date; use Email Template:|

h | Preview

O Es=calate to program ownerl:l days after start date; use Email Template:|

b |F'rea-'iew

O E=calate to stakeholders managerl:l days after start date; use Email Template:|

v

Preview

Create a "Branch”
stage

ividually to each stakeholder
ail to all stakeholders

@ Allow each questionnaire to advance workflow-stages independently
O All questionnaires must advance workflow-stages together

Options

O Remind Stakeholderl:l days after start date; use Email Template:|

b | Preview

[l Escalate to program ownerl:l days after start date; use Email Template:|

h |F'FE'v'iE".n\l'

[ Escalate to stakeholder's managerl:l days after start date; use Email Template:|

]

Preview

Tos H ividually to each stakeholder
Create a "Join '

stage ail to all stakeholders

l each questicnnaire to advance workflow-stages independently
@ questionnaires must advance workflow-stages together
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Preferred Ownership

Objects such as entities and controls have at least one owner. Object owners can be nominated as the primary stakeholders of any workflow stage
so that they can manage the objects in an assessment. Alternatively, you can also assess entities based on the controls, groups or control objectives
with preferred ownership that match the workflow stage owners and entity owners. Preferred ownership allows stakeholders to answer a
questionnaire that is different from other stakeholder's questionnaires of the same program assessment. That is, preferred ownership allows the first
stage of an assessment workflow to send a unique questionnaire to each stakeholder.

To implement preferred ownership:

1. The control, control objective, content pack, or group must list the ownership type in the Target Entity’s Preferred Ownership field.

Attributes
Status | Select a status v|
Key Control |Nu vl
Version | |

Target Entity's Preferred Ownership

2. In the assessment workflow options, selectEnable preferred user matching and indicate whether a questionnaire must be sent if the
preferred user is not found for a particular entity.

Enable preferred user matching. If no matching users found.
O Send Questionnaire C‘ Don't Send Questionnaire

If Enable preferred user matching is selected and no matching users are found, the default behavior is that the questionnaire will not be sent.
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About Preferred Ownership Options

If your assessment is only valid when key object owners participate, you may want to skip sending a questionnaire when no preferred owners match.

If any owner can answer when a preferred owner does not exist, send questionnaires even if no preferred owners match. Below are the preferred
ownership options for sending a questionnaire if no matching users are found:

e Assess entities when control preferred owners and workflow stakeholders do not match
o Do not send questionnaires if no matching users are found When you launch an assessment workflow, RiskVision will compare the
preferred ownership of a control (group or control objective) with the stakeholders of a workflow stage. If no match is found, controls
are not created, meaning the controls are not listed in the Assessment Details tab of the program.

o Send questionnaires if no matching users are found When you launch an assessment workflow, RiskVision will compare the
preferred ownership of a control (group or control objective) with the stakeholders of a workflow stage, and if no match is found, it
compares the workflow stage stakeholders with the entity owners. If a match is found, a questionnaire is sent to the matched
stakeholders to log the answer choice. Otherwise, only stakeholders can view the questionnaire.

e Assess entities when control preferred owners and workflow stakeholders match:
o When you launch an assessment workflow, RiskVision will compare the ownership of an entity with the matched owners of a
workflow stage and control (group or control objective). If a match is found, a questionnaire is sent to the matched stakeholders to log
the answer choice. Otherwise, stakeholders can only view the questionnaire.

The preferred ownership feature only works in the first stage of an assessment workflow that allows each questionnaire to advance the workflow
stages independently.

Assign the preferred ownership at the same level as the content added in a program. For example, if the preferred ownership is assigned to the
content at the group level, assign the content to the program at the group level. If the preferred ownership is assigned to the content at the control
level, assign the content to the program at the control level.
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Visualize Workflows

Workflows can be simple or complex, ranging from a few stages with sequential transitions to 20 or more stages with transitions that skip stages and
go back to previous stages. For simple workflows, the Definition tab allows you to add and configure stages and helps you quickly grasp the stage
transitions and the overall behavior.

For workflows with multiple stages, you must be precise in setting up each stage and test the workflow to ensure the behavior is as expected. The
Stages tab can be used to gain a quick understanding of complex workflows. It shows all stage transitions, both forward and backward, and not just
the sequential transitions, and allows workflows to be visualized in graphical layout.

A Workflows » Ticket Workflow
Ticket Workflow

(#®)(s)(=])(@)] [remene ~)(5]l[®][x]I[2]

The Stages tab.

For information about the tool options, see Visualizing Objects.
The following is an explanation of the various elements of the Stages tab:

e The rounded rectangle in the graph represents the stages in a workflow.

e The incoming and outgoing arrows represent the transitions and indicate that transitions happen only between those stages. The direction of
the arrow shows whether the transition is forward or backward.

e The Stage pane displays the stage information. Click a stage to view the action and the stage that a workflow will enter when that action is
performed by the stakeholder.
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4[] Back

A Workfiows » Ticket Workflow
Ticket Workflow

(#®)(sa)(= (@] | (e +)(8]] (@ ][x ][]

Stage
Name: Apply
Changes
Action MNext Stage
Review In
Changes Complete Progress
Reject Closed
Overview

h |

%,
!
- !

The Stage pane when the Apply Changes stage has been selected.

e The Overview pane allows you to move the workflow layout in different directions. For more information, seeMoving the Layout.
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Escalation

Escalation configurations allow you to control the email notifications that are sent when a due date has passed. Three levels of escalation are
supported, each with distinct evaluation criteria, recipients, and email templates.

By default, RiskVision provides a single level escalation that sends an email to the ticket owner's Manager one day after the ticket is due. This

escalation uses the Default Escalation Email Template by default. You can define additional levels, additional escalations, and individual and team
recipients.

For more information about the email template associated with each level of an escalation, seeAbout Email Templates.

To manage escalation configurations, go to Configuration> Escalation.
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Create an Escalation Configuration

Escalation configurations define what happens when a ticket is overdue. Selected recipients are notified using an email template.
If your escalation requires a custom email template, create the email template.

You can create, update, or delete an escalation if your user role has Email Template View and Email Template Manage permissions.

To create a new escalation configuration:
1. Go to Configuration > Escalation.
2. Click New.
3. Enter the General settings as follows:
o Name: Enter the display name that users will use to identify this escalation configuration.
o Description: Enter a summary that will be visible only on the escalation page.

4. Create an escalation for Level 1 by clicking New in the Escalations section. You can repeat these steps to create escalations for Level 2 and 3
later, if desired.

5. Enter the Escalation settings as follows:

o Escalation Level: Choose 1 for the first response to an overdue ticket. To create a different response if the ticket remains overdue,
create a second escalation with Level 2.

o Email Template: Select from the list of available e-mail templates. Click Preview to see how the email will look.

o Escalation Date: The number of days after the ticket is due that triggers this message. Level 1 might be triggered 1 day after a ticket's
due date while Level 2 is triggered a few days later. Level 3, if required, would be triggered later.

o Recipients: Check Requester or Owner Manager, or select individuals or teams to receive this message.
6. Click OK.

7. Click Save to save the new escalation configuration.
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About Email Templates

Use customized email templates to include organization-specific details in messages sent to stakeholders during assessments, ticket resolution, and
other processes.

Resolver uses the Velocity template engine to generate workflow and system messages. You can use some basic Velocity syntax and parameters to
insert context data, such as the user's name, program name, program owner name, entity name, and dates and deadlines. For example, "Hi
SUsername" inserts the actual stakeholder's first and last name into the message.
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Default Email Templates

The default template types available depending on the RiskVision application you're using. This is a complete list of the default templates available:

Name

Alert Notification
(HTML)

Alert Notification

Assessment Launch

Assessment Launch

Status

Assessment

Recurrence

Assessment Review

Assessment Review

Rejection

Assessment Signoff

Assessment Signoff

Rejection

Classification

Assessment Launch

Content Pack

Delegation

Content Pack

Deployed

Content Pack

Escalation

Content Pack

Reminder

Content Pack Review

Content Pack Review

Rejection

Default Escalation

Type

Alert

Alert

Assessment

Assessment

Assessment

Assessment

Assessment

Assessment

Assessment

Assessment

Control

Control

Control

Control

Control

Control

Escalation

Description

Used to notify users that a compliance, control or risk score has crossed a specified

threshold.

Used to notify users that a compliance, control or risk score has crossed a specified

threshold.

Notifies users that a new assessment has been launched.

Notifies program owners of assessment launch success or failure.

Notifies program owners that an assessment that is configured for recurrence is about to

be restarted.

Sends e-mail when an assessment is sent out for review.

This template is used when an assessment you sent out for review was rejected.

Sends e-mail when an assessment is sent for sign-off.

This template is used when an assessment that you sent out for sign-off was rejected.

This template is used when a new risk classification assessment has been launched.

This template is used when a Content Pack is delegated from one user to another user.

This template is used when a Content Pack is deployed.

This template is used to alert users that a Control's due date is passed.

This template is used to remind the user about upcoming due dates.

This template is used when a Control is ready for review.

This template is used when a Control is rejected during the review.

This template is used for sending an escalation notification.
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Name
Default Ticket

Escalation Template

Default Ticket

Assignment

ERM Assessment

Launch

ERM Risk Opinion

Review Request

Exception Delegation

Exception Escalation

Exception Expire

Exception Reminder

Exception Review

Exception Review

Rejection

Exception Signoff

Exception Signoff

Rejection

Finding Closed

Finding Delegation

Finding Escalation

Finding Reminder

Finding Review

Finding Review

Rejection

Finding Update

Notification

New Finding

Type

Ticket

Ticket

Assessment

Risk

Exception

Exception

Exception

Exception

Exception

Exception

Exception

Exception

Finding

Finding

Finding

Finding

Finding

Finding

Finding

Finding

Description

The default template used when tickets themselves are escalated.

This template is used when a new ticket has been launched.

This template is used when a new ERM assessment has been launched.

This template is used to notify users to request an ERM risk opinion.

This template is used when an exception is delegated from one user to another user.

This template is used to remind the user that the exception assigned to them is past the

due date.

This template informs a user that an exception has expired.

This template is used to remind the user about upcoming exception due dates.

This template is used when an exception is ready for review.

This template is used when an exception is rejected during the review.

This template is used when an exception is ready for sign-off.

This template is used when an exception sign-off was rejected.

This template is used when a finding is closed.

This template is used when a finding is delegated from one user to another.

This template is used by the system to notify an assignor that a finding that they have

assigned has not been worked on and is nearly past the due date.

This template is used to remind users about upcoming due dates on findings.

This template is used when a finding is ready for review.

This template is used when a finding is rejected during the review.

This template is used to notify the finding owner when the finding is updated.

This template is used to notify stakeholders when a finding is created.
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NQQW Vendor Contact

Notification

Incident Closed

Incident Delegation

Incident Detected

Incident Escalation

Incident Reminder

Incident Review

Incident Review

Rejection

Incident Signoff

Incident Signoff

Rejection

Out of Office

Delegation

Questionnaire

Assignment

Questionnaire Change

Notification

Questionnaire

Delegation

Questionnaire

Escalation

Questionnaire

Reminder

Report or Dashboard

Delivery

Response Notification

Error

Response Notification

Success

Type
Vendor

Incident

Incident

Incident

Incident

Incident

Incident

Incident

Incident

Incident

Access

Delegation

Assessment

Assessment

Assessment

Assessment

Assessment

Analytics

System

System

Dﬂ?&"l@ﬁﬂnate is used for notifying a new vendor contact that his/her login account has been

created.

Notifies users that an incident is closed.

This template is used when an incident is delegated from one user to another.
Notifies that an incident is detected.

This template is used to remind users that the incident assigned to them is past the due

date.
This template is used to remind the user about upcoming due dates on incidents.

This template is used when an incident is ready for review.

This template is used when an incident is rejected during the review.

This template is used when an incident is ready for sign-off.

This template is used when an incident sign-off is rejected.

This template is used to notify users of assigned access delegations.

Used for data gathering to notify users that a questionnaire has been assigned to them.

Used to notify assessment stakeholders that the questionnaire has been changed.

Used to notify a user that another user delegated a questionnaire to them.

Used to alert users that the questionnaire assigned to them is past the due date.

Used to remind users of questionnaire due dates.

This template is used when a report or dashboard is sent to the user.

An HTML template used to send notification that a user request was not successfully

processed.

An HTML template used to send notification that a user request was successfully

processed.



Name

Response to
Password Reset

Request

Risk Assessment

Launch

Risk Identified

Scheduled Job
Completed

Successfully

Scheduled Job Failed

Threats Advisory
Alerts

Ticket Assignment

Notification

Ticket Update

Notification

Ticket Closed

Ticket Delegation

Ticket Escalation

Ticket Reminder

Ticket Review

Ticket Review

Rejection

Vulnerability
Assignment

Notification

Type

System

Assessment

Risk

System

System

Alert

Ticket

Ticket

Ticket

Ticket

Ticket

Ticket

Ticket

Ticket

Alert

Description

Sent when a user requests their password to be reset.

This template is used to notify stakeholders that a new risk assessment has been launched.

This template is used to notify owners that a new risk is identified.

Sends a job success notification.

Sends a job failure notification.

Used to notify users when new threats or vulnerabilities are reported by security research

organizations.

Notifies a user they have been assigned a ticket.

Notifies the ticket owner when the ticket is updated.

Sends a notification that a ticket was closed.

Sends a notification that a ticket was delegated from one user to another user.

Used to alert users that the tickets are assigned to them after the due date is passed.

Reminds a user about upcoming due dates on tickets.

Sends a notification that a ticket is ready for review.

Sends a notification that a ticket was rejected during the review.

Used to notify a user that they have become the owner of a vulnerability.
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Configure Email Templates

This section explains how to create, delete, and modify an email template. On the Configuration menu, click Email Templates to view default and
custom created template types. To view email templates, you must have the Email Template View permission, and in order to create, delete, or

modify them, you must have the Email Template View and Email Template Manage permissions.

The following email template types are available:

Access Delegation. Used when notifying users of assigned access delegations.

Assessment. Available for selection in assessment workflows.

Analytics. Available for selection in the Administration application when a report or dashboard is sent to a user.

Control. Available for selection in policy workflows.

Ticket. Available for selection in ticket workflows.

Incident. Available for selection in incident workflows.

Exceptions. Available for selection in exception workflows.

Finding. Available for selection in finding workflows.

Alerts. Sent for events, such as an entity scoring higher for risk or compliance than the threshold.
Escalation. Used when a ticket is overdue.

Reports. Sent for report notifications.

Vendor. Used to notify the primary vendor contact of changes.
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Update an Email Template

Modifications to email templates take effect immediately.

To update an email template

1. Go to Configuration> Email Templates.

2. Select a template and then click Details. The template opens in a pane below the grid.
3. Click Edit.

4. In the General section, edit the following settings:

e Display Name: Enter the short name for the template.

e Template Type: Select the workflow type.

e Content Type: Select either HTML or Plain text content type of a template.

e Description: Enter information that will help others understand the use of template.
e Send Immediately: Send notifications without sequencing.

e High Priority: Send notifications with high importance.

e Sender Email Account: Select the email account that will send the notifications. The RiskVision administrator's email account is used
by default.

o Template text: Author information that suits the template type. Text can be formatted using HTML.

5. When you finish modifying the template, click Save.
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Add a New Customized Email Template

Users with sufficient privileges can create new email templates for later use.

To create an email template:
1. Go to Configuration > Email Templates. In the Administration application, go to Administration > Email Templates.
2. Click New.
3. Enter the following fields in the General section:
o Name: Enter the display name that users select when setting up a workflow.
o Template Type: Select the workflow type.
o Content Type: Select either HTML or Plain text.
o Description: Enter information that will help others understand the use of the template.

o Send Immediately: Send notifications without sequencing and/or merging. See also Sequencing and Merging of Email Notifications.

o High Priority: Select to send the notifications with high importance. By default, all of the escalation email templates are sent with high
priority.

o Sender Email Account: Select the email account that will be used to send the notifications. By default, the RiskVision administrator's
email account is used for sending email notifications.

4. Enter the message content. We recommend basing your new template on one of the default templates.
5. Click Save.
The email template is now available for selection in workflow templates.

To understand how an email template can be used to notify the stakeholders, see Setting up Email Notifications.
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Email Template Variables

The system automatically replaces the variables in the following sections with the corresponding value when the notification or email is sent.

In designing your own email template or modifying those provided, use the default templates as a guide to what variables are available for different
types of email template and for how they are used.

e Alert Email Templates

o Assessment Email Templates
e Analytics Email Templates

e Exception Email Templates

e Finding Email Templates

e Incident Email Templates

o Risk Email Templates

o Ticket Email Templates

e Vendor Email Templates

® More Variables
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Alert Email Templates
The following variables are available to designers of this type of email template:
VARIABLE DESCRIPTION

Includes properties and methods that describe the details of the alert of which the user is being

notified. For example, details.alertRule is one property. Alert rule is itself an object, comprised
details

of the properties name and description. So, to cause an Alert email template to display the name of the

alert rule that triggered the notification, the designer would specify Sdetails.alertRule.name.
details.alertRule.description =~ The description of the alert rule that triggered an email notification.

details.alertRule.name The name of the alert rule that triggered an email notification.
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Assessment Email Templates

The following variables are available for this email template:

Variable Description

email The email object gives the designer access to the setSubject method, which takes a
string that can include other variables.

projectName The name of the Program associated with this assessment.

surveyName The name of the Questionnaire.

projectDescription The description of the Program associated with this assessment.

userName The recipient of the email, usually a stakeholder in the current assessment

launchStatusDetalis A descriptive string (Assessment Launch Status template only).

assessmentName The name of the assessment.

commentOwnerName The name of the user rejecting the assessment (Review Rejection or Signoff
Rejection only).

comment The text of the comment associated with the rejection (Review Rejection or Signoff
Rejection only).

You can add the SNT.getValue("RAProject.version") variable in any assessment email template type to display the assessment's version number.
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Analytics Email Templates

The following variables are available for this email template:

VARIABLE DESCRIPTION

The email object gives the designer access to the setSubject method, which takes a string that can

email

include other variables.
userName The recipient of the email, usually a stakeholder in the current workflow.
objectValue The name of dashboard or chart.

passwordProtectedStatement =~ The password to open the report.

appurl The URL of the RiskVision application.
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Exception Email Templates
The following variables for this email template:

VARIABLE DESCRIPTION

email The email object gives the designer access to the setSubject method, which takes a string that can

include other variables.

userName The recipient of the email, usually a stakeholder in the current workflow.

workltemName The name of the workltem, either a Control, a Subcontrol, or another kind of item.

stageName The name of the current workflow stage.

xceptionName The name of the exception (Exception expire template only).

exceptionEndDate The expiration date of the exception (Exception expire template only). SeeModifying a Variable

Displaying Date.
ownerName The owner of the exception (Exception expire template only).

commentOwnerName The name of the user transitioning the workflow stage.

You can add the $Sexceptionld variable in any exception email template type to display the exception ID.
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Incident Email Templates

The following variables are available for this email template:

Variable

email

userName

workltemName

stageName

incidentName

incidentTypeName

incidentSubTypeName

incidentld

incidentDetected

incidentStatus

commentOwnerName

Description

Gives the designer access to the setSubject method, which takes

a string that can include other variables.

The recipient of the email, usually a stakeholder in the current

workflow.

The name of the workltem, either an incident or other type of

item.

Name of the current workflow stage.

Name of the incident (Incident closed template only).

Name of the incident type.

Name of the incident subtype.

The incident identifier (Incident closed template only).

The string of the date and time the incident was detected

(Incident closed template only).

Current status of the incident (Incident closed template only).

Name of the user transitioning the workflow stage.
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Risk Email Templates
The following variables are available for this email template:
VARIABLE DESCRIPTION

The email object gives the designer access to the setSubject method, which takes a string that can include other
email
variables.

projectName The name of the Program associated with this notification.

projectDescription =~ The description of the Program associated with this notification.

riskNames The name of the risk associated with the program for which you are sending the notification.
entityName The name of the entity associated with the risk.
appurl The URL of the RiskVision application.
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Ticket Email Templates

The following variables are available for this email template:

VARIABLE

email

userName

workltemName

ticketlD

ticketName

ticketPriority

ticketDue

ticketStatus

ticketDescription

notificationDescription

ticketAttributeChangeDetails

commentOwnerName

DESCRIPTION

The email object gives the designer access to the setSubject method, which takes a string that

can include other variables.

The recipient of the email, usually a stakeholder in the current workflow.

The name of the workltem, either a ticket, or another kind of item.

The ID of the ticket.

The name of the ticket.

The priority of the ticket (low, medium, high, and so on).

The string of the date that the ticket is due. SeeModifying a Variable Display Date.

The current status (workflow stage) of the ticket.

The description of the ticket.

The description of this ticket notification (Ticket Update Notification templates only).

The old and new values of changed attributes (Ticket Update Notification templates only).

The name of the user transitioning the workflow stage.
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Vendor Email Templates

The following variables are available for these email templates:

VARIABLE DESCRIPTION

The email object gives the designer access to the setSubject

emai method, which takes a string that can include other variables.
vendorName Name of the vendor to whom the account details are sent.
Recipient of the email, usually a stakeholder in the current
userName
workflow.
userld Username of the vendor account.
password Password for the vendor account user.
details Additional details sent for the vendor account.
senderName Name of the user who will send this notification.
appurl RiskVision URL.

In addition to the variables above, you can also use the SNT.getValue(".- workflowTransitionComment") variable to notify stakeholders of the
workflow stage comments.
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More Variables

The following variables are available for email templates to help point stakeholders to the user interface in which the action is required.

VARIABLE

SNT.getObjectUrl("objectName")

SNT.getObjectUrlWithTab("objectName",

"tabName")

SNT.getQuestionnaireUrl()

DESCRIPTION

Use this variable in an email template to direct users to the default tab of an object. For

example, SNT.getObjectUrl("RAProject").

Use this variable in an email template to direct users to a tab available on an object

details page. For example, SNT.getObjectUrIWithTab("Assessment", "Control Results").

Use this variable in an email template to direct users to the Questionnaire window. This
variable must be specified in the email templates defined in the first stage of the

assessment workflow.
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Modify a Variable Display Date

Although variables, such as SticketDue and SexceptionEndDate will display the date in the '"MM/dd/yyyy hh:mm:ss' format in email notifications, you
can also use the SdateTool velocity template variable to display an alternative date format. To change the date format in an email template, use the

following code corresponding to the format and replace the code with the email template variable:

SticketDue variable:

e Dateandtime: S$dateTool.format ('MM/dd/yyyy hh:mm:ss', $ticketDue)

e Date: S$dateTool.format ('MM/dd/yyyy', SticketDue)

SexceptionEndDate variable:
e Dateandtime: S$dateTool.format ('MM/dd/yyyy hh:mm:ss', SexceptionEndDate)

e Date: S$dateTool.format ('MM/dd/yyyy', SexceptionEndDate)

165



Add Object Fields to Email Templates

You can add fields from an object's details page as workflow-type variables in stakeholder notifications. You can even include custom attributes that

you have added to the objects. The following field types can be added to any email template:

FIELD TYPE

String

Number

Boolean

Date

SNT.getValue(".customAttributes.")

SNT.getValue(".customAttributes.")

SNT.getValue(".customAttributes.")

SNT.getValue(".customAttributes.")

VARIABLE
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Add Custom Attributes to Email Templates

Any custom attribute supported by RiskVision can be added as a variable to an email template. The following attribute types can be added:

ATTRIBUTE

Date

Encrypted string

Flag

Image

Number

Rational number

String

Text

VARIABLE

SNT.getValue(".customAttributes.")

SNT.getValue(".customAttributes.")

SNT.getValue(".customAttributes.")

SNT.getValue(".customAttributes.")

SNT.getValue(".customAttributes.")

SNT.getValue(".customAttributes.")

SNT.getValue(".customAttributes.")

SNT.getValue(".customAttributes.")

DESCRIPTION

The date and time in the YYYY-MM-DD
HH:MM:SS format by default.

A string value in encrypted format.

Boolean values.

An image that can be displayed in the

email.

Positive and negative numbers, including

zero.

Positive and negative integers displayed as

fractions.

Multiple characters.

Character strings and HTML formatting.
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About Email Notifications

RiskVision notifies system users by email under a variety of circumstances. The user who receives the email notification is almost always determined
by the entity or other object ownership.

NOTIFICATION EMAIL TEMPLATE RECIPIENTS

Stakeholders are always notified.
Assessment Workflow Assessment Launch, Classification Assessment Launch, ERM

Stakeholders includes ‘Primary
Started Assessment Launch, and Risk Assessment Launch

Owner’ by default.

Assessment Restart

All stakeholders in the initial
An assessment is Assessment Recurrence stage that are tagged with the
automatically restarted notify icon.

based on recurrence rules

Optional Exception requester is the only
Exception Workflow
stakeholder if Notify selected

Started
Do Not Send Email is the default. stakeholder is checked.
Optional
If Notify selected stakeholder is
Ticket Workflow Started
checked.
No pre-defined templates.
User-selected.
Workflow Action
Note: Pull down list for Policy workflow is ‘Content Pack’ choice. All stakeholders of the stage
An action changes a Assessment Review, Assessment Review Rejection, Assessment before the change.
workflow to a new stage. Signoff, Assessment Signoff Rejection, Ticket Review, and Ticket

Review Rejection.

Escalate (optional)

Escalates to the stakeholders in
The escalations for

the current workflow stage. See
different objects can be User-Selected Email Template

the note at the end of this
sent based on the

section.
available different date

types.

Reminder

Reminds all stakeholders in the
The reminders for different
User-Selected Email Template current workflow stage. See the
objects can be sent based
note at the end of this section.
on available different date

types.

Ticket Created Default Ticket Assignment The user assigned to the ticket.
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Exception or Ticket

Delegated

Ticket Exception

Expiration

Date in a ticket’s
‘Exception Expiration’ field

has passed.

Vendor Account Created

Assessment is Accessed

(Optional in all except
terminal stages)
Assessment is accessed
when questionnaire is

opened.

Score Crosses a Threshold

A control, compliance, or
risk score crosses a

specified threshold.

A Scheduled Job

Completes Successfully

A Scheduled Job Fails

A Dashboard or Report is

Sent to the User

Risk Created

New Threats or
Vulnerabilities are

Reported

New threats or

vulnerabilities are reported

from a security research

organization.

User Account Delegation

Notify users of assigned

Exception Delegation and Ticket Delegation

Specified in the

ticket.exception.expired.notification.template

Property

New Vendor Contact Notification

N/A

Alert Notification

Scheduled Job Completed Successfully

Scheduled Job Failed

Report or Dashboard Delivery

Risk Identified

Threats Advisory Alerts

Out of Office Delegation

The new assignee.

All stakeholders of the current

stage.

New vendor user.

Primary owner. If the primary
owner is removed from list of

stakeholders, no email is sent.

Selected in the alert rule.

Specified email user.

Specified email address.

The original requestor.

Owner.

Control/entity owner.

The user who has been

designated as a delegate.
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access delegations.

Content has Been Stakeholders in the current
Questionnaire Changed Notification
Changed workflow stage.
Workflow escalation and reminders can be sent as one email to all (single email to all
stakeholders) or one email to each (email individually to each stakeholder).
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About Filters

A filter contains a set of conditions used by reports to match records and by dynamic groups to limit membership and user access. Filter types include
Assessment, Dynamic Group, Entity, Exception Request, Incident, Program, Response, Risk, and others.

The following options are available on the filter page:

e Filter conditions: Options for creating operands:
o Field: Displays a list of available fields for the type of filter that you selected.

o Comparison Op: Displays a list of logical operators that you can select to build a filter condition.

o Value: The string, number, or other value types that you want to match. To match a user, seeUser Variables.
o Perform a case sensitive comparison Consider the case of strings.

o Use this condition as a parameter to a chart Allows users to drill down to the record level of this field.

e Conjunction: Joins operands in truth tables.
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About Filter Data Types

The properties of a field describe the characteristics and behavior of data added to that field. A field's data type is the most important property
because it determines what kind of data the field can store.

Fields contain the following types of data:

Data types Description

string Field contains characters, symbols, or numbers.
float, integer, short, long Field contains a numeric value.

Field contains a date. Select the day and time using the calendar
timestamp
widget.

boolean Field contains true or false.
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About Comparison Operators

Comparison operators allow you to compare two values. Comparison operators are used in logical statements to determine equality or difference
between variables or values.

To use a comparison operator, you must specify the values that you want to compare together with an operator that separates these values. When
the input is a collection of values, the comparison operators return any matching values. If there are no matches in a collection, comparison operators
do not return anything.

The following table describes the comparison operators:

Operators

Equals

Not equals

Greater than

Greater than or
equal

Less than

Less than or
equal

Between

Contains

Starts with

Ends with

Matches filter

Data type

all

all

float, integer, short, long,
timestamp

float, integer, short, long,
timestamp

float, integer, short, long,
timestamp

float, integer, short, long,
timestamp

string

string

string

string

string

Description

Exactly matches the value.

For Tags and Organizational Nodes, use Contains, not ==.

Any that do not exactly match.

Definition is higher than the number that you entered.

Definition is similar or higher than the number that you entered.

Definition is lower than the number that you entered.

Definition is similar or lower than the number that you entered.

Value is between two values. (Selecting this Comparison op displays a second value field).

Definition contains the exact phrase that you entered. For example: 'al' matches alright and
minimal but not.

Definition begins with the exact phrase that you entered. For example: 'al' matches alright,
but not minimal and.

Definition ends with the exact phrase that you entered. For example: 'al' matches minimal,
but not alright.

Allows one filter condition to reference another filter.
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About Conjunctions

Join operands to create a truth table as follows. A single filter can mix AND and OR conjunctions, but the results may not match the author's intent,
due to precedence rules. The expression X AND Y OR Z can be interpreted as true only when X and either Y or Z are true, or it can be interpreted as

true when either Z or both X and Y are true. Avoid mixing both conjunctions in the same filter. Instead, create two filters and use the 'Matches filter'
operator to combine them.

Conjunction Description

Returns true if all conditions are true, and false if any condition is
AND

false.

Returns true if any condition is true, and false if all conditions are
OR

false.

For users other than the RiskVision administrator, filters can be viewed on the Configuration > Filters menu with the Filter View permission.
Creating, modifying, or deleting a filter requires you to have the Filter View and Filter Update permissions.
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Add a Filter

This article explains how to add a filter without conditions. Typically, a filter without any conditions matches all records.

To create a new filter:
1. In the RiskVision application, go to Configuration > Filters. In the Administration application, go to Users > Filters.
2. Expand the Filter groups to select a specific group to which you want to add the filter.
3. Click New. The New Filter dialog appears.
4. Enter the general information:
1. Enter Name and Description.
2. Select the filter type and then click OK.

The filter is available for assignment.
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Modify Filter Conditions

This article explains how to add or remove a condition. Changes are applied the next time a report is run or a dashboard is updated. The new settings
are used and user access filters are applied the next time the user logs in.

To add a condition:

1. Go to Configuration > Filters.
2. Expand the Filters tree.

3. Select a filter to open.

4. Click the Conditions tab.

5. Click Edit, then click Add.

6. Enter the Filter conditions as follows:

¥ Filter: Test 1

Filter Conditions:

Filter Information Entities (Any type) Field ()

Comparison Op e Value o

@ save @cancel 5

Action

Conditions | Entity.Name

Applications

@ And o) or @)

2 [Equals v [mobid

|| Use this condition as a parameter to a chart e

The Filter Conditions section.

1. Attribute: Select the field where you want to filter the records.

2. Operator: Select the type of operation you want to use to compare the attribute definition and value.

3. Value: Enter a string or number, or select from the dropdown list.

4. Conjunctions: Joins conditions to build an expression that is matched when returned true. Select the same type for all conditions in a
filter. Matches filter to combine AND and OR expressions.

5. Use this condition as a parameter to a chart Allow all users to create reports that can drill down to the record level of this field.

7. Click Save.

The Matches Filter operator will not produce correct results if the filter it references is not found. If you must use the Matches Filter operator in the
condition of a filter, create the filter to be set in the Matches Filter value first.

To remove a condition:

1. Go to Configuration> Filters. In the Administration application, go to Users > Filters

2. Expand the Filters tree.
3. Select a filter to open.

4. Click the Conditions tab.

5. Click Edit, then click the Delete X icon next to the condition.

6. Click Save.
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Remove a Filter

You can only remove unassigned filters. If you try to remove a filter that is in use, an error will appear providing the location where it's in use.

To delete a filter:

1. Go to Configuration > Filters.
2. Expand the Filters tree and select a filter.

3. Click Delete.
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Group Filters

To make it easier to get an overview of the filters in the filters panel, you can create filter groups within a data table and place certain filters in these.
You can only group filters that belong to the same data table. You can then expand or collapse various groups to only work with the filters you want
for the moment.

The navigation pane contains the following predefined groups:

GROUP NAME DESCRIPTION
Filters Root folder contains RiskVision Content and Organization Content; displays a recursive list of all filters.
My Filters Contains filters visible to the current user only.

Shared Filters/System Contains default system filters.

Shared Filters/Public Contains filters configured by your organization.
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Create a New Group

Groups display as folders on the navigation pane and allow you to assign multiple controls, checks, questionnaires, and policy documents to an entity
for evaluation in an assessment. To create a new group, your user role must have Control View and Control Author permissions.

If multiple groups have the same control, the questionnaire window will display all of the associated questions according to the way the control is
grouped.

To create a new group:
1. Open the Content menu.

2. Click Controls and Questionnaires or Policies. (On the Risks menu, click Controls and Questionnaires. On the Content menu, click
Questionnaires.

3. Expand Organization Content and select the group or policy pack where you want to create the new group.
4. Select New Group in the More Actions...pull-down list.

The New Group page displays.

New Group @ szve @ carce  #0Back

\ . Group

| Title* IFire protection subsystems

Description . R -~

Fire Protection Subsystems =

| Thiz group will include controls specifying paricwlar subsystems that can be used for fire -
supression, evacustion supnart, and fire depatment interface, b

Preferred g siness Crvuner o

Author mphelps
Group
Details

Click to enter texd

Identifier |g1938-Fp

5. Enter the following Group information:

o Title. Enter the group name.

o Description. Summarize the content contained by this group.

o Preferred Ownership. Click + to display a list of entity ownership types, select the ownership type, and click OK.
o Group Details. Describe the group with as many details as desired.

o Identifier. Provide an optional identifier for the group.

6. Click Save.
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Delete a Group

Deleting a group removes all filters in the group. You can only remove groups that contain unassigned filters.

To remove a group:
1. Go to Configuration > Filters. Or, in the Administration application, go to Users > Filters.
2. Select the group you want to delete.
The group displays in the Filter list.
3. Click Delete.

The group and any subgroups and filters are removed.
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Complex Filters

A filter can be as simple as Setting Equals 1, but more complex filters can be used in reports or for access control.

The built-in filter editor can be used to add conditions one at a time to a filter. These filter conditions are added using theAND or OR logical
operators. By default, the AND operator has higher precedence than the OR operator. The filter editor does not allow the user to override the
precedence (typically done by adding parenthesis).

Example

You have the following filter set up:

V Filter: Test 1 [ Edit 5,

Filter Conditions:

Filter Information

Conditions Column Operator Value Options
Applicntions Mame Equals agl

AND Enfity type Equals Computer

OR Entity type Equals Application

AND Organization name Equals Acme

The Conditions tab of a filter.

The filter in this example translates to:

Entity Name starts with agl AND Entity Type = Computer OR Entity Type = Application AND Organization name =
Acme

Since the AND operator has higher precedence than the OR operator, the above filter means:

(Entity Name starts with agl AND Entity Type = Computer) OR (Entity Type = Application AND Organization name
= Acme)

That is, the AND operations are performed first.

If you want this filter to evaluate as:

(Entity Name starts with agl) AND (Entity Type = Computer OR Entity Type = Application) AND (Organization
name = Acme)

There is no way to do this directly by using the filter editor. You must do this using the Matches Filter operator. To implement the above filter, you

must build a Computer or Application Entities filter for the condition (Entity Type = Computer OR Entity Type = Application).

-’" Filter: Computer or Application Entities Q’ Edit 5 4[] Back

Filter Conditions:

Filter Information

Conditions Column Operator Value Options

Applicntions Enfity type Equals Computer
OR Enfity type Equals Application

A Computer or Application Entities filter.

The original filter will use the Computer or Application Entities filter using theMatches Filter operator.

First, add the Name Equals agl condition. Use the Matches Filter operator to add the Computer or Application Entities filter. Note that a dummy entry
must be selected in the first dropdown of the filter editor. In this case, Created By is selected, which is ignored by the server.
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V Filter: Test 1 @ save @ Cancsl %5 ¢ Back
Filter Conditions:

Filter Information Entities (Any type) Field Comparison Op Value

Conditions | General.Created by v | Matches Filter v
Applications

|C p or Applicafion Enfities v

@ And ) Or Use this condition as a parameter to a chart
Column Operator Value Options
Mame Equals agl i ;

Adding the Matches Filter operator.

Add Organization name Equals Acme. The filter will now look like this:

V Filter: Test 1 [ Edit %5 4] Back
Filter Conditions:
Filter Information

Conditions Column Operator Value Options
Applicntions Mame Equals agl

AND - Matches Filter Compuier or Application Entities

AND Organization name Equals Acme

The filter with the Matches Filter operator added.

Internally, the server surrounds the filter condition of the Matches Filter operator with parenthesis. So, this will translate to:

(Entity Name starts with agl)AND (Computer or Application Entities) AND (Organization name = Acme)
Which is effectively similar to the filter that you set out to construct:

(Entity Name starts with agl) AND (Entity Type = Computer OR Entity Type = Application) AND (Organization
name = Acme)

This can be taken further by using Matches Filter operator within the filters used by another Matches Filter operator.

183



User Variables

Users can refer to the following variables when creating filters or custom SQL queries for reports.

USER VARIABLE DESCRIPTION
%USER_ID% Login user ID of the current user.
%SYSTEM_USER_ID% Internal ID of the current user.
%USER_FIRSTNAME% First name of the current user.
%USER_LASTNAME% Last name of the current user.

Concatenation of the first name, a single space, and last name of the
%USER_NAME%
current user.
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Questionnaire Presentation Options Overview

A questionnaire presentation option is a set of options associated with a program. When assessments within a program are launched, the only option
visible to stakeholders is to enable the Questionnaire Presentation Option. Using the Questionnaire Presentation Option, users can set options

such as Allow user to skip questionnaires, Allow user to skip resolved questionnaires, or Allow forwarding of questions to make it easy for
stakeholders' to answer questionnaires. Before creating a questionnaire presentation option, the user must understand the entire assessment
strategy and objective, because all assessments created within a program are carried out using the same questionnaire presentation option. Any
changes to preferences will affect assessments and questionnaires that are in progress.

The Questionnaire Presentation Option is available on the Configuration menu if the user has the Questionnaire Preferences View permission. To
modify the default questionnaire presentation option or create a new questionnaire presentation option, the user must have the Questionnaire
Preferences View and Manage permission.

Users can only delete unassigned presentation option sets.
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Set up Questionnaire Presentation Options

The following articles are settings in the Questionnaire Presentation Option. Each section contains a table describing the fields and their purposes.
Change the settings using a radio button, check box, dropdown list, or by entering the test.

e Questionnaire Responder
e Questions

e Control Testing

® Supporting Information

e Actions

e Evidence

e Questionnaire Reviewer
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Questionnaire Responder

Field

Display the main logo in the
questionnaire header

Display the co-branding logo in the
questionnaire

header

Display the image of the subject in the
questionnaire

header

FAQ URL for the questionnaire
responders

Show more information link

Show policy documents

Distribute attachments

Maximum number of table rows shown in

summary
Maximum number of table columns
shown in summary

Show auto-advance checkbox

Show progress and summary checkbox

Load single question directly

Automatically lock questionnaires on
launch

Allow user to skip answered questions

Allow user to skip resolved questions

Description

Click Yes to display the main logo in the
questionnaire header

Click Yes to display the co-branding logo in the
questionnaires header.

Click Yes to display the image in the subject
questionnaires header.

Enter a web address where Frequently Asked
Questions are posted.

Displays a “more information” link where
appropriate.

Displays a link that allows the user taking the
questionnaire to download the policy document
attached to the control.

Attach all questionnaires in Excel format in the
launch e-mail.

The default is 5 rows.

The default is 5 columns.

Allow questionnaire takers to automatically advance
when all questions on the page have been answered.
Radio button choices only.

Note: Questionnaires will not auto-advance,
regardless of the auto-advance setting, when
evidence has been added to a question, so that the
questionnaire taker can preview the evidence in
context.

Displays the questionnaire taker's progress and
summary.

Automatically displays questions for control with only
one manual subcontrol.

Note: Controls with multiple subcontrols display a
table with a list of questions where the user must
select to answer.

Locks questionnaire automatically, forcing the
questionnaire takers to unlock it in order to answer
questions. When the questionnaire taker's session
ends, the questionnaire is automatically re-locked.
This prevents multiple users from answering
questions at the same time. When disabled,
questionnaires must be manually locked to prevent
answers from being overridden by other users.
Provides a check box that skips answered questions
when the user clicks Next in the questionnaire.
Provides a check box that skips resolved questions
when the user clicks Next in the questionnaire.
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Questions

Field Description

A rich text editor allows questionnaire takers to highlight words
Use a rich text editor for text questions and phrases with styles, such as bold and italic, and to control

text formatting.

Allow scoring of text questions (in Review Stages) Set to Yes to enable scoring answers to text-based questions.
Choice Template The name of the program-level choice template.

Always use the Choice Template from the Program Set to No to allow overriding the program-level choice template.
Display cell choices horizontally For table questions, set to No to display cell choices vertically.
Show multiple time series entry fields Automatically provides multiple fields.

Group questions using each Choose control objective or control.
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Control Testing

Field Description
Show Design Test Show the associated design test in the Ul
Show Effectiveness Tests Show the associated effectiveness tests in the Ul.
Show Documents Show attached documents.
Show Evidence Show attached evidence.
Show Applicable Entities Show entities that are applicable to the questionnaire.
Show Change History Show the change history.
Design Test Select a choice template to use with the design test.
Effectiveness Test Select a choice template to use with the effectiveness tests.

Effectiveness Tests cannot be rated until Design Test has
Select Yes or No.
passed.

Overall control cannot be rated until all Effectiveness Tests have
Select Yes or No.
been rated.
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Supporting Information

Field Description

Displays a text field where the user can enter more information.

When the questionnaire is exported to a spreadsheet, the user
Show comments enters text in the My New Comments field. This text is merged

with the Comments field when the spreadsheet is subsequently

imported.
Comments section label The title of the Comments section.

Set to Yes to require that questionnaire takers provide comments
Require comments when answering radio or checkbox-type questions, or text

questions when Allow text question scoring is Yes.

Allow deletion of comments Allow questionnaire takers to delete comments.

Show implementation Displays the implementation information to the users.
Implementation section label The Enter the title of the implementation section.

Show remediation Displays a text field where the user can enter more information.
Remediation section label The title of the remediation section.
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Actions

Field Description

Displays the Followup button that allows users to flag the

Allow flagging questions for followup
question.

Displays the Request Exception button so users can create a

Allow exception requests
new exception request while taking a questionnaire.

Displays the Delegate button so users can delegate a question to

Allow forwarding of questions
other users while taking a questionnaire.

Provides the option to delegate each group of questions to a

Allow splitting and merging of Questionnaires
different user, or merge split questionnaires back into one.

Allows questionnaires to be advanced by the primary owner,

Allow primary owners to advance questionnaires
even if all questions have not been answered or resolved.
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Evidence

Field
Document upload required for evidence
Required evidence label

Show evidence links for all choices

Show evidence link when the user clicks on a choice
Hide evidence links for these choices
Optional evidence label

Provide evidence descriptions automatically
Allow data feeds to be used as evidence

Evidence must come from the same program

Evidence must be owned by questionnaire
responder
Allow adding evidence to the Evidence Repository

Allow selecting evidence from document repository

Allow selecting evidence from the Evidence
Repository

Allow selecting evidence from the Document
Repository

Description

Forces the user to upload a document as evidence.

The label that displays next to the link for uploading evidence
when required by the questionnaire choice settings.

Provides a mechanism for optional evidence for choices. Note:
Allows evidence to be uploaded for choices that do not
require evidence.

Select Yes or No.

Specify the choices that must not have evidence links.

The label that displays as the link text for "Show evidence
links for all choices."

Inserts the question title into the description field.
Questionnaire takers can display and attach data feeds
associated with the Entity that is the target of the assessment
Only allow evidence that is associated with the current
program.

Only allow evidence that is owned by the questionnaire
responder.

Allows you to hide or display the option to select evidence
from evidence repository.

Allows you to hide or display the option to select evidence
from document repository.

Allows you to hide or display the selecting an evidence from
evidence repository.

Allows you to hide or display the selecting an evidence from
document repository.
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Questionnaire Reviewer

Field Description

Displays conflicting answers if questionnaire taker's answers
Show the discrepancy report
differ.

Displays an icon to indicate that a mitigation has been requested
Show mitigation requests
for a subcontrol.

Show if a question changed Select Yes or No.

Displays the resolutions associated with the questionnaire if it
Review resolutions.
the stage is marked as a Review stage.

Displays the normalized risk score (10-compliance score) of the
Show risk score in header questionnaire taker's answer to a question.

Note: Risk scores apply to compliance assessments only.

Enables the Risk Report button that allows questionnaire
Show risk report responders to display a list of risks while taking the

questionnaire.
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About Ticket Management Preferences

The Ticket Management Preferences page manages the list of ticket dispositions. A ticket disposition is a text string such as "Pending customer
confirmation" or "Under investigation." You can use a ticket disposition to label a ticket's status. You can access the Ticket Management Preferences
page only if you have the Ticket Manage permission.

When a ticket reaches its due date, it is automatically escalated to additional stakeholders who are notified that the ticket is overdue.

Ticket Management Preferences allow the user to disable escalations for tickets with a specified disposition. For example, the user may not want to
escalate overdue tickets if the disposition is "Pending customer confirmation."

To add a ticket disposition:

1.

2.

Go to Configuration > Ticket Management Preferences.

Click Edit.

. Click Add, then enter a new disposition in the Ticket Dispositions text box.
. Click OK.
. Click Refresh to update the Do not escalate when disposition is set to dropdown list.

. Click Save.

To change a ticket disposition:

1.

2.

Go to Configuration > Ticket Management Preferences.

Click Edit.

. Click the disposition name to change, update the name, and then click OK.
. Click Refresh to update the Do not escalate when disposition is set to dropdown list.

. Click Save.

To delete a ticket disposition:

1

2.

Go to Configuration > Ticket Management Preferences.

Click Edit.

. Select the disposition, click Delete, and then confirm the action.
. Click Refresh to update the Do not escalate when disposition is set todropdown list.

. Click Save.

To disable escalation for a specific disposition:

1.

2.

Go to Configuration > Ticket Management Preferences.

Click Edit.

. Select a disposition from the Do not escalate when disposition is set todropdown list.

. Click Save.
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About Entities

For customers using RiskVision to build and deploy a risk and compliance management solution, there are two main components to be concerned
with:

1. Determining the controls and subcontrols that you want to enforce or monitor across your organization, for example to measure security risk
across the various computers and other IT assets/entities across your organization. Using Enterprise Risk Management (ERM) or Key Risk
Indicator (KRI) methods of risk analysis, you may approach building a risk and compliance management solution from another point of view,
by determining the risks you want to evaluate and keeping a close eye across your organization, business units, and business and
organization-wide processes and objectives.

Using RiskVision, you can choose from standards-based risks and controls already provided in the Resolver content library. You can then add
and combine controls to create a customized "Organization Content" collection of controls that are used in creating programs, performing
entity assessments and risk evaluation across your organization.

2. The collection of your organization's combined entities or resources. Accessing groups of entities from RiskVision, you can apply or evaluate
controls for selected entities included in an assessment, measure or monitor their compliance, and calculate associated risk. RiskVision allows
you to capture information and inventory nearly any item of value within your organization (referred to as entities), from IT resources such as
computers, systems, and applications, to non-IT resources such as property, business equipment, business operations, people, vendors, and
processes. In addition, using methods such as ERM, you can model the processes, sub processes, and business objectives that you want to
evaluate for risk.
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Entity Types

The following list describes the predefined
entity types:

Icon Entity Description

Account or login information pertaining to privileged access of financial accounts, computer applications,

Account
i etc.

Software applications that are critical to a company's operation, for example, financial reporting, CRM,
= 5%  Application

=@ procurement, change management, incident management, and database applications.
=

Computers, servers of different types (file, database, authentication), notebooks, laptops, etc. Predefined

- Computer
g\J subtypes such as Desktop and Notebook.

Specific data that may be critical to operations and are important enough to be classified and tracked on

Data their own, for example, account numbers, customer lists, documents containing product formulas, market-
'i;
sensitive information, intellectual property, etc.
e Device Other network devices such as routers, switches, printers, VPN, etc.
-
Domain An Active Directory domain.
s Financial Entities related to financial resources such as stocks, bonds, cash, etc.
7o~ Group An Active Directory security group.
|/
= Intangible Entities such as intellectual property, product secrets and proprietary information, etc.
=
Location Physical or geographical locations, real estate, offices, etc.

Mobile devices are entities, such as mobile phone, personal digital assistant (PDA), and much more that
are allowed by organizations under the Bring your own device (BYOD) policy. Employees bring their
Mobile Device
g mobile devices to access email, file servers, and critical applications. Track and assess all employee-owned

devices by creating or importing a Mobile Device entity type.

Elﬂ_" Network Computer network infrastructure like subnets and wireless networks.
-
Network
. Network devices such as firewall, routers, modems, etc.
%=~ Device

Organizational
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Person

Physical

Process

Project

Vendor

DREAPKsHDIrectory organizational unit.

Individuals within an organization where compliance and risk are managed by the RiskVision system. Also

linked as users of applications, processes, documents, and storage.

Non-computer entities such as mechanical, manufacturing, and production equipment, vehicles and capital

goods.

Business operations such as order entry, payment transaction, accounts payable and receivable, shipping

and receiving, RMA, etc.

Shows individual entity assessments defined as part of a larger program.

Organizations or entities outside your own enterprise for which you want to apply and monitor control

compliance and calculate risk.
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Create a New Entity

To create a new entity, you must have the Entity View and Entity Create permissions. The entity wizard takes you through the configuration of basic
entity settings. For computer type entities, see Creating a New Computer Type Entity.
To create a new entity:

1. Go to Entities > Entities and select an entity group.

2. Click New. The Add Entities to your Organization page is displayed.

Add Entities to your Organization

While adding Entities to your organization, you can manually create/import from a file.
If you would like to export entities, select the folder and choose Export Entities of the Entities Grid.
Please select how you would like to add new Enfities:

(O] Use the Entity creation wizard to create an Entity

Enter the following informafion for the entity you wish fo create
The wizard will guide you to create an enfity.

Name” |DesktoplD1012
Entity type* | Computer b |a
Entity subtype [ Select a subtype v]
Description

Primary Owner* |
pramt 00 v
y Import Entities from a file

The Add Entities to your Organization page.

3. Setthe name, type, and owner and then click Next. The Create a Computer wizard appears, showing the Organization wizard page.
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Create a Computer

Step 1: Select the organizational unit of the entity. Skip this option if the
group is undefined.

* = required

2. Computer

If there is an organizational unit associated with the entity, select it

3. Address
4. Classification Available Hierarchies Selected Hierarchies
5. Ownership 1-30f 3 (] Datacenter

Filter by| - Show all - ¥ |[ Refresh ] o DME Group

| Name Path e
|# Datacenter [Datacenter

[+ DMNB Group JDMB Group

[ HO Ha

[ Cancel | [ = Back ] m

The Organization wizard page.

4. Select the organizational group to automatically set the organization fields. Skip this step if the organization has not been configured.
For more information on organizational groups, see Defining a New Organization.

5. Click Next. Click Next again. The Address wizard page appears.
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Create a Computer b 4

1. Organization Step 3: Optionally, enter the geographic location of the entity. * = required

2. Computer Skip this step, select an existing location, or choose 'Define a lecation' to create a new location. Use the other

fields to edit the location. Define / Select a location and enter the details for mandatory fields such as Address 1,
\ddres City, State / Province, Zip Code / Postal Code.

r— Primary Address

4. Classification i
Location

| Headquarters: v

Address 1

[123 Main Street |
Address 2

| |
City

|Wa5hingtun |
State / Province

Ioc |
Zip Code / Postal Code

20401 |
Country

us |
Region

5. Ownership

Euilding

Floor

[ Cancel | ( < Back ] m

The Address wizard page.

6. Enter the address and click Next. The Classification page is displayed.
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Create a Computer b 4

W Security Requirements

Confidentiality (g) Unknown ) Low ) Medium High
5. Ownership Integrity (&) Unknown ) Low ) Medium © High
Availability &) Unknown ) Low ) Medium ) High

Accountability @) Unknown Q Low (@] Medium (] High

¥ Classification

Classification Label | - Select - v |

Internal or external | - Select - v |

Cancel

1. Organization Step 4: Select the criticality ratings and classification labels.
2. Computer Enter the new entity's security requirements, criticality ratings, and classification labels.
3. Address

* = required

The Classification wizard page.

7. Select the criticality setting. The Ownership page is displayed.
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Create a Computer b 4

1. Organization Step 5: Add owners involved with processes related to the entity. * = required
2. Computer Add owners involved with the processes related to the enfity. A primary owner is required.
3. Address

Owners

4. Classification
Primary Owner*

[ 1)

Additional Owners:

[ Add Cwners ] [ Delete ] | More Acfions_.. ¥ |

Filter by| - Show all- v |[ Refresn |

| Name « Type Ownership Type

o No additional owners defined.

[ Cancel | [ < Back ] m

The Ownership wizard page.

8. Change the primary owner and assign other users as owners. See Configuring Owners. While it is possible to import an entity without a
primary owner, or to delete an entity's primary owner, many operations require that each entity has a primary owner. Creating a program that
references an entity without a primary owner, for example, will cause an error.

9. Click Finish.

The entity is added to the system. If the entity is part of a dynamic group, an assessment automatically launches the entity depending on the program
settings.
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Create a New Computer Type Entity

The entity wizard takes you through the configuration of basic entity settings.

To create a new entity:

1. Go to Entities> Entities and select an entity group. The Entities page is displayed.
2. Click New.

Add Entities to your Organization

While adding Entities to your organization, you can manually create/import from a file.
If yeu would like to export enfities, select the folder and choose Export Entities of the Entities Grid.
Please select how youw would like to add new Enfities:

» Use the Entity creation wizard to create an Entity

Enter the following information for the entity you wish fo create.
The wizard will guide you to create an entity.

Name” |DesktoplD1012
Entity Pe" | Computer b
Entity subtype | Select a subtype v
Description
2
Primary Owner*

. '

Import Entities from a file

The Add Entities to your Organization page.

3. Select the Entity type. Enter the name, select the owner, and then click Next.
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Create a Computer

Step 1: Select the organizational unit of the entity. Skip this option if the
group is undefined.

* = required

2. Computer

If there is an organizational unit associated with the entity, select it

3. Address
4. Classification Available Hierarchies Selected Hierarchies
5. Ownership 1-30f 3 (] Datacenter

Filter by| - Show all - ¥ |[ Refresh ] o DME Group

| Name Path e
|# Datacenter [Datacenter

[+ DMNB Group JDMB Group

[ HO Ha

[ Cancel | [ = Back ] m

The Organization wizard page.

4. Select the Organizational group to automatically set the organization fields. Skip this step if the organization has not been configured. For
more information on organizational groups see Defining a New Organization.

5. Click Next. The Computer wizard page appears.
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Create a Computer b 4

1. Organization Step 2: Define the network identification and physical properties of the * = required
computer or device.
| 2-Computer |
Enter the network identification and other information, if desired.
3. Address
Identification
4. Classification Name DeskioplD1012

Host name” |DeskioplD1012 |
Domain name | |

5. Ownership

Computer Details
Manufacturer |

Version |

Serial number |

Product name |

Chassis Type |Iapip

Processor name | |

[ Cancel | ( < Back ] m

The Computer wizard page.

6. Enter the Identification and Computer Details, then click Next.
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Create a Computer b 4

1. Organization Step 3: Optionally, enter the geographic location of the entity. * = required

2. Computer Skip this step, select an existing location, or choose 'Define a lecation' to create a new location. Use the other

fields to edit the location. Define / Select a location and enter the details for mandatory fields such as Address 1,
\ddres City, State / Province, Zip Code / Postal Code.

r— Primary Address

4. Classification i
Location

| Headquarters: v

Address 1

[123 Main Street |
Address 2

| |
City

|Wa5hingtun |
State / Province

Ioc |
Zip Code / Postal Code

20401 |
Country

us |
Region

5. Ownership

Euilding

Floor

[ Cancel | ( < Back ] m

The Address wizard page.

7. Enter the address, then click Next.
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Create a Computer b 4

W Security Requirements

Confidentiality (g) Unknown ) Low ) Medium High
5. Ownership Integrity (&) Unknown ) Low ) Medium © High
Availability &) Unknown ) Low ) Medium ) High

Accountability @) Unknown Q Low (@] Medium (] High

¥ Classification

Classification Label | - Select - v |

Internal or external | - Select - v |

Cancel

1. Organization Step 4: Select the criticality ratings and classification labels.
2. Computer Enter the new entity's security requirements, criticality ratings, and classification labels.
3. Address

* = required

The Classification wizard page.

8. Select the criticality setting. The Ownership wizard page appears.
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Create a Computer b 4

1. Organization Step 5: Add owners involved with processes related to the entity. * = required
2. Computer Add owners involved with the processes related to the enfity. A primary owner is required.
3. Address
Owners
4. Classification
Pri Owner*
. ~— rimary el |" p— = |
Additional Owners:
Add Ow Delete | | More Actions... ¥ | - '
[L2¢0 Ouners ] [ Dstete J [More actions.. v | Filter by| - Show all- v |[ Refresn |

| Name « Type Ownership Type

'o No additional owners defined.

Cancel

The Ownership wizard page.

9. Change the primary owner and assign other users as owners. See Configuring owners for more information.

10. Click Finish.

The computer type entity is added to your system. If the entity is in a dynamic group that is included in a program, an assessment may automatically

launch for the entity, depending on the program settings.
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Set the Name, Type, and Owner for an Entity

Set the following information on the Entity Wizard Name and Owners page:

Add Entities to your Organization

While adding Entities to your organization, you can manually create/import from a file.
If yeu would like to export enfities, select the folder and choose Export Entities of the Entities Grid.

Please select how youw would like to add new Enfities:
(@) Use the Entity creation wizard to create an Entity

Enter the following information for the entity you wish fo create.
The wizard will guide you to create an entity.

Name” |DesktoplD1012

Entity HPe" [ ¢ omputer v |ﬂ
Entity subtype | Select a subtype v
Description
2

Primary Owner* |:—- — ¥

y Import Entities from a file

The Entity Wizard Name and Owners page.

Setting Type Description

Enter a name that Identifies the entity in programs, assessments, questionnaires, tickets, exceptions,

Name string
incidents, and reports.
Default
Displays a list of predefined entity types.
entity types
Entity type
Define new Displays a text box where you can enter up to 255 characters. The new type is added to the list of
type entity types when you save the entity.
Entity Define new (Optional) Displays a text box where you can enter up to 255 characters. The new subtype is added to
subtype type the selected type and displays as an option the next time you select the type.
Description  string Enter up to 1024 characters that summarize the entity. Displays in the entity in list and detail pane.
Primary

System user =~ Select a user.
owner
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About Discovered Entities

The Discovered, Managed and Unmanaged dynamic groups provide dynamic subgroups that categorize entities by attributes such as entity type,

application, or computer. Entities first appear in the Discovered dynamic group when they are discovered using a connector or created from imported
entities.

To move Discovered and Unmanaged entities to the Managed group:

Perform one of the following actions:

1. Open the General detail display, then click Status > Manage.

2. Click the Manage node or any Manage node subgroup, then click Start Managing These Entities.

3. Click More Actions > Manage Entities.

Entities require a minimum of a hostname or IP and a domain to be included in Discovered or Managed entities.
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Display Entity Details

There are a few ways to open the entity details pane from other menus, such as opening theAssessment Details page. This section explains how to
open the details pane from the Entities menu. To view and search an entity, you must have the Entity View permission. In general, entities are visible
only to their primary owners. However, if a primary owner nominates another user as a business owner for an entity, then the business owner will be
able to view that entity. Find an entity by entering part or all of the name in the search field, then click Search.

Y Enfity name ] Search

The search field.

To display the entity details pane:

1. Go to Entities > Entities.

2. Click a group, such as My Entities, to display the Entity list.

Home Q@3 1/-CM Assessments | Content | Analytics | Configuration Show Graph | [Enfity name Search

Entities Enfity Collections Group Definiions Entity Managemeni

# Entities # Entities

My Entities Actions w

1-6of @

Entities
+ [, Eniities with IP Addresses [ Details ] [ Delete ] |More Actions... v |

+/ |, Active Directory

[ =how IP Address Filter by| - Show all - v | [ (Refresh |
+! |8, By Criticality
+ [|4, By Operating System (] Mame a Type Subtype Criticality Owner Description
+ 1, By Type =IFRAME SRC=# =IFRAME SRC=#
& = (] onmouseover="aler{document cookie)™> Computer MiA onmouseover="alert{document.cookie "=
8. My Entities =IFRAME= =IFRAME=
+ & Organization Hierarchy
F &MY Favoriles (] gﬂ E1234 Computer MiA MiA

+/ ., Recently Viewed

(] gﬂ MewEntityForRiskScore001 Computer MIA || MewEnfityForRiskScoredd1

The My Entities list of entities.

3. Select an entity, then click Details to open the Entities Details pane.
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QJ Computer: <IFRAME SRC=2 onmouseover="alert{document.cookie)"><IFRAME> [_:'r Edit iy Favorites

Information
2 General
Owners Information Maintenance
De _ Name <IFRAME SRC=# ) Installation date N/A
scription z?IFRAME:w: aleri(d t.cookie)> Last maintenance date N/A
Addresses Description <IFRAME SRC=# Maintenance reference N
. ) on er="aleri(d " kiel= Warranty expiration date MN/A
Classification <IFRAME= Warranty reference N/A
Costs & Impact Entity type Computer
Entity M/
Relationships subtype
. Manufacturer N/A
Propagation Serial N/A
D number
CE—® Product N/A
Assessments name

Entity Management
Tracked since 2020-04-27
System Details Status Managed
Data source(g) Manual eniry
Created by srinu s
Exceptions Created on 2020-04-27
Discovery source N/A

Vulnerabilities

Data Feeds

W Organization Hierarchy

2ad | [ Dekete | | More Actions... ¥ | Fitr by Show - =

(] Organization Root 4 Path Description

0 Mo assigned Hierarchies found.

The Entities Details pane.
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Entity Details Tabs

Entity details are categorized into a set of tabs. The available tabs will depend on the entity type. You can edit these tabs if you have the Entity View
and Entity Update permissions. To edit entities created by other users for which you have not been named an additional owner, you must have Entity
View and Entity Update all permissions. You can update the Classification tab if you have Entity View and Entity Manage permissions.

These are the available entity details tabs:

Tab
General

Owners
Description

Addresses

Classification

Cost & Impact

Relationships

Propagation

Documents

Assessments
Automation

Vulnerabilities

Vulnerabilities List

Inferred

Comp Controls

Attributes

All entity types have a General tab. Attributes include name, type and subtype, and other
identifying fields. Status can be Managed or Discovered. The entity's Organization Hierarchy
is described here.

Entities have a primary owner and a grid of additional owners. Click Add Owners to
associate more users with this entity.

The Description provides additional type-specific fields, such as Publisher and Version, for
applications. The profile information is listed on this tab, if a matching profile is found.

A grid of physical addresses, if any, associated with this entity. Click New to define a new
physical address. Use the following property to delete an entity's address:
com.agiliance.asset.deleteAddress=true.

Entities can be classified in many different ways, such as Business Criticality, CIAA
(Confidentiality, Integrity, Availability, and Accountability), or tags. There is a Change
History associated with entity classification.

This tab associates specific costs and importance metrics with a particular entity. Costs
include attributes such as "business value per hour ($)," and "average remediation time
(days)." Important attributes include "number of users."

A grid listing the other entities with which this entity has a relationship. Click Add
relationship to specify how an entity must relate to another entity. Also, see Relationship
Explorer.

For a Person-type entity, a relationship is listed in the Teams tab.

This tab displays the programs in which the entity is inheriting and propagating the
controls. Because the entity is related to another entity, the control results are propagated
after answering the assessments.

The Documents tab is a grid listing documents, web links and network path associated with
this entity. Click New Document to upload a document related to the entity, such as a
contract for a Vendor type entity, or click New Web Link / Network Path to record an
external link.

Note: By default, users with the Entity view+create+update permission and without any
Document Repository-related permissions can attach or delete documents on Entities, but
when users are using the new Global Document Repository feature to attach a document
from the Document Repository to an entity, then Document Repository-related permissions
and ownerships are required.

A grid of the assessments associated with this entity. Click New to create a new
assessment.

Entity types, such as Computer or Application, have an automation tab that displays target
type parameters based on the entity type, subtype, and product name.

For some entity types, the Vulnerabilities tab provides a summary of vulnerabilities found by
scanners or users. Computer and Vendor types, for example, list vulnerabilities on different
tabs.

The Vulnerabilities List tab is a grid of all vulnerabilities found by scanners or entered
manually by users. To create a new vulnerability and associate it with the entity, click either
New or Import. To assign an existing vulnerability to this entity, click Assign. For more
information, see Assigning Vulnerabilities.

Some entity types, such as Vendors, do not have associated vulnerabilities.

The Inferred tab lists the vulnerabilities that are associated indirectly with an entity type,
such as Computer and Network Device.

The Comp Controls tab lists each of the vulnerability compensation controls attached to the
entity. Users can add new compensating controls, delete them, add notes, and view the
recent changes made.

Note: Only users with the Entity View, Threats and Vulnerabilities View, and Vulnerability
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Threats
System Details

Data Feeds
Exceptions

Compensating Control Update permissions can view, add, update, and remove vulnerability
compensating controls from the entity or add comments. All updates and changes to a
vulnerability compensating control will be logged in the Change History section.
A table displaying all, if any, of the threats the entity has been attached to.
Certain types and subtypes of entity, such as Computers, have a number of tabs organized
under the heading 'System Details.' These tabs include:

e Network

e Ports

e Services

e Applications

e Patches

o Network Shares

e User Accounts

o Membership
A grid listing the data feeds associated with the entity, if any.

The Exception tab is a grid of all exceptions, including the controls, findings, and
vulnerabilities related to the entity that the tab is associated with.
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About Ownership Types

Ownership types link workflow stage stakeholders to the system users who are assigned to an entity or policy. This allows processes such as
programs, tickets, and policy pack approvals to run automatically. You can restrict user access based on role and type of ownership.

Different workflow stages are automatically assigned to different object owners:

e Ticket, Assessment program, incident, and exception are processes for entities. Therefore, the workflow stage stakeholder is linked to an
entity ownership type.

e Content packs and control objectives contain content objects such as controls and questionnaires that also have owners.

You can also assign users and teams as stakeholders in a workflow. For more information, see About Workflows. Adding, modifying, or deleting an
ownership type requires the Tenant Configure permission.

215



Add A New Ownership Type

Add ownership types to create a new mapping between workflow stages and system users you want to automatically assign to workflow related
actions.

To create a new ownership type:

1. Go to Configuration > Ownership Types.
2. Click New.
3. Enter the ownership configuration:
o |n the Name field, type name that uniquely identifies the ownership type.
o In the Display Name field, enter the name that you want to display in ownership assignment dialog.
For example, the display of an Entity type appears in the list on the workflow stage stakeholder owner roles tab.

o Select the type. Entity: Assign to Entities and the Assessment, Ticket, Exception, and Incident workflows. Policy: Assign to policy
packs and policy workflows.

o Select a role to limit which users can be assigned as the ownership type. The user must have at least one of the roles.
When no roles are selected, any user can be assigned.
4, Click OK.

The new ownership type will display in the list.

216



Delete an Ownership Type

You can delete unused ownership types only. Change the ownership type entity and policy owners or remove the ownership type from the workflow
stage.

To delete an ownership type:

1. Go to Configuration > Ownership Types.
2. Select the ownership types.

3. Click Delete.

The ownership type is removed from the list and is no longer available on corresponding policy, entity, and workflow pages.
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Change the Setting of an Ownership Type

You can change the display name and role restrictions. Modifying role restriction only affects new ownership assignments.

To modify an ownership type settings:
1. Go to Configuration > Ownership Types.
2. Select the ownership type.
3. Click Edit. The Configure Ownership Type dialog appears.
4. Modify the configuration and click OK.

The display name is updated immediately. Role restrictions apply to the next owner assignment.
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Configure Owners

Entity ownership allows RiskVision to automatically assign stakeholders for workflow stages, such as assessments, when the entity is selected for

the process.

Workflow Assessment/
Ticket/Incident/Exception

Entity

CWeer ok SRty Maager

Owvnership

Security Manager CwneT ok Secnriy Manager

H e
|

Tesm

Rary ool

I Ed Smith

To modify owners:

1. Click an entity to open.

2. Go to Ownership, then click Edit.

3. Perform one of the following actions:
o To change the primary owner, select a different user from the primary owner dropdown.
o Toremove an owner, click X in the top-right corner of the window.

o To add another user, click Add Owners.

Select Owners ®x

Owner Type*

| Business Owner A |

Individual Owner*

= aley

Team Owner
| ¥ | Details

m Cancel

The Add Addinal Owners dialogue.

4. Select the ownership type. For more information, see About Ownership Types.

5. Select a user from the individual user dropdown. Skip this option to assign a team only.
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6. Select a team from the Team drop-down. Skip this option to assign a user only.

7. Click OK.

8. Click Save.
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Configure Entity Compliance and Criticality Ranges

The Range option controls the numeric score for the low, medium, and high or VL (very low), L (low), M (medium), H (high), and VH (very high)

selections, as well as the colors and ranges that display in graphs and charts on dashboard pages and reports:

e Compliance range: Controls the numeric values for displaying overall compliance levels, such as on theAssessment Details > Control Results

> Compliance Summary pane.

&y pssessments » d Assessment TCATM39-ENT1
& Assessment: TCA14439-ENT1

Assessment Details | Entity Details { Propagation |

Assessment Summary

4 Back

Overall Compliance Risk Score

-

General
Findings Compliance for Controls in an Assessment Compliance Levels
Control Results No data to display

Responses

Full.25%
Workflow
+ Charts ‘
+ Logs Low,50%
Archives }
<

1%

e Criticality values: Control numeric values for Entity Details > Classification > Security Requirement. The Business Criticality is an average of

the confidentiality, integrity, and availability security requirement settings. It's available on the Assessment Details page and in reports.

;F! Entity Management
) Entity Classification
oy o
r. 4 \.\‘\__ lanaged Entities with Complete Classification lanaged Entities with Criticality

s‘ é?’ 1‘ .
& —ll =
Summary

Create
Reconciliation
Manage

Assessment Progress
Vulnerabilities
Controls & Questions  Entity Ownership

Managed Entities with Primary Owwner

Mo, 1

To modify a range:

1. Go to Configuration> Entity Configuration.

2. Click Ranges.
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Configure Threshold X

Threshold For: Ertity Criticality Configuration Rewvert
Threshold Label Color Display
Less than Unknowyn Gray O @

om0 e R
Bt 1]
veend p ] ke ] e - © o
Between 5 Medumu | [Gold B @® O
and Text  Score
Greater than 7 |High | |Red |- ® O

Text  Score

m Cancel

3. Choose Entity Criticality Configuration and click Edit.

4. Optional: Click + or - to increase or decrease the threshold range. The color will change based on the selected threshold range.

5. Click OK.
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Set the Criticality Rating

The Security Requirements section allows you to manually set the entity criticality.

EE Application: E1

¥ Business Criticality

g Save a Cancel 7y Favorites

General

Assessments Business Criticality [ ] |known

Owners W Security Requirements

Description

Addresses Confidentiality O yninown @ Low ) Medium O High

Classification NGty O yngnown O Low O Medium @ High

Availability ') & ~ i

Costs & Impact Accoumah”i: Unknown . Low Med!um .?. Hfgh

Vulnerabilities ~ Unknown '#' Low '/ Medium '~/ High

Vulnerabilities List W Classification

Relationships Classification Label |__ Salect — v |

Propagation Type Of Data | — Select - v |

Documents Environment Type | --Select - v |
Internal or external |__ Select — v |

Data Feeds

Exceptions

b Tags

P Change History

The Security Requirements section of the Classification tab.

For discovered entities, you can configure a Control Target Profile to automatically set this value.

Criticality is not set when importing vulnerabilities from a saved XML file, even if the vulnerabilities were exported with criticality information.
Vulnerabilities can be imported into other entities, and the criticality cannot be assumed.

Clicking on the Refresh button will manually update the confidentiality, integrity, availability and accountability values of the entity.
These settings are used for.

e Automatically reassessing entities;

e Calculating the simple risk and compliance scores; and

e Calculating the Business Criticality score.

To set the criticality rating:
1. Go to Entities > Entities.

2. Select a group.

Assessments | Content | Analytics | Configuration Show Graph | (_, [Entity name |( searcn |

Entities Enfity Collections Group Definiions Entity Managemeni

# Entities # Entities
My Enfities Actions w 1-20f2
I=I" " Enfities p .
=] &Enlitieswilh IP Addresses [ Details ] [ Delete ] | More Actions... T
1+ ||, My Entities || Show IP Address Filter by | Show all - v | Ca [ Refresh ]

I & Organization Hierarchy

== &MY Favorites (] Mame a Type Subtype Criticality Owner Description
I+ & Recently Viewed
O g.] DesktoplD1012 Computer MIA [ ] pavaniB MIA
08 = Application s [ | pavaniB s
The Entities list.
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3. Select an entity, then click Details.

4. Click the Classification tab, then click Edit.

5. Select the desired radio button in the Security Requirements section,
6. Click Save.

Related scores and settings are immediately updated.
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About Entity Relationships

Entities are related to one another. For example, an application is hosted on a particular computer, or a user has access to a certain application. In
RiskVision, entity relationships model these associations. Once the relationships between entities are understood by the system, you can propagate
controls, risk scores, and other aspects of entities within a given program for use in dashboards and reports.

Relationships between entities have types and are bidirectional. For example, if an application is deployed on a computer, the computer hosts the
application.

Relationship Relationship
Type: Access to Type: Deployed on

Entity Entity Entity
Type: User Type: Application Type: Computer

Relationship Relationship
Type: Accessed by Type: Hosting

Entity relationships allow risks to propagate from entity to entity.

EXAMPLE

Mark has access to a critical business application. He leaves his username and password on a
sticky note on his computer monitor at his desk. Despite the security measures (authorization
and authentication controls) in place on the server, Mark's negligence increases the risk that

an unauthorized person will access the server and application data.

When a parent entity is deleted, the child entities are not automatically included in assessments in which their parents had participated. Entity
relationship propagation settings are disabled by default.
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Relationship Types Overview

RiskVision defines several entity relationship types. Each relationship type includes propagation and inheritance settings that allow the entities to
share controls and show aggregate scores. Propagation and inheritance settings can be specified separately for each direction of a bi-directional
relationship.

e Propagate Control Results: Automatically import questionnaires and check results into assessments of the To entity.

Propagate Risk Score. Shows aggregated scores of all From entity assessments in assessments of the To entity.

Use score with propagate controls.

Only set propagation for policies, results, and scores in one direction of a relationship pair. For example, enable propagation on either the Parent of or
the Child of relationship to avoid looping.

Entity Configuration

Relationship Types

Relationships

Ranges 1-240f24 Show rows

To configure entity relationships:
1.
2.
3.

4.

| More Actions.. ¥ |

Filter by| - Show all - ¥

befween entities

P Propagate Propagate Risk - S
|| From Type a To Type Description Control Results  Score Inherit Tag Criticality
Access relationship . .
|_| Canbe accessedby Has access to between entifies Mo Mo Mo Mo inherit
Parent child
|| Child of Parent of relationship Mo Mo MNo Mo inherit
between entities
Compositicn
|| Consists of Part of relationship Mo Mo MNo Mo inherit
between entities
Service provider
|| Consumes Provides relationship Mo Mo MNo Mo inherit
befween entities
Containment
|| Contains Is inside relationship MNo MNo MNo Mo inherit

The Relationships tab of the Entity Configuration screen.

Go to Configuration > Entity Configuration.

On the Relationships tab, select any of the relationship types.

Click Edit. The Relationship Type dialog displays.

Modify the settings, click OK, and click Save.

Programs and scores for entities with the relationship are updated immediately.
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Predefined Relationship Types

The following types and their inverse are defined by RiskVision. That is, a relationship pair such as Child of/Parent of is specified in either direction. A

source entity can have either the Child of or the Parent of relationship with a target entity. In the following table, the Relationship Type can be
swapped with the Inverse Type.

Relationship type

Can be accessed by

Child of

Consists of

Contains

Depends on

Deployed on

Entity Collection

For

Group

Member of

Program

Owned by

Consumes

Inverse type

Has access to

Parent of

Part of

Is inside

Needed by

Hosting

Member of Entity

Collection

Has

Member of Group

Program

Owner of

Provides

Description

Access relationship between entities

Parent-child relationship between entities

Composition relationship between entities

Containment relationship between entities

Dependency relationship between entities

Deployment relationship between entities

Membership relationship between entities and entity collections

Requirement relationship between entities

Membership relationship between entities

Membership relationship between entities and programs

Owner-ownee relationship between entities

Service provider relationship between entities
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Create Entity Relationships

Relationships can be defined between entities and entity collections.

Because entity relationships are always bi-directional, defining a relationship from one entity to another automatically defines the inverse relationship.
When you define a relationship from one entity to another, two relationships are created. You can define a relationship between one source entity and

more than one target entity, in which case several relationships are created. If you relate one source to three targets, six relationships are created.

For example, if you set the relationship of a user to 'Access to' an application, the system automatically adds the 'Accessed by' relationship to the
application. Removing either 'Access to' or 'Accessed by' removes both definitions.

Relationships immediately affect assessments in progress and are visible in reports and dashboards the next time they run.

By default, control and score propagation settings are disabled. See Configuring Entity Relationship Attributes for more information.
EXAMPLE

You want to establish a parent-child relationship between entity A and entity B. As an entity
owner, you know that an entity A must be the parent of entity B. In this case, you must add a

'Child of' relationship type on the Relationship tab of entity B and select entity A.

To establish a relationship between entities:
1. Go to Entities > Entities.
2. Click an entity to open.

3. Click the Relationships tab.

@) Computer: 10.10.16.101 iy Favoritas

& General REIatiDHShips \_b Relationship Report \_b Relationship Explorer Import Relationship Add Relationship
Owners Type Subtype Name Description Remove
Description
Addresses Needed by
Classification

1 ) MiA 10.1.10.11 MiA Fad
Costs & Impact
Relationships Hosting
Propagation -
1 o M~ Application One MiA Fat

Documents o Pe

Assessments Member of Entity Collection

Vulnerabilities

System Details 1 »® EC Demo EC NiA >

Data Feeds .

¥ Change History
TVM Risk Settings
TVM Risk Report 2a iz ; .
pe Save as C5V | [ Customize Filter by| - Show all - v |[ meresn |
Test ' ’
Operation Type When = Who Changed Attribute Name Managed By

Exceptions
Analytics-Dashboard

ﬁ Mo change records found.

The Relationships table on the Relationships tab.

4. Click Add relationship.
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Add relationship(s) to 10.10.16.101 EH x

-

Relationship® | Select a relationship type v | 0 Please select the entiies that should be added to the relationship with this enfity.

Browse Entfities  Search Entities

Available Entities 4 Page: 1of 22 p Selected Entities

=] & Entities with IP Addresses &By Criticality [ setect Al "] j‘ 10.1.10.11
[+ ||g, By Criticality

+ B . - ** Unfinished - —

ks &k By Operating System O &  vendor v @ 11016102
[+ |8, By Owner Senvice

[+ |, By Type . @ @ 1010716106

. || 10.1.10.11
[+ |, ByOwnerLimitedbyApp o 3‘

[+ ||, Duplicate IP address

, 73] 10.10.16.102
[+ |8, My Entities - g.i
+ B Mewly Discovered Entities -
'g“ T ® @  101016.106
55| & Organization Hierarchy
[+ g Tag Name
& 3 0 @ 101016109
I+ 1%, Unmanaged Entities
B My Favorites o
. , O @& 1010162
I+ |, Recently Viewed
0 @ 1010163
-
-
L] »

The Add relationships dialog.

5. Click Relationship and choose a relationship type.

6. Select an entity group in the Available Entities box, or click Search to find a particular entity using the search criteria. To specify search criteria,
select a field in the first dropdown box, then select a condition in the second dropdown box, and enter the search value in the box. Click + to
add a new search condition. Click Search to retrieve the results for selecting entity(s). To select specific entities, check the box next to entity(s),
or dynamic group, or Select All.

7. Click OK.
The specified relationship is added, as well as the inverse relationship from the target(s) to the original entity.
When a relationship is established with a dynamic group or its member(s):

e Selecting only specific entities within a dynamic group will create a relationship with only those entities.

e Select All will create a relationship with all the selected entities within a dynamic group, but not the dynamic group. Therefore, when members
are added or removed from a dynamic group, the relationship of those entities with the entity collection are not affected.

e Selecting dynamic group will create a relationship with dynamic group itself. This selection creates a dynamic relation with members of the
dynamic group. You must be careful with this selection because when members are added or removed from a dynamic group, their relationshig
with other entities is affected.

e Even though a member is shown on theEntities tab of entity collection, the Relationship tab will not show the EC Member or the Member of
EC relationship type.

To remove a relationship:
1. Go to Entities> Entities and select an entity to open.
2. Click the Relationships tab.
3. Find a the relationship and clickX in the Remove column.
4. Click OK.

The inverse relationship is automatically removed from the related entity.
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Create and Delete Relationship Types

From version 7.0 and later, you can create and delete relationship types when the com.agiliance.asset.enableCreateRelationshipTypes=true property

is added to the agiliance.properties file. You can only delete relationship types that are not in use.

To create a new relationship type:
1. Go to Configuration > Entity Configuration to open the Relationships tab.
2. Click New.

3. Enter the following fields.
o Relationship Name: Name of the relation between entities.

o Inverse of Relationship: Name of the reverse relationship.
o Description: The purpose of this relationship type.

4. Click OK.

User-defined relationship types allow the establishment of a relationship between entities only.

To delete a relationship:
1. Go to Configuration > Entity Configuration to open the Relationships tab.

2. Select a custom relationship type that is not in use, then click Delete.
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Import Relationships

You will need the EntityRelationshiplmportTemplate.xls file to import relationships between entities and entity collections.

To import relationships:
1. Go to Entities > Entities and click an entity to open. Or, go to Entities > Entity Collections and click an entity collection to open.
2. Click the Relationships tab, then click Import Relationship.
3. Click Browse and select the EntityRelationshiplmportTemplate.xls file.

4. Click Open, then click OK.
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Propagation Overview

IT infrastructures are usually complex, with many interconnected systems and components. Propagation allows you to reflect these relationships by
disseminating control results and risks from one entity and/or entity collection down to multiple other entities or entity collections. Generally, with
propagation, you are spreading the results from one to many entities or entity collections, as opposed to doing it from many entities or entity
collections to a single entity or entity collection. In order for propagation to occur, there must be a relationship between entities or between the entity
and the entity collection. Also, propagation must be enabled for the relationship. This allows the entities or entity collection to inherit results from the
related entities or entity collections within a program.

RiskVision uses a publish-auto-subscribe-revocation model for propagation. Before any control results can be propagated, they first have to be
published by a related entity or an entity within the same program for a relationship for which propagation has been enabled. All related entities or
entity collections will automatically inherit the results but can then revoke those results if they decide to meet the control(s) on their own.

RiskVision has the following propagation types:

e Inter system: Propagation that occurs between entities and other entities, between entity collections and other entity collections, or between
entities and entity collections. For example, propagating results for authentication and authorization-related controls from Active Directory to
an SAP financial system.

e Intra system: Propagation that occurs between an entity collection and its members and is meant to capture controls that apply only to the
specific system in question and not other systems or components. For example, Active Directory may provide authentication and
authorization-related services to other systems, but for internal Active Directory components, you may need to propagate results for other
controls, such as whether there is a system security plan in place or whether risk management processes are being followed for the system.
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About Propagation Settings

Entity classification and tags can be inherited from other entities usingentity relationships. Any relationship between two entities can be configured
to propagate control assignments, control results, risk, tags, or criticality. The system is designed to make circular references impossible. Entities

cannot inherit what they propagate.

= Network Device: Router 25006

¥ Business Criticality

I+ Vulnerabilities
[+ System Details
Data Feeds
Exceptions

ﬂ Business Criticality I High

g}/ ¥ Security Requirements

Confidentiality L] Medium
integrity [ High

= General Availability IS High
Owners Accountability L] Medium
i::i::;;:n W Classification
Classification Label /A
Costs & Impac‘t Internal or external NIA
Relationships b Tags
Propagation
e P change History
Assessments

[« Edit & Favorites

Refreshm-

To specify the propagation associated with an entity relationship, go to Configuration > Entity Configuration > Relationships. Click on a relationship

to display the Relationship Type dialog.

Relationship Type X

Relationship Type Name Child of

Description®

Parent child relationship between entitie|

Relationship propagation
Control Results [7]

Risks []
Classification inheritance
Tags [
Criticality ]
Criticality values for related entities
Use the criticality of this entity

Use the highest criticality
Use the lowest criticality

m Cancel

Control results and risks are propagated, but only within a particular program. Propagating control results or risks across programs can be performed

manually. If a control profile is specified, the system uses the control profile and ignores the control assignment.

When propagating criticality, choose the value to use:

e The "from" entity's criticality
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e The highest criticality between the "from" and the "to" entity

e The lowest criticality between the "from" and the "to" entity

Adding entities and then creating a new relationship with an existing entity relationship type requires running theUpdate Objects job to propagate

the scores effectively to the newly added entities. A child entity inherits the security risk score if you configure the parent entity to propagate the risk
score.

EXAMPLE

Your program owner configures each entity with different criticality values. They establish a
parent-child relationship between entities such that the parent entity propagates either

criticality or tags and control results to the child entities.
Run the Update Objects job first before you include entity pairs in an assessment. By doing

so, you can ensure that all the child entities inherit the criticality value of the parent entity.

When you run the assessment, the control results will propagate effectively.
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Visualize Relationships

Relationship visualization allows you to view associations between entities and entity collections for multiple levels of relationships. The
Relationships Report provides the relationships of entity collections with entities, entity collections with other entity collections, and entities with
other entities in graphical form.

To visualize entity relationships:

1

2.

Open the Entities menu, then click Entities to open the Entities grid.
Go to the Entities tree, then expand an entity group.

Click an entity to open.

. On the entity details page, click the Relationships tab. The Relationships tab details are displayed.

. Click Relationship Report. The web browser opens the Relationship Report in a new window.

To visualize entity collection relationships:

1.

2.

Open the Entities menu, then click Entity Collections to open the Entity Collections grid.

Go to the Entity Collections tree, then expand an entity collection.

. Click an entity collection to open.
. Click the Relationships tab.

. Click Relationship Report.
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Relationship Report

The Relationship Report provides visualization tools to study relationships from level 1 to 6. In the Relationship Report, you can use filters, such as
entity types, criticality, and relationships, to exclude unwanted items. The default view includes all of the entity types, criticalities, relationship types,
and level 1 relationships the entity or entity collection has established with other entities and/or entity collections. The level 1 relationship is directly

related to the source entity or entity collection. The graph also displays the criticality colors for the related entity and entity collections.

For each relationship type, the entities will be grouped based on the entity type when the count exceeds the value set in the

com.agiliance.web.visulization.maxentitycountofsametype property.

| 1 Level [)[2]

Overview

‘The graph with level 1
relationship

Summary

S .
relationship |=

W,
Ep e

= E e

BB EpE

eTe 2fe
=@e =@
e cE»

AGLEM )

EE“E E Hierarchic | @E Ii | Entity types = Criticality =  Relationships =

Level 1, 2, and 3 relationships.

In the image above, the arrows indicate the relationships, the label colors associated with entities or entity collections indicate the criticality ratings,

and double-clicking an entity or entity collection displays the details page.
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Relationship Explorer

The Relationships tab for an entity or entity collection shows only the direct relationships of an entity or entity collection and not the indirect
relationships. That is, the relationships of one or more entities or entity collections that are related to other entities or entity collections.

The Relationship Explorer window allows you to drill down into relationships with other entities and entity collections and can be used to show all
the dependencies of a particular entity collection or entities, and not just those that are one level removed from that entity collection.

To open the Relationship Explorer window, select an entity or entity collection to open its details page, click theRelationships tab, and then click
Relationship Explorer at the top right corner of the view.

%) Agiliance Risk¥ision, - Mozilla Firefox

& https:/f10,11.1,35/spcfasset/tabs Entity CollectionTree, jsprisEditing=Falses

Relationship Explorer

—| #. GF_Audit_System
+ g}.EC hdember
= g Parent of
= 8 GF_fcoount_Settiement
+ g}.Member of EC
= g, Child of
,f'GF Augdi &m

| >

[=|

|GF_P.udit_System i= the original entity

htbps: /10, 11.1,35/spcfasset tabs En. . =falsedidString= 16978570595 1570599354

At the top of the Relationship Explorer window, you will see the entity (or entity collection) as a root. When you expand the root, any established
relationships will appear. Expand each relationship type to see with what entities that the root entity is associated. You can also expand other entities

to see if those entities have a relationship with any other entities, and so forth. This will provide an overview of the dependencies of the root entity or
entity collection with the other entities or entity collections.
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Assign a Vulnerability

To assign vulnerabilities to RiskVision objects, such as entities, tickets, controls and subcontrols, select the vulnerabilities by entering the search
criteria. The Select Vulnerabilities interface has search elements with a text box or a check box that you can choose to narrow search results.

Search Element

Title

Identifier

Description

Severity

Source

Secondary Source

Technology

Patch Name

CWE

Other Identifiers

CVSS Score less than

CVSS Score greater than

Published between

Modified between

To assign a vulnerability:

Description

Input the title text to search for vulnerabilities.

Input the alphanumeric character to search for vulnerabilities.

Input the vulnerability description to search for vulnerabilities.

Search for vulnerabilities based on their severity, such as low,
medium, or high. Specify the complete string to search
vulnerabilities based on the severity. For example, "med" will not

return any results.

Search for vulnerabilities based on their source, such as NVDB or

Nessus.

Search for vulnerabilities based on a secondary source, such as a

scanner.

Search for vulnerabilities that are associated with a technology,

such as Microsoft, Symantec, or Oracle.

Search for resolved vulnerability instances for which a patch has

been applied.

Input the CWE value to search for vulnerabilities.

Search for vulnerabilities identified from a vulnerability database

other than NVDB, such as MLIST or Security Focus.

Search for vulnerabilities with a CVSS score less than a specified

value.

Search for vulnerabilities with a CVSS score greater than a
specified value. Use CVSS Score less than and greater than to

find vulnerabilities between a score range.

Search for NVDB vulnerabilities and user-created vulnerabilities

published between a specified period of time.

Search for vulnerabilities modified between a specified period of

time.

1. Follow with the navigation in the following table for the desired object type:
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Object

Entity

Control and Subcontrol

Ticket

Technology

Chart

Navigation

Go to Entities > Entities, then select an entity to open. Click

the Vulnerabilities List tab > Assign.

Go to Content > Controls and Questionnaires, then click a
control or subcontrol to open. Click the References tab >

More Actions > Map to Vulnerability.

Go to Home > Tickets, then click a ticket to open. Click

Linked To > Vulnerabilities tab > Assign.

Open RiskVision Threat and Vulnerability Manager. Go to
Vulnerabilities > All Technologies, then click a technology to

open. Click Vulnerabilities > Link to Existing Vulnerabilities.

Go to Analytics > Charts. Click a chart. Go to the Filters tab,

then click +.

2. Search for vulnerabilities. Click Select Search Criteria and select search elements, or click the Published between or Modified between
checkbox to select a date range. Click Search.

Select Vulnerabilities x

| Severity v |High

| Select search criteria

L2 I

| select search criteria v | |

| | select search criteria

v | |

|« Published between

[2018-01-01] [[g] and [2018-05-11

Matching Vulnerabilities

1-100 of 250 Show rows

| Mare Actions... ¥ |

|| Name

0 Search in the National Vulnerability Database.

A More than 250 vulnerabilities found. Showing first 250.

Page 123 Go

Filter by| - Show all -

v |dentifier

] Modified between

Iﬂ Resclver RiskVision - Google Chrome

O X

A Not secure | pm-ca-edm01.corp.resolver.com/spc/detailjsp?id...

Publish

™! Vulnerability: CVE-2018-6000

[ Edit

BRI 0 LU T BT R

CVE-2018-2998.

General Identifier CVE-2013-6000
Owner N/A
CVSS v2.0 Score References M/A
Severity High

Enhanced Score
Risk Score
Identification

[J CVE-2018-6000

[] CVE-2015-5999

[J CVE-2018-5988

CVE-2018-6000

2018-01-22

CVE-2018-599% 2013-01-22

CWVE-2018-3888 2018-01-24

Likelinood N/A

Weaknesses N/A

Source NVDB
Secondary N/A

ﬂ " Cancel |

Search results are returned using:

Searching for elements in the Select Vulnerabilities dialog.

e The "AND' operator - If the search criteria is applied to the different search elements.

e The "Contains" operator - If the input text is entered for a single search element.

e The "Or" operator - If the search criteria is a comma separated value for the Identifier search element.
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e Select the check box next to the vulnerability, then use the right arrow to move the vulnerability into vulnerabilities to assign pane, and then
click OK. To remove the selection, use the left arrow.
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Operating Systems

Operating systems are available on computer, network device, and mobile device entity types. You can add a new operating system or use an
existing one.

To add an operating system:
1. Open the Entity Details page.
2. Click the System Details tab.
3. Click New to open the Operating System dialog.

4. Enter the following fields:
o Full Name: The application name. This must be a relevant name.

o Description: Any information that describes the operating system.
o Product: The product name. This is a short name for the operating system.

o Version: The version number of the operating system. This will help you notice the differences between the new version and old
version.

o Vendor: The organization's name that is providing the operating system.

o Update: The software revision number, if available. You can derive this field if your operating system includes the most recent fix.
o Edition: The edition, such as standard, professional, or enterprise, if applicable.

o Language: The language, if the operating system is procured for non-native English users.

o Version name: The version name, if available.

o Serial number: The unigue number that identifies the operating system.

5. Click OK.

To assign a predefined operating system:
1. Open the Entity Details page.
2. Click the System Details tab.
3. Click Add to open the Choose Operating Systems dialog.

4. Search using the following fields:
o Title: The operating system's name.

o Version: The operating system's version number.

o Vendor: The vendor's name.
The fields above can be used in combination to narrow the search results.

5. Click Search to view results in the Known Operating Systems box.

6. Click the operating system, then click the arrow pointing towards downward to move the operating system into theSelected Operating
Systems box.

7. Click OK.

To edit an operating system:
1. Open the Entity Details page.
2. Click the System Details tab.
3. Select the box in the corresponding operating system row. You can edit only the user-defined and scanner-imported operating systems.
4. Click More Actions > Edit to open the Operating System dialog appears, where changes to the operating system can be made.
5. Edit the operating system, as needed.

6. Click OK.

To delete an operating system:

1. Open the Entity Details page.
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2. Click the System Details tab.

3. Select the box in the corresponding operating system row, then click Delete.
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Applications

Installed applications can be found on the computer, network device, and mobile device entity types. This data is typically brought in from scanners,
but there may be times when you want to manually update the data.

To add an application:
1. Open the Entity Details page.
2. Click + to expand the System Details tab.
3. Click Applications.

4. Click New to open the Application dialog.
5. Enter the following fields:

o Full Name: The application name. This must be a relevant name.
o Description: Any information that describes the application.
o Product: The product name. This is a short name for the application.

o Version: The version number of the application or product. This will help you notice the differences between the new version and old
version.

o Vendor: The application vendor.

o Update: The software revision number, if available. You can find this field if your application includes the most recent fix.
o Edition: The edition, such as standard, professional, or enterprise, if applicable.

o Language: The language if the application is procured for non-native English users

o System Component: Click Yes if the application is a system component.

6. Click OK.

To assign a predefined application:
1. Open the Entity Details page.
2. Click + to expand the System Details tab.
3. Click Applications.

4. Click Add to open the Choose Applications dialog.
5. Use the following fields to search:

o Title: The application’s title.
o Version: The application's version number.

o Vendor: The vendor's name.
The fields above can be used in combination to narrow the search results.

6. Click Search to view the results in the Known Applications box.
7. Click the application, then click the arrow pointing downward to move the application into theSelected Applications box.

8. Click OK.

To edit an application:
1. Open the Entity Details page.
2. Click + to expand the System Details tab.
3. Click Applications.

4. Select the box in the corresponding application row. You can only edit user-defined and scanner-imported applications, since the applications
that come from the NVD are not meant to be changed.

5. Click More Actions > Edit to open the Application dialog.

6. Make changes to the application, as needed.
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7. Click OK.

To delete an application:
1. Open the Entity Details page.
2. Click + to expand the System Details tab.
3. Click Applications.

4. Select the box in the corresponding application row, then click Delete.
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Ports

Ports are available on the computer, network device, and mobile device entity types. Typically, ports are automatically imported into RiskVision by a
vulnerability scanner, such as the Tenable Nessus Connector or the Qualys QualysGuard Connector. However, there may be times when you want to

manual

Toa
1.

2.

5.

Toa
1.

2.

Toe
1.

2.

Tod
1.
2.
3.

4.

Manually modified port information will be overwritten by scanner data, if it applies to the same entity.

ly modify port data.

dd a port:

Open the Entity Details page, then click + to expand the System Details tab.

Click Ports.

. Click New to open the Port dialog.

. Enter the following fields:

o Name: The port name.

o Protocol: The type of protocol, such as UDP and TCP.
o Protocol Number: The port number.

o Description: The reason for adding the port.

Click OK.

ssign a predefined port:
Open the Entity Details page, then click + to expand the System Details tab.

Click Ports.

. Click Add to open the Choose Ports dialog.

. Use the following fields to search:

o Port Name;
o Port Number; and

o Protocol: TCP or UDP.

These fields can be used in combination to narrow the search results. <

. Click Search to view results in the Known Ports box.

. Click the port, then click the arrow pointing down to move the port into the Selected Ports box.

. Click OK.

dit a port:
Open the Entity Details page, then click + to expand the System Details tab.

Click Ports.

. Select the box in the corresponding port row. You can only edit user-defined and scanner-imported ports.
. Click More Actions > Edit to open the Port dialog.
. Edit the port, as needed.

. Click OK.

elete a port:

Open the Entity Details page, then click + to expand the System Details tab.
Click Ports.

Select the box in the corresponding port row.

Click Delete.
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Perform Entity Actions

Entities can be managed using the actions in the Entities and Entity Collection grids. Entity actions are visible only if you have Entity View and Entity
Manage permissions. These actions provide a convenient way to update all of entities in a dynamic group. Multiple entity attributes can be updated

simultaneously, and entities can excluded or included from participating in assessments.

The following table lists different the available actions and their purpose:

Action

Manage Entities

Unmanage

Entities

Add Operating

System to Entities

Remove
Operating System

from Entities

Add Application

to Entities

Remove
Application from

Entities

Copy Entity

Batch Edit Entities

Save as CSV

Show
Relationship
Graph

Run Contextual

Report

Description

Entities imported into RiskVision must be managed before you can include them in assessments.

Excludes entities from participating in assessments.

Adds operating system information to entities. Use theChoose Operating System dialog to search and select
the operating system. For information about how to add the operating system to entities, see Operating

Systems.

Removes operating system information from entities.

Adds application(s) to entities. Use the Choose Applications dialog to search and select the applications. For

information about how to add the application to entities, see Applications.

Removes application(s) from entities.

Creates a copy of an entity into the selected assessment. While copying choose whether to copy an entity's

attributes. Or use this action to copy an entity's data to other entities.

Select multiple entities to update common attributes simultaneously.

Export entities out of RiskVision in Excel format.

Display a graph showing the relationship between the selected entities.

View a contextual report of the selected entities.

The Export Entities option is configurable. If you have a lot entities, you can choose to turn off the Export Entities option by modifying the
ui.asset.grid.export.enable property.

If ui.asset.grid.export.enable = True, Export Entities will appear in the More Actions dropdown.

If grid.csvexport.all = True, users will be able to export entities to CSV files.
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Entity Attribute Screens

This section provides the list of Entity attribute screens in RiskVision.

:a Vendor: 361 Degrees

i Favorites 4 Back

Address
General
Summary
. 120f2
Ssessments ) )
Addresses | Location - Type Address City State Postal Code Country
Vendor Contacts
Engagements. ] Mailing Primary Address 260 Beach Shanghai CN 24107 China
Documents - . . )
[ ] Billing Billing Address 260 Beach Shanghai CN 94107 China
Engagemnt Summary
The Addresses tab of a vendor.
e )
EE Application: Application One [« Edit  Favorites
Description
General
Assessments Description
Publisher N/A
Owners Version NiA

Accounts N/A
Network Access
IP address N/A
Port{s) M/A
Internet facing N/A

Description
Addresses
Classification
Costs & Impact
Vulnerabilities ¥ Profile Information
Vulnerabilities List Entity Profile(s) _High Baseline
Relationships

Propagation

Documents

Data Feeds

Exceptions

The Description tab of an application type entity.
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Network Interface: 172.31.4.5 [ Edit

Network Interface

General

Network
Unique name 172.31.45
Domain name M/A

Host name 172.31.4.5
MNetwork Interface

AL, If this interface was discovered automatically, it may also be updated or removed automatically. Because of this, changes made
here can be lost without warning.

Description N/A
Friendly name nif 172.31.4.5/32
MAC address 00:03:B2:2A:C3:48
IP address 172.31.4.5
Subnet mask 255.255.255.0
Network address 172.31.4.0
Network zone N/A
Wireless No
Gateway NiA
DNS servers NiA
DHCP Enabled No
DHCP server NiA
DHCF lease obtained N/A
DHCP lease expires NIA
WINS Server No
Primary WINS server N/A
Secondary WINS server Ni&

The General tab of a network interface.

ﬁ Application: Application One G’ Edit 7y Favorites

W Business Criticality
General

Assessments Business Criticality N High
Owners

W Security Requirements -Refresh
Description

Addresses Confidentiality [ High
Integrity | pMedium
Availability I Medium
Accountability [ | Medium

Classification
Costs & Impact
Vulnerabilities
Vulnerabilities List W Classification

Relationships Classification Label NiA

Type Of Data NiA
Environment Type N/A
Documents Internal or external N/A

Data Feeds b Tags

Propagation

Exceptions

b Change History

The Classification tab of an application type entity.

Clicking the Refresh button will:

e Update the criticality based on the classification survey; and

e Update any changes made to the classification through the entity user interface.
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Entity Vulnerability: CVE-1999-0535 on 10.10.16.101 [__'“r Edit

¥ Vulnerability Instance

General
CVSS v2.0 Score Entity 10.10.16.104 External reference MiA
Identification Location 10.10.16.101 Total exposure M/A
Reported by @) eEyeRetina Secondary source N/A
More Information First detected 2015-09-17 Issue Id N/A
References Last detected 2015-09-17 Testuri N/A
Fixed Mo File name M/A
Risk Fixed date NiA Line number M/A
- Severity for this High Discovery method N/A
Entities entity Virtual No
Custom tab 1 Risk for this I High Exception Status M/A
entity Exception Current Stage M/A
Custom tab 2 Resolution Unresolved
status
Enhanced Score Comments MN/A
Risk Score Include in report Yes
Auther N/A
CV55 v3.0 Score CV55 Base 10.0
Score

¥ Vulnerability

Title CVE-1999-0535

% Windows NT account policy for passwords has inappropriate, security-critical settings, e.g. for password length,
password age, or uniqueness.

Identifier CVE-1999-0535
References MN/A
Severity High
Likelihood MiA
Weaknesses N/A
Source National Vulnerability Database

Status N/A
System Info Mew from Feed

0 You can decide to always ignore this vulnerability for all entities by marking it not applicable.

Applicable Yes

The Description of an Entity Vulnerability.
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Contextual Reports of Entities

You can generate reports on more than a single entity or entity collection. For example, you can see all of the vulnerabilities that exist on a dynamic
group containing your Windows and Linux servers. Or, you can generate a consolidated report showing the compliance status of all servers that a
specific employee is responsible for.

With contextual reports you can:

e View reports on dynamic groups. For example, it would be easy to create a contextual report on a given owner's entities and entity collections,
a given type of entity, or any other attribute that can be represented by a dynamic group.

e Use the Advanced Search to precisely define the list of entities or entity collections you want to see and then create a contextual report on

these entities or entity collections. For example, you can search by IP address, discovery source, and entity risk, and then run a contextual
report.

The contextual reporting feature works with both reports that come with RiskVision and reports you define yourself.

To view a contextual report
1. Open the Entities page.

2. Select the required entities, then click More Actions > Run Contextual Report.

Home S Assessments | Content | Analytics | Configuration Show Graph | . [Enfity name Search

Entities Enfity Collections ‘Group Definitions Entity Management

#: Entities #& Entities
By Criticality Actionz w
1-100 of 208 Show rows Page 123 Goto
Entities
Ex i i Details Delete More Acfions.. A
. Entities with IP Addresses ( il | [ Show IP Address Filler by| - Show all- v L [[Revesn | @
+ g, By Criticality B"ﬂ"*: A;‘I'IU"S
elete - B -
+ [, By Operating System (] Name Manags Enities btype Criticality  Owner Description
] &By Owner ———— Unmanage Entities
Add Operating System to Enfities
& (]} 101101 L NiA
‘R By Type o ’ﬁ Remove Operating System from Entities
£ &ByOwnelLimdedbyApp Add Application fo Entities
+ B, Duplicate 1P address (] gj 10.10.16.101 zemo;el.ﬁtsplicaliun from Enfities I MNiA
™ opy Enti
| [fa, My Entities Baich Edit Entifies
+ |, Newly Discovered Eniities (W) @J 10.10.16.102 Save as C5V | Ni&
- . Show Relationship Graph

+! |, Organizaiion Hierarchy Run Contextual Report
+ ||, Tag Name o @ 10.10.16.108 Gustomize A L] Ni&s
+ |, Unmanaged Entities
[+ &My Favorites o @J 10.10.16.109 Computer NIA NiA
+ |, Recently Viewed

O @ nt0as2 Computer Host I i

Running a contextual report.

3. Browse and select the required report. These reports can also be created in JasperReports and run directly from the Entities page.
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Select a Report X

Refresh Repository

-

= anatytics
[=I |y Entities Contextual Reports
=l Y compliance Reports
') &7 Entity Compliance Report

UJ Exceptions Reports
UJ Findings Reports
UJ Incidents Reports
|} Risk Reports
|4 Tickets Reports
[} “ulnerabilties Reports

-

o JE

Selecting a report in the Select a Report dialog.

A contextual report related to the selected entities is generated based on the parameters configured for the selected report in JasperReports Server.

The entities you have selected are passed to the report as parameters.

Create a Contextual Report in JasperReports Server

To create a contextual report to report against entities:
1. Click Analytics > R7 charts to open the JasperReports Server page.

2. Click View > Repository.

AgliiénCE' TIBC® Jaspersoft”  #4 Library View. Manage. Create-
© Folders Repository

= I:‘ Agiliance Run Edit Open Copy Cut Paste Delete
W ad Hoe Components o]
W pashboards
W pomains
4 1nput controls
8] Organizations
W Rreports
Lﬁl Temp
W Themes
W public

Name Description

administrator

There are no resources in the folder.

Help

Q

Sort By: Name | Modified Date

Created ...

Modified...

The Repository page.

3. Click RiskVision > Reports > Entity Contextual Reports.

4. Right-click on the type of contextual report that you want to create, then click Add Resource > JasperReport.
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Spersoft' Library  Vie Manage » Create» Q
olders epository Sort By: Name | Modified Date
11 Folde Repositol " | Modified
=Wl agiliance Run | Edit | Open Copy | Cut | Paste | Delete
[
gdiaclcemecients 0] Name Description Type Created ... Maodified...
W pashboards
M Ermeie Entity Compliance Report Report Today Today
W 1nput controls
Lﬁl Organizations
= 1' Reports
=] 1" Entity Contexual Reports
= Compliance Reports
4 Exceptions Reports Add Folder
W Findings rReports Add Resource  » Domain
W 1ncidents Reparts Copy File »
W risk Reports Cut Input Centrol
U Tickets Reports Delete } JasperReport
W vulnerabilities Reports Parmissions... Content Resource
F 1 Report with multiselect input ) List of Val
Properties... ISt of Values
.
. 8] Temp Mondrian XML/A Source
W Themes Query
W pubic
5. Follow the onscreen instructions to create a new report.
Aglllance TIBC dS[Perso Library  View- Manage~ Create~ administrator  Help Server Q
Add JasperReport:
a
Set Up the Report
Set the required values for the report, then, optionally, proceed to other pages in the flow.
Name:
Controls & Resources Cyber Security]
Data Source
Resource ID (required):
Cyber_Security
Customization
Description:
Locate the JRXML File
® Upload a Local File
Browse...
o
oo

After you have created a report, you can generate this contextual report from theSelect a Report pop-up.
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About Entity Collections

An entity collection system is a type of entity (or asset) that behaves as an entity, but refers to a set of entities, such as a system, process, or
department. If you prefer to use a name other than entity collection, for example, "System," you can rename the term in the UlDictionary.xml file.

Dynamic groups and organization hierarchy containers with entity collections as members will appear in the navigation pane. An entity collection will
appear in the By Criticality, By Type, or Organization Hierarchy pre-configured groups in the Entity Collections grid, by default. To add more pre-

configured groups to the Entity Collections grid, go to Entities > Group Definitions, click Add Pre-Configured Groups, check the box next to the
dynamic groups, and then click Add Groups.

Home

Incidents
Entity Collections

Content | Analytics | Configuration

Entities

Group Definitions

Enfity Management

The Entity Collections tab.

To create an entity collection:

1. Go to Entities > Entity Collections and click New.

Add Entity Collections to your Organization

While adding Entity Collections to your organization, you can manually createfimport from a file.

If you would like to export entity collections, select the folder and choose Expori Entity Collections of the Entity Collections Grid.
Please select how you would like to add new Entity Collection:

(O] Create an Entity Collection

Enter the following information for the enfity collection you wish fo create.
The wizard will guide you to create an enfity collection.

Name* |GF_F‘ ayment_System
Description

Entity Collection Type® | Define an entry b |

PaymentSystems

Primary Owner* |

, Import entity collections from a file

The Add Entity Collections to your Organization screen.
2. Enter a name in the Name field.

3. Optional: Enter a description in the Description field.

Click the Entity Collection Type dropdown and select a sub type, or define a new subtype. As a logged in user, you will be the primary owner
for the entity collection by default. To change the primary owner, choose a name from the Primary Owner dropdown list or click +.
5. Click Next.

. Select an organizational hierarchy container from the Available Hierarchies section, if available.
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Create an Entity Collection

Step 1: Select the organizational unit of the entity collection Skip this option * = required

if the group is undefined.
2. Address
. . If there is an organizational unit associated with the entity collection, select it.
3. Classification
4. DwnerShlp Available Hierarchies Selected Hierarchies
5. Entities 1-30f 3
Filter hy. -Showall - ¥ |[ Refresh ]
| Name Path e
|| Datacenter /Datacenter
[ DNB Group /DNB Group
[ Ha HQ
[ Cancel | [ = Back ] m
The Organization step of the Create an Entity Collection wizard.
7. Click Next.

8. Optional: Enter the entity collection's geographic location.
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Create an Entity Collection x

1. Organization Step 2: Optionally, enter the geographic location of the entity collection. * = required

\ddres Skip this step, select an exisfing location, or choose 'Define a location' to create a new location. Use the other
fields to edit the location. Define / Select a location and enter the details for mandatory fields such as Address 1,

3. Classification City, State / Province, Zip Code / Postal Code.
r— Primary Address

4. Ownership Location

| Select a location r
Address 1

5. Entities

|Ad|:lress 2 |
City
| |

State / Province

Zip Code / Postal Code

Country

Region

Euilding

Floor

[ Cancel | ( < Back ] m

The Address step of the Create an Entity Collection wizard.

9. Click Next.

10. Classify the new entity collection in terms of confidentiality, integrity, availability, accountability, and classification, and specify if it's internal or
external.
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Create an Entity Collection x

1. Organization Step 3: Select the criticality ratings and classification labels. * = required
2. Address Enter the new entity collection's security requirements, criticality ratings, and classification labels.

assiincatio _ N
W Security Requirements
4. Ownership
Confidentiality 'S (] : (®)
e ““ Unknown '~ Low -~ Medium '#' High
5. Entities Intearity . § . .
ntegrity ) Unknown ' Low '® Medium '_' High
Availability Q Unknown Q Low o Medium ® High

Accountability () Unknown Q Low (@] Medium (O} High

¥ Classification

Classification Label Proprietary v |

Internal or external | Internal r |

[ Cancel | ( < Back ] m

The Classification step of the Create an Entity Collection wizard.

11. Click Next.

12. Select a different primary owner, if appropriate. The entity collection must have a primary owner. You can also specify additional owners.
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Create an Entity Collection x

1. Organization Step 4: Add owners involved with processes related to the entity collection. = required

2. Address Add owners involved with the processes related to the entity collection. A primary owner is required.

3. Classification
Owners

ownershio

Primary Owner*
5. Entities | v

Additional Owners:

[ Add Cwners ] [ Delete ] | More Acfions_.. ¥ |

Filter by| - Show all- v |[ Refresn |

| Name « Type Ownership Type

o No additional owners defined.

[ Cancel | ( < Back ] m

The Ownership step of the Create an Entity Collection wizard.

13. Click Next to continue.

14. Click Add.
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Create an Entity Collection x

1. Organization Step 5: Entities * = required
2. Address Select the enfities you would like to add to this entity collection.
3. Classification .
W Entities
4. Ownership
Entities [ Add ] [ Details ] [ Remave ] | More Actions. . A | Filter h\".' Show all - v |[ Refresh ]
. - Dynamic
(W] MName Type Subtype Criticality Owner Groups

0 Mo Entities found.

Cancel

The Entities step of the Create an Entity Collection wizard.

15. Go to the Browse Entities tab > Available Entities and select a group. Or, click Search to search for an entity. After the entity(s) or group is

found, select any appropriate entities, or Select All, or select the dynamic group.

16. Click >>to move the entity(s) or group to the Selected Entities box, then click OK.
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Select Entities

Browse Enfities

Search Entifies

Available Entities
(5] & Entities with IP Addresses
I+ |8, By Criticality

B} & By Operating System

= |, By Type
I£ 7 Agency
I+ Application
55| Business Unit
53] Computer
I Data
53] Device
53] Entity Collection
53] Facility
I+ Mobile Device
I+ Network
I+ Network Device
53]

Organizational Unit

4 Page: 1 of 14

' computer L Select an
O & 101016101

¥ @ 101016102

# @ 101016106

¥ @ 1010.16.109

¥ @ 1010182

¥ @ 1010163

0 & 1010164

2

Selected Entities

E

W
-
W
W

10.10.16.102

10.10.16.106

10.10.16.109

10.10.16.2

10.10.16.3

When adding a dynamic group or its members:

The Select Entities dialogue.

o Selecting only specific entities within a dynamic group will associate only those entities as members of an entity collection.

o Selecting a dynamic group will associate all entities as members of an entity collection. When members are added or removed from a
dynamic group, those dynamic members within an entity collection are updated automatically.

o Select All will associate all entities as members of an entity collection, but not the dynamic group. When members of a dynamic group

are added or removed, those dynamic group members within the entity collection are not updated.

o Entities that are a part of more than one dynamic group will be added only once to an entity collection, even if you add all dynamic

groups containing that entity.

17. Click Finish.The new entity collection will be an 'entity collection' type entity.

To edit an entity collection:

1. Go to Entities > Entity Collections and locate the entity collection that you want to edit using the tree and grid views.

2. Click an entity collection name to open.

3. Select the tab with the information that needs to be edited, such asGeneral, Entities, Description, or Classification.

4. Click Edit and make changes as needed.

5. Click Save.

To delete an entity collection:

Entity collections that are not associated with an assessment can be deleted.

1. Go to Entities > Entity Collections and locate the entity collection to be deleted using the tree and grid views.

2. Select the checkbox next to the entity collection to be deleted.

3. Click Delete, then click OK.
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Entity collection task limitations

There is currently no predefined template for importing entity collections into RiskVision, so they must be entered manually.
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About Entity Collection Details

Unlike with entities, entity collection details tabs do not vary. When you create an entity collection, it's created as 'entity collection' type entity in
RiskVision. As a result, tabs, such as General, Assessments, Owners, Description, Addresses, Classification, Cost & Impact, Relationships,

Documents, and Data Feeds that are commonly available in details page of various entity types can also be found in the entity collection details page.

As a primary owner of an entity collection, it is important to understand the following tabs to configure and manage an entity collection.

Tab

Description

Composition

Displays the number of objects grouped by type that
constitutes an entity collection. Click an entity type to
drill down into all the entities of that type.

Entities

Displays the objects available in an entity collection.
The Entities tab allows you to manage entity
collection members, such as, entities and dynamics
groups. Use Remove option to remove entities that
are a part of dynamic group or entity collection and
choose Remove Dynamic Groups from the More
Actions drop-down list to remove a dynamic group.

263



About Dynamic Groups

Dynamic groups include entities based on matching attribute values and filter conditions. Dynamic groups are used for assessments, displays and
reporting. This feature is useful for managing very large collections of entities, called entity collections.

Dynamic group folders contain dynamic groups and child groups. Dynamic groups are displayed in a pane to the left of the entities and entity
collections grid. For assessments and reports, you can select dynamic groups and child folders, but not top level folders.

Dynamic groups can contain entities and entity collections. When viewing dynamic groups in theEntities grid, you will only see entities. Similarly,
when viewing dynamic groups in the Entity Collections grid, you will only see entity collections. Along these lines, if a dynamic group only has
entities, then you will not see it in the Entity Collections grid, and if a dynamic group only has entity collections, you won't see it in the Entities grid.

The following example shows the default By Criticality group:

& Entities

By Criticality Actions

=\ Enfities
+/ g, Entities with IP Addresses
=I ., By Criticality
+ High
+ Low
+ Medium
+ Unknown
+ g, By Operaling System
+l |, By Owner

The default By Criticality group.

RiskVision automatically creates High, Low, Medium, and Unknown groups.

Performance Note

Be careful when creating dynamic groups that will create thousands of folders, because user interface performance will suffer. For example, do not
create a dynamic group for "By Owner" in a system with 20,000 entities and 10,000 owners. This would create 10,000 folders, which would cause
the system to respond slowly, making it difficult to scroll to the desired folder.
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Default Dynamic Groups

The following table provides a brief description of the default groups available. To add, update, or delete a custom defined dynamic group or a pre-
configured group, you must have Entity View and Entity Manage permissions.

Dynamic Group

Type of Entity

By Criticality

By Operating System

By Subnet

All Vendors

All Processes and Objectives

Active Directory

My Entities

Recently Viewed

My Favorites

Newly Discovered Entities

Description

Groups by Type and Subtype.

Groups all entities based on the business criticality score. The
score is the average of the user defined CIAA rating
(Classification > Security Requirements > confidentiality,

integrity, availability, and accountability).

Groups computers and network devices by operating system

settings (Entity Details > System Details).

Groups computer and network devices by the specific interface
subnet range. The range is calculated using the subnet mask set
on the System Details > Network > Network Interface details
panel.

If the subnet mask is null, the device will display in the top level
folder only, even if the IP address is within a recognized range.

Overlapping ranges are grouped separately.

Lists all vendor type entities.

Lists all process type entities for use with ERM risk assessments

and calculations.

Groups domain entity types. Entities are automatically structured

when using the AD Connector to import Active Directory data

Lists all entities the current user is assigned to as any type of
owner.
User access is also limited by the filters assigned to their user

profile and roles.

Lists the last ten entities the current user has viewed.
The maximum number of entities can be configured in the

Recently Viewed group of the .properties file.

Entities you identified as a favorite on the entity's detail page.

Groups discovered entities (an entity with the General > Entity
Management > Status of Discovered) by operating system,
network subnet, and entity type.

When a connector finds a new entity and imports the details, the

entity status is set to Discovered.
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Dynamic Group dggﬁimmﬁnaged entitites (an entity with the General > Entity
Unmanaged Entities Management > Status of Unmanaged).
Many of the default groups are filtered by Managed status. They

only show entities that have the Managed status.
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Group Applications
The following table describes the group-by options for entity type applications:

Group by Category Description

ApplicationSystem  Internet Creates True, False, and Unknown groups that include application type entities based on the

Flags Facing Description > Network Access > Internet Facing attribute.
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Group Entities By Attributes

Entity options allow you to create groups using attributes that are common to all entity types. Use filters to limit the entities by type.

The group-by options for entities are:

Group by
Entity Address

Entity Classification

Entity Description

Category
Address

Building

City

Country

Name

Postal Code
Region

State

Availability Impact
Availability Score
Classification Label

Confidentiality Impact
Confidentiality Score
Criticality

Criticality Score
Integrity Impact
Integrity Score
Compliance Level
Container Levell
Container Level2
Container Level3
Container Level4
Container Level5
Container Level6
Division

Domain

Installation Date

Internal or External

Inventory Tag
Manufacturer

Model

Organization

Risk Assessment Status
Risk Assessment Next

Review Date (by Month)

Sub Division
Subtype Type

Description

Creates a group for each unique street address.
Creates a group for each unique building name.
Creates a group for each unique city name.
Creates a group for each unique country name.
Creates a group for each unique Location name.
Creates a group for each unique Zip/Postal Code.
Creates a group for each unique Region.

Creates a group for each unique state.

Creates a group for Top secret, Highly confidential, Proprietary,
Internal use only, and Public for the Classification >
Classification Label > Classification Label

Creates a group for High, Medium, and Low or VH, H, M, L, and
VL depending on your Entity Configuration settings for Criticality
ratings. Groups entities by their Business Criticality score.

Custom option that structures user-defined attributes.

Creates a group for each unique General > Organization >
Division attribute.

Note: Used in the structured Organization default

dynamic group folder

Creates a group for each entity type Domain General > Domain
attribute. Used for an Active Directory DN (distinguished name).
Organizational Unit, Domain, Computer, Network

Devices: Creates a group for each unique General >
Maintenance > Installation date.

Account: Creates a group for each unique Description > Create
attribute.

Create an Internal, Public Facing, and unknown group sorts by
the Classification > Classification Label selection.

Creates a group for each unique General > Information >
Manufacturer attribute.

Creates a structured group Type/subtype for each unique
General > Information > Subtype.
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Entity Ownership

Entity Stage
Entity Tag
Entity Vulnerability

User ID — All Owners

User ID — Direct
Ownership

User ID Indirect
Ownership (through a
team)

User Name — All Owners

User Name — Direct
Ownership

User Name — Indirect
Ownership (through a
team)

Stage

Name

CVSS Score

CVSS Vector
Description

Likelihood
Severity
Source
Type

Creates a group, that has the User & Roles > User > Username
field as the group name, for each user who owns an entity
regardless of the ownership role.

Creates a group, that has the User & Roles > User > Username
field as the group name, for each primary owner.

Creates a group that has the User & Roles > User > First and
Last Name fields as the group name, for each user who owns an
entity through a team regardless of ownership role.

Creates a group that has the User & Roles > User > First and
Last Name fields as the group name, for each user who owns an
entity regardless of the ownership role, including users who own
the entity through a team.

Creates a group that has the User & Roles > User > First and
Last Name fields as the group name, for each primary owner.
Creates a group that has the User & Roles > User > First and
Last Name fields as the group name, for each user who owns an
entity through a team regardless of ownership role.

Creates a group for each vulnerability CVSS score of
vulnerabilities assigned to computer and device entities.

Note: Use a filter to match only entities with vulnerabilities, such
as an entity filter with the Vulnerability Name Not Null condition.
Otherwise, the unknown group includes both entities without
vulnerabilities and entities with vulnerabilities that do not have
the CVSS score set.

Creates a group for each unique vulnerability description, see
Vulnerability > Vulnerability List > Vulnerability Details >
General > Vulnerability.

Creates a group for each severity level of a vulnerability.
Creates a group for each vulnerability author or source.
Creates a group for each type of vulnerability.
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Group Computer And Network Devices

The following table describes the group-by options for computer and network device type entities:

Group by
ComputerSystem Address

ComputerSystem Application

ComputerSystem By Date

ComputerSystem Classification

ComputerSystem Description

Parameter

Building
City
Country
Name
Postal Code
Region

State
Application Name

Publisher

Type
Version

Installation Date

Month

Week

Weekday

Availability Impact

Confidentiality Impact

Criticality

Integrity Impact
Domain

Creates a group for each unique parameter

Creates a group for each unique
building name.

Creates a group for each unique city
name.

Creates a group for each unique
country name.

Creates a group for each unique
location name.

Creates a group for each unique
Zip/Postal code.

Creates a group for each unique
Region.

Creates a group for each unique State.
Creates a group for each unique
System Details > Application >
Application name attribute.

Note: When multiple applications are
installed, the system appears in
multiple groups.

Creates a group for each unique
System Details > Application >
Publisher Name attribute.

Creates a group for each unique
System Details > Application >
Version Number attribute.

Creates a group for each unique
System Details > Application >
Version Number attribute.

Creates a group for each unique month
and year of the General > Maintenance
> Installation date.

Creates a group for each unique week
and year, where the first day of the
week is the previous Monday, of the
general > Maintenance > Installation
Date.

Creates a group for each unique date
of the General > Maintenance >
Installation date.

Creates a group for High, Medium, and
Low, or VH, H, M, L, and VL,
depending on your Entity
Configuration settings for criticality
ratings. Groups entities by their
business criticality score.

Creates a group for each unique
Description > Identification > Domain
Name attribute.

Note: The System Details > Network
Domain Name field is the same
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Group by

ComputerSystem Network

ComputerSystem OperatingSystem

ComputerSystem Vulnerability

Parameter
Host Name

Installation Date

Inventory Tag
Manufacturer

Subtype

Subnet

Subnet Mask

OS Name

OS Version

OS Version Name

CVSS Score

CVSS Vector
Description

@dsteytegroup for each unique parameter
Creates a group for each unique
System Details > Network Domain
Name attribute.

Creates a group for each unique
General > Maintenance > Installation
date.

Creates a group for each unique
General > Information > Manufacturer
attribute.

Note: The General > Information >
Manufacturer and Description >
Physical Description Manufacturer field
are the same.

Creates a group for each unique
General > Information > Subtype.

Note: Computer and Network Device
entity types are grouped together
unless you set a filter.

Creates a group for each unique
subnet range. The subnet range is
automatically calculated from the
address settings in the System Details
> Network > Network Interface Card
dialog.

Note: Overlapping ranges are grouped
separately.

Creates a group for each unique
subnet mask of the System Details >
Network > Network Interface Card >
Subnet Mask.

Creates a group for each unique
System Details > Operating System >
Name attribute.

Creates a group for each unique
System Details > Operating System >
Version attribute.

Note: Some connector discovered
computers have the version number in
the OS name field.

Creates a group for each unique
System Details > Operating System >
Version Name attribute.

Creates a group for each vulnerability
CVSS score of vulnerabilities assigned
to computer and device entities.

Note: Use a filter to match only entities
with vulnerabilities, such as an entity
filter with the Vulnerability Name Not
Null condition. Otherwise, the
unknown group includes both entities
without vulnerabilities and entities
with vulnerabilities that do not have
the CVSS score set.

Creates a group for each unique
vulnerability description. See

271



Group by

Parameter

Likelihood
Severity
Source

Type

Sfebner abjlidvprordaataiibiuelpstameter
Vulnerability Details > General >
Vulnerability.

Creates a group for each severity level.

Creates a group for each vulnerability
author or source.

Creates a group for each vulnerability
type.
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Configure Dynamic Group Folders

Modifications to an existing folder take effect immediately. When a group or child folder is part of an assessment, the newly matching entities are
automatically added to the assessment. If the modification removes entities from the group or child folder, the assessments for the entities are
automatically removed from the program. In order to modify an existing dynamic group or create a dynamic group, you must have Entity View and

Entity Manage permissions.

To modify an existing group:
1. Go to Entities > Group Definitions.
2. Click the group, then click Edit to open the Dynamic Group wizard.

3. Enter aName and Description.

Dynamic Group

Step 1: Basic information * = required
2. Group By Enter a name and description for the Dynamic Group.
3. Child Groups
Mame* |Recenﬂ:.' Viewed
4. Filter Descripfion | Group to hold recently viewed

5. Preferences

Cancel < Back m

Step 1 of the Dynamic Group wizard.

4. Click Next.
5. Optional: Configure the dynamic group settings:

o To group applications by flags, click the Application System Flags and Internet Facing checkboxes.
o To group entities by an attributes, select the options from the Grouping Entities table.
o To group computer and network devices, select the options from the Grouping Computer and Network Device table.

o If you skip this option, the folder will display a list of the entities that match the filters.
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Dynamic Group x

1. General Step 2: Select the attribute from which dynamic groups are created * =required
(Optional)

'oUup B5Y

. Dynamic groups can opficnally be configured to automatically group maiching entities. For example if you are
3. Child Groups creafing a Dynamic Group to show Computers, then you can select to group the matching enfities by Operating

System.
4. Filter
5. Preferences
Group By Category | Computer Network ¥
Group By

| Cancel | | <Back |

Step 2 of the Dynamic Group wizard.

6. Click Next.
7. Enter a name that's similar to the value of the attribute that you want to match, then click Add.

The child folder will appear in the Entity and Program Wizard Entity selection trees. RiskVision sorts entities with a matching attribute value
into the appropriate folder and allows prepopulation of values during entity creation for organizations. For example, if you create a Division
child folder called Engineering, the Engineering folder displays on the Organization page of the Entity Wizard. When it is selected, the Entity
Organization/Division is automatically set to Engineering.
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1. General Step 3: Add subfolders (Optional) * = required
2. Group By Child Folders for a dynamic group are calculated dynamically by the RiskVision system. For example, if you
selected the option to group by Computer System 03, then folders like Linux and Windows will be created for you
ld Croup: based on operating systems currently assigned to enfities. This wizard step allows you to specify fixed child
folders. These fixed child folders will be presented to your users even if no entiies match the condition to populate
. this group.
4. Filter

5. Preferences
Create a child folder

Child Folders

Name

ﬂ Mo folders have been created

[ Cancel | ( < Back ] m

Step 3 of the Dynamic Group wizard.

8. Click Next.

9. Select a filter to limit the entities grouped or listed. You can select one filter. To use the Match Filter option to combine multiple filters, see
Configuring filters.

275



1. General
2. Group By
3. Child Groups

5. Preferences

Cancel

* = required

Step 4: Assign filters to the folder (Optional)

The set of entities that are displayed by a dynamic group can be further filtered. Select a RiskVision filter to filter
the set of entities that are displayed for this group.

Available Filters [New Filter]

(=" Filter
My Filters
[+ Shared Filters

Selected Filter
Mo filter selected

10. Click Next.

Step 4 of the Dynamic Group wizard.

11. Select the folder and dynamic group settings, then click Finish.
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1. General Step 5: Select folder and dynamic group node options. * = required

2. Group By Here you can configure the display preferences for your group.

3. Child Groups

4. Filter Show group hierarchy @ Yes ) No
Show this node in the hierarchy @ Yes () Mo
Show child nodes with "unknown” value ) Yes @ Mo
Show child nodes with no value ) Yes @ Mo

Show individual entities as children of this node

Maximum number of children for this node

[ Cancel | [ < Back ] m

Step 5 of the Dynamic Group wizard.

The dynamic group folder displays in the list and entities matching the settings are dynamically grouped on the Entities page.
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Set the Name and Description

Specify the following fields:

e Name: Identifies the folder that contains the dynamic groups and/or child groups.

e Description: The summary that will display on the Group Entities page.
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Set Folder and Grouping Preferences

Folder preferences control how dynamic and child groups display in the Entities tree and Program Wizard Entity selection tree.

3. Child Groups

Cancel

1. General Step 5: Select folder and dynamic group node options. * = required

2. Group By Here you can configure the display preferences for your group.

4. Filter Show group hierarchy O] Yes | B Mo
Show this node in the hierarchy s Yes No
Show child nodes with "unknown” value ) Yes @ Mo
Show child nodes with no value 7y Yes (@) Mo
Show individual entities as children of this node  — ves 5, Mo
Maximum number of children for this node

The folder and grouping preferences in the Dynamic Group wizard.

SETTING

Show group hierarchy

Show this node in the hierarchy

Show child node with Unknown value

Show child node with no value

Show individual entities as children of

this node

DESCRIPTION

Displays dynamic groups in the folder. If disabled, the group will be hidden from users.

Hides the folder that contains the dynamic groups in the Entity and Program Wizard

pages.

Displays Unknown group that contains entities that the group by category attribute that

matches Unknown.

Displays N/A group that contains entities for which the matching group by category

attribute is not defined.

Displays entities in the Entities and Program Wizard Entities tree.
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Organizational Hierarchy Overview

The names and relationships of divisions, departments, and other organizational units within an enterprise can be modeled in RiskVision, and
individual organizational units can be associated with other components of the system.

Organizational Hierarchy & save ) Cancel
Information
General
General
Name*|
Description

The New Organization Group screen.

Organizational units represent a "tree" of nodes. Each node has a single parent node and may have child nodes.

When adding an organization hierarchy node to a profile or other component, use 'Contains.' Do not use the '==' operator.
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Organization Hierarchy Actions

Each node and its child nodes in an organization hierarchy tree can be moved, copied, or deleted using the Actions dropdown menu that appears
when you select a node, or by opening a node's details page and going to the General tab > Actions.

To add an organization hierarchy node
1. Open the Entities menu, then click Group Definitions.
2. Search the node in the Organization Hierarchy tree, then select it. Any child nodes that are available appear in the child hierarchies section.

3. Optional: To move all the child nodes of a node, open the organizational hierarchy tree. Click Actions, then click Cut. Select the node you
want to move the nodes to, then click Paste from the Actions dropdown.

4. Optional: To move a child node, select the node. ClickActions, then click Move To, and then click Go. Select a hierarchy and click OK.

To delete an organization hierarchy node
1. Click Group Definitions on the Entities or Vendors menu.
2. Click a node in the Organization Hierarchy tree.

3. Perform one of the following actions:
o To delete a root node, select a node in the organization hierarchy tree. Click Actions, then click Delete.

o To delete a child node, select a node. ClickActions, then click Delete. Click Go a This provides the ability to retain specific child nodes
if you don't want to delete the complete node from the organization hierarchy tree.

To copy and paste an organization hierarchy node
1. Click Group Definitions on the Entities or Vendors menu.
2. Click a node in the Organization Hierarchy tree. Any child nodes that are available appear in the child hierarchies section.

3. Perform one of the following actions:
o To copy all the child nodes of a particular node, open the organizational hierarchy tree. Click Actions, then click Copy. Select a desired
node to which you want to copy move the node. Click Actions, then click Paste.

o To copy a child node, select the node. Click Actions, then click Copy To, and then click Go. Select a hierarchy, then click OK.

To move an organization hierarchy node
1. Click Group Definitions on the Entities or Vendors menu.
2. Select a node in the Organization Hierarchy tree. Any child nodes that are available will appear in the child hierarchies section.

3. Perform one of the following actions:
o To move all the child nodes of a node, click Actions, then click Cut. Select a node to which you want to move the node. Click Actions,
then click Paste.

o To move a child node, select the node to open its details. Click Actions, then clickMove To, and then click Go. Select a hierarchy and
click OK.
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Enable Organization Hierarchy Selection

When you create a node under the organization hierarchy tree, the new node will not be available for selection in the entity wizard or to be assigned
to an organization group on an existing entity. Configure the following properties to enable its selection:

1. entity.organization.assignment. through.hierarchy= [true |false]
This property displays the new organization hierarchy in the entity details pane when it is set to true. By default, the property is set to false.

2. entity.organization.through.hierarchy= [true |false]

This property allows you to select new organization hierarchy in the entity wizard when it is set to true. By default, the property is set to false.
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Define a New Organization

Entities can be associated with multiple nodes in an enterprise's organizational hierarchy. For example, the hierarchy might be defined by location

and division. An entity might belong to a particular department and may be located in a particular facility.

In previous versions of RiskVision, each entity had single-value fields for organization, division, and subdivision.

Associated nodes are in the organizational hierarchy with an entity on the General tab of the entity.

W Organization Hierarchy

1-1 of 1
fdd Delet More Acfions_. ¥
[20d ] (Deete ] | more actons Filter by| - Show all - v | Refresn |
[ Organization Root a Path Description
(] Datacenter /Datacenter/Florida Datacenter MiA

The Organization Hierarchy in the General tab of an entity.

Your organizational hierarchy defines your enterprise. You can define various hierarchies and combine them to cross-categorize your entities. For

example, your organizational trees might be defined based on:

e Organization: Division, subdivision, department, group.
e Location: Country, region, facility, building, floor, section.

e Function: Retail/b2b, industry, market.

To create an organization node:
1. Go to Entities > Group Definitions and click Organizational Hierarchy in the tree.
2. Click New Organization Group, or navigate to an existing node and click Actions > New Child.
3. Click Go and enter the new child node's name and description.

4. Click Save.
Note:

e Nodes can also be copied, moved, and deleted using the Actions dropdown menu.

e From release 6.5 SP1 HF3 on, the organizational hierarchy supports a maximum number of 15 nodes
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Entity Management

The Entity Management page provides on-going information about entities in your system using dashboards that are available on each tab. To view
dashboards, you must have Entity View and Entity Manage permissions. The following tabs are available on the Entities > Entity Management menu:

Tab Description

Summary Displays a dashboard with the count of managed, unmanaged, discovered, and entity-type entities.

Displays a vertical bar chart of the count of entities that came from multiple sources, such as scanner and user
Reconciliation
created entities.

Manage Displays a grid of the count of discovered, managed and unmanaged entities for each entity type.

Displays dashboards with information on managed entities' classification, criticality and ownership data. Each

dashboard shows "Yes" and "No" followed by a count of entities. The "Yes" followed by a count denotes the number
Classification

of managed entities with that classification, criticality, and ownership. The "No" followed by a count denotes the

number of managed entities with no classification, criticality, or ownership.

Assessment
Displays a dashboard with the workflow stage count of entities.
Progress

Vulnerabilities =~ Displays a dashboard with the count of entities affected by vulnerabilities and entities that have no vulnerabilities.

Controls &
Displays a dashboard that provides the count of entities that have controls and questionnaires assigned to them.
Questions
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About the Content Folders

The Content navigation pane is a hierarchical tree that separates system-provided content from your organization's content.

e RiskVision Content Library: Provides RiskVision-defined, read-only content (documentation, templates, controls, and subcontrols) to enforce,
monitor, and calculate compliance and risk scores based on common industry standards, such as NIST SP 800-53. To enforce controls, the
library includes both automated and manual/questionnaire control checks. In the case of automated controls, the appropriate connectors run
checks on targeted entities and return results to RiskVision. For manual control checks, questionnaires are automatically distributed to the
appropriate entity stakeholders. The questionnaire results are automatically collected.

Controls and subcontrols for the NIST SP 800-53 standard are provided in the Content library by default. Controls and subcontrols for other
standards are available for purchase from Resolver.

e Organization Content - The Organization Content tree is designed to hold the collection of controls you want your organization to use for
compliance and risk measurement. By default, this section includes predefined groups for linking in your own organization's policy documents,
control framework, and individual controls and subcontrols, but you can also create additional subgroups or folders within the current
hierarchy to meet the needs of your organization.

Although users can assign controls directly from the Content Library hierarchy, it is recommended that you assign controls from the
Organization Content hierarchy. Controls in the hierarchy that are linked or copied from the Content Library can be customized for your
environment in the Organization Content hierarchy. This will also assist you in managing updates when you synchronize with changes to the
Content Library.
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Default Organization Content Folders

This section discusses the Organization Content folders that you will find under Controls & Questionnaires in the Content menu. The following table
lists different folders and their purpose.

Default root folder for managing check templates for automated

subcontrols.

Check Templates e Resolver Content folder provides predefined check templates.

e Organization Content folder is empty by default and provides
options for creating the custom check templates.

Organizational Documents/Policies Default root folder for an organization's policy documents.
Organizational Documents/Contracts Default root folder for an organization's contracts.
Controls Default root folder for an organization's controls.

Choice Templates Location of user-defined choice templates.

Default root folder for managing questionnaires that are not
Questionnaires
associated with controls.

User-defined group folders for managing controls and other
By Category cont
content.
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Content Actions Overview

You can use RiskVision content out-of-the-box and apply or assign read-only controls from the Content Library to entities in your enterprise. You
can also create your own customized framework and hierarchy of controls under the Organization Content node in the Controls & Questionnaires
navigation pane. By defining controls in this area, you can leverage existing system-generated content by choosing the frameworks, standards, and
regulations for which you will measure compliance and risk, and then customizing the controls to fit the exact requirements of your organization.

This section describes the actions available for customizing content in the Organization Content hierarchy.

iMore Actions...

Mew Functional Risk Area
Mew Controls with Cortent Wizard
Inzert Content Pack
Corvvert to Cortrols with Flexible Tests
Mew Group
Wieswy Common Controls
Imgport from Excel
Copy To
Maove To
Delete
| Convert Controls to Policy
Detailz
Export
Browse Versions
Save as CSV
Customize

Available
Action Description
from

Create KRI functional risk area that contains key risks. This type of control and subcontrol uses the Key risk indicators

(KRIs) model.

Group The sub controls (questionnaires) also have additional attributes to hold scoring thresholds as well as input values for
number, time and frequency-based reporting. For example, a user may enter multiple sets of values for a
New questionnaire question, where each value corresponds to a point in time. For example, if the question is "Average
BCP Test delay (in days)," the user may enter a value for January, February, and March etc. The user also defines
entities in the program for which assessment questionnaire answers are used to calculate risk scores.

functional
risk area

Content Allows you to group customized content into a package that is processed, from draft to approved state, tracks
Pack changes between content versions, and is published for use in assessments.

Group See Selecting Domain-Specific Controls.

New

Controls

with

Content

Wizard Content
Pack

Insert

Content Group Allows you to create a content pack in a group folder.

Pack

Group See Using Configurable Control Testing.

Convert to
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Controls KX fe
A&tidn Pack Description
Flexible from
Tests
Control
Objective
N Content .
Control Allows you to create a control object.
S Pack
Objective
Content
Pack
New
Allows you to create a new control.
Control
Control
Objective
Promote Control

Changes a control objective to a group.
to Group Objective 9 ! group

Content
New Pack Allows you to create a hierarchical structure in the Organization Content root directory, in a content pack, or control
group (More objective.

actions)

’ Content
Vi
few Pack

Common Displays a list of referenced controls.

Controls (Mc.zre
actions)

Content
Pack
(More
actions)

Copy to Creates a linked copy of the content in the new location.

Control
Objective

Content
Pack
(More
actions)

Move to Cuts .and pastes the selected item from one area to another and updates pointers from other content to the new
location.

Control

Objective

(More

actions)
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Available
Action Description
from
Content

Pack
(More
actions)

Delete Removes content from the system.

Control
Objective
(More
actions)

Content
Pack
(More
actions)

Details Displays all information related to the object.

Control
Objective
(More
actions)

Content
Pack
(More
actions)

Export Creates an XML file that contains all the content and attributes.

Control
Objective
(More
actions)

Content
Pack
(More
actions)

Browse . . . . .

Versions Shows what previous versions contained. Allows you to see differences between selected versions.
Control
Objective
(More
actions)

Customize All Allows you to customize which columns display and their labels in the table.
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About Controls

Under any defined group, subgroup, or control content pack in Organization Content, you can create one or more new control objectives as a starting
point to define one or more controls and subcontrols that address the new control objective.

Control Objective

u‘ﬂ
=
B

| —

Control

‘ Manual Subcontrol

The basic control objective structure.

Notes:
e See About Automatic Controls for more details on checks.

e Control objectives: State the desired result or purpose to be achieved by implementing control procedures in a particular process. Control
objective titles display in the user questionnaire.

EXAMPLE

You have a high-level company policy that specifies:

"Access to information, information processing facilities, and business processes must be
controlled on the basis of business and security requirements. Access control rules must take
account of control objectives and controls for information dissemination and authorization."

In that case, you might specify the following control objective:

"To ensure authorized user access and to prevent unauthorized access to information systems."

e Controls: Address an aspect of the control objective. Under any existing control objective in the Organization Content hierarchy, you can
create one or more new controls, each of which specifies an action or process. The control title is the section title in user questionnaires.

EXAMPLE

You have the following control objective:
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User Access: To ensure authorized user access and to prevent unauthorized access to

information systems.

One of several controls you may put in place to support this objective might be to
implement a user registration control. A statement of that control could be the

following:

"There must be a formal user registration and de-registration procedure in place for

granting and revoking access to all information systems and services."

e Subcontrols: Specify a check or procedure used to enforce or evaluate compliance with the associated control. Under any existing control
in the Organization Content hierarchy, you can create one or more subcontrols (either automatic or manual). The subcontrol question and
choices display in the main pane of the user's questionnaires.

EXAMPLE

You have the following control:

"There must be a formal user registration and de-registration procedure in place for granting
and revoking access to all information systems and services."

One of the subcontrols you may put in place to support or verify compliance with this control
might be to check if there is a process in place and test the process to determine how well it
works. To implement a subcontrol, you can specify automated tests of a control, or create

questionnaire questions that can measure satisfaction with the control and control objectives.

You can assign control objectives or controls to entities in an assessment. If the subcontrol is manual - that is, if users provide answers to
questions - the questionnaire is assigned to the entity owners identified as stakeholders of the information-gathering stage of the workflow
process, as shown below:

Assessment

Entity: computer

.

ntity Owner

[SESAS

Data Gathering

Burvey Oueslions

Stakeholder

Survey

\ = A A

The system produces a questionnaire from the object chosen in Selecting Controls and Questionnaires, where the highest level is the
questionnaire title. The following example shows the questionnaire that is created when the program author selects the ISO-5.1 Control Objective
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and assigns it to an entity:

51k

:

Question 1 of 2 ¥ Help

m Frogress IS

Alignment of strategy and objectives

Does the information secunty policy document contain statements Concaming & statement
of management infent, supporting the goals and principles of information securty in line
wilh the business strategy and objecies?

12 Rt of the information O ating i
security policy Select a rating i

0712 Answered  Hot Started
> O pont know
O et sppkcabie
| — A

Supporting Infor mation

Comments ShiarwiHide
Daficiencies Shirwitide
Remediation Showitide

@ More information [~ Followup @™ Risk Report

=3 Delegate %3 Retresh E

If the program author selected ISO-5.1.1 only, then the questionnaire title would be 5.1.1 Information security policy and the questionnaire would
only contain the questions from the 5.1.1 subcontrols.
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About Controls and Questionnaires

One of the key benefits of RiskVision is the very simple way in which you can organize and assign entire groups of controls (both automated and
manual questionnaire checks) to entities as part of assessments. RiskVision then automatically distributes the controls in a way that ensures you can
enforce or verify compliance with designated controls, measure and calculate overall risk and compliance, and respond with different measures to
track, mitigate, or remediate control violations or failures. With automated controls, results for controls are checked by your system's connectors. For
manual controls (that are verified or evaluated by responses to individual questionnaires), the questionnaires are automatically distributed to entity
stakeholders and the questionnaire answers and results are returned to RiskVision.

To help you choose the controls that you want your organization to adopt, Resolver provides an extensive out-of-the-box control library from which
you can choose the most common frameworks, regulations, best practices, and standards-based controls to use in your own environment. The
RiskVision Content Library provides literally thousands of control objectives, automated and manual controls, and control checks to monitor and verify
compliance with the regulations and standards most widely in use today.
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Understanding Controls and Questionnaires

Before jumping into the creation or customization of your organization’s policy and control framework, it is important to have a basic understanding of
the terminology and components needed to build a policy and control framework.

e Policy and Control Framework or Group Hierarchy At the highest level in the policy, the hierarchy is the organization’s policy or control
framework. This hierarchy groups high-level policies and control objectives. The grouping of control objectives can be based on or include the
“domains” or broad categorization provided by standards-based frameworks such as CobiT, ISO 17799, PCI-DSS, NIST SP 800-53 or SP
800-66. For example, ISO 17799 has domains, or categories, that include areas such as security policy, system access control, computer and
operations management, physical and environmental security, personnel security, entity classification, and control.

The grouping hierarchy can also be of an organization’s own design, such as defining a hierarchy of control objectives based on location,
organizational structure, or stage of deployment. Or, you can combine the hierarchy grouping reflecting the needs of your organization, as well
as take into account those of standards-based frameworks you wish to implement.

e Content Packs: Contains a group of control objectives, controls, and subcontrols, questionnaires and topics, or policy documents for your
organization that you want to develop using the same process and timeline.

e Control Objectives: Within the broader categories of a policy and control framework, policy and control objectives are statements that specify
the objectives for developing and implementing controls (control checks or test procedures) that enforce, check, or verify compliance with
higher-level management goals and objectives. Essentially, the control objective states the desired result or purpose to be achieved by
implementing control procedures in a particular process. For, example, ISO 17799 specifies an Access Control domain to satisfy the high-level
business requirement or policy to properly control access to information in an organization. The control objective, in this case, is that access to
information, information processing facilities, and business processes must be controlled on the basis of business and security requirements.
Access control rules must take account of policies and control objectives for information dissemination and authorization.

e Controls: The terms "policy" and "control" are often misunderstood. They may be interpreted or have a different meanings to people from
different backgrounds, such as security, IT, regulatory compliance, and auditing. In RiskVision, the terms policy and control mean specific rules
of behavior that can be enforced or verified, either through automatically executed subcontrol checks and tests, or responses to questionnaires
distributed to business and technical owners, administrators, or other stakeholders for the relevant entities.

For example, in the Content Library hierarchy, under the ISO Section 11 "User Access Management" control objective, Resolver provides four
unique controls for user registration, privilege management, user password management, and review of user access rights. For each control,
there can be many subcontrols that can be used to check conformance or compliance with the associated control.

e Subcontrols: For each Resolver control, users can define one or more sub-control checks implemented using automatically-run test
procedures or manual control (questionnaire) questions.

Note: For manual controls, questionnaires are distributed to the business owner or other parties (stakeholders) responsible for the associated
entity(s).

For example, in the Content Library > Policies and Controls > Standards > 1SO 17799 > 11 - Access Control > User Access Management
hierarchy, the User Password Management control includes a half dozen or so manual control checks that enforce or verify compliance with
the user password management control policy objectives.

e Control Target Profiles: Named collections of attribute values that define some groups of entities as being similar for the purpose of choosing
controls to evaluate and retrieve control results, since the entities matching the same profile have similar characteristics.
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Control Objectives

Under any defined group or subgroup in Organization Content, you can create one or more new control objectives as the starting point to define one
or more policy controls and subcontrols that address the new control objective. To create a control objective, you must have Control View and Control

Author permissions.

To modify an existing control objective, click Edit.

To create a control objective:
1. Go to Content Risks > Controls and Questionnaires.
2. Expand Organization Content and select a group.
3. Optional: Structure your content in a new root folder by creating a new group.

4. Click New Control Objective.

Group: Controls |_:'r Edit

Group
General

Tags Title Confrols
Description User defined confrols
Target Entity's Preferred Ownership MN/A
Author RiskVision
Group Details MN/A
Identifier N/A

Applications

MNew Content Pack ]I[ MNew Confrol Objective II[ Mew Control ] | More Actions. . v

The General tab.

5. Enter the following fields:

o Title: The label that identifies the control objective.

o Objective: Specifies the purpose of supporting controls that enforce, check, or verify risk measurement and compliance with
organization policies and goals.

o |dentifier: Enter an optional identifier for the new control

o Weight: Indicates the weight assigned to this control objective when paired with others in an assessment. When compliance and risk
scores are rolled up, values are calculated based on the percentage this control object's weight contributes to the total weight of
objectives at the same level in a hierarchy.

o Status: Lets you specify the stage of associated control development or completion. Later on, you can use this information to identify
and track progress in various stages of completion.

o Version: Enter the new control objective's version in any consistent format.
o Categories: Assign a category to the control objective.
o Target Entity's Preferred Ownership: Choose users, teams, and roles to be preferred owners of the new control objective.

o Other Information/Notes: Enter additional information about the control objective.
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MNew Control Objective: Controls

Title* ||

Control Objective -
OBIECHVE | ook to enter text

Identifier

Attributes

Weighl|1_0

Status | Select a stalus

Last updated N/A
Created N/A

Target Entity's
Preferred Ownership

Other Inf Hiom Nt

Author Administrator

o Save 0 Cancel

Version

Categories

O ciick to enter text

The Create Control Objective screen.

6. Click Save.
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Configure Controls

Under any existing control objective in the Organization Content hierarchy, you can create one or more new controls, each of which specifies an
action or process that will address the control objective.

To modify an existing control, click Edit.
To create a control, see Creating a New Control.

In addition to entries on the General tab, you can also click on the Guidance and Risks tab to specify guidance information on how to check the
control, as well as add risks that this control is meant to address.
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Configure Subcontrols

One of the subcontrols you may put in place to support or verify compliance with this control is to check if there is a process in place and test the
process to determine how well it works. To implement a subcontrol, you can specify automated tests of a control or create questionnaires that
measure satisfaction with the control and control objectives. In order to create a new subcontrol, you must have Control View and Control Author
permissions.

To create a new subcontrol:
1. Go to Content > Controls and Questionnaires.
2. Expand Organization Content and select a control.
3. Click New Subcontrol.
4. Click the Create Subcontrol tab and enter the following information:
o Title: The control's label in the Organization Content hierarchy.
o Question text: The question text that displays in the user questionnaire.
o Description: Provides an overview description of the subcontrol entered in WYSIWYG rich HTML format.

o Weight: Indicates the weight assigned to this control. When compliance and risk scores are rolled up, values are calculated based on
the percentage the control's weight contributes to the total weight of controls at the same level in a hierarchy.

o Reference Numbers: Lets you specify information corresponding to related control framework or regulation reference numbers, such
as ISO-17799 1.4.1. To enter multiple reference numbers, you can include the reference numbers in a comma-separated list.

o Help text: The help text for this question in the user questionnaire.
o Assessment Procedures: The procedural text for this question.

o Key Control: Indicates whether this subcontrol must be included when a user selects control options only to implement or use key
controls in measuring risk and policy compliance. In contrast to primary controls, where a user would generally pick one control to rely
on for results, users can generally pick multiple key controls.

5. Set up the answers available to the user in the questionnaire. If you skip this step the default answers will be applied. SeeDefault Question
Settings.

6. Select subcontrols that apply when an answer is chosen.

7. Click Finish.
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Create a New Control

Creating a new control requires you to have Control View and Control Author permissions. There are three types of controls:

e Controls with subcontrols: The most common type of control. A container for specific subcontrols. For example, the control might be "Ensure

physical security" and the subcontrols might refer to specific aspects of physical security.

e Controls with a single subcontrol: Binds a control to a single subcontrol, creating a control that can act like a subcontrol, if necessary. Use this

type of control when a control does not have multiple aspects.

e Audit-friendly controls: Include design and effectiveness tests in order to be self-documenting. For more information, see Using Audit-
Friendly Controls.

Ll New Control: Controls O v Ocancal

Title* | d

Control

Statement Click ta enter text

Control M
Objective

Identifier |

Control (& Predefined Subcortrals (Cortral will have & set of subcontrols as children. New subcontrols cannat
Type he added during assessment. )

O Predefined Single Subcontral (Control iz same as the subcontral, which will he presented at the
contral level during assessment.)

O Flexible Tests and Documentation (Control will allovy creation of tests and documentation an-the-fly
during aszessment.)

Attributes

Status | Selact a status v | Reference
Humbers

Key Control | Mo v |

Version | |

Target
Entity's
Preferred
Ownership Weight (4 g

L))

Avthor Sase §

Last S §

Updated By ]

To create a new control:

1. Go to Content Risks > Controls and Questionnaires.

2. Navigate to a writable control group in the Organization Content tree (control groups in the content tree, for example, are read-only) and click

New Control.

3. Click a Control Type. Selecting the Flexible Tests and Documentation option changes the attributes in the lower part of the screen. For more

information about creating that kind of control, see Using Audit-Friendly Controls.

4. Enter the parameters:

Parameter  Description

Title Enter a name for the new control. This is the only required field.

Enter an optional statement to be associated with the new control. Clicking the field opens the rich text editor.

Control

The control statement specifies the actions or checks that must be provided by supporting subcontrols
Statement

(automated or manual/questionnaire).
Identifier Enter an optional identifier for the new control.
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Parameter
Status

Key

Control

Version

Target

Entity's

Preferred

Ownership

Reference

Numbers

Weight

DeRl&GpaiskAtus, such as Draft, In Testing, Final, or Review. The Status field lets you specify the stage of control
development or completion. Later on, you can use this information to identify and track controls in various stages

of completion.

Choose Yes if this is a key control. The Key Control field indicates whether this control must be included when a

user selects control options only to implement or use key controls in measuring risk and policy compliance.

Enter the new control's version in any consistent format.

Choose users, teams, and roles to be preferred owners of the new control.

Enter any meaningful reference numbers (for example, referring to specific internal or regulatory standards). This
field lets you specify information corresponding to related control framework or regulation reference numbers,
for example, ISO-17799 1.4.1. To enter multiple reference numbers, you can include the reference numbers in a

comma-separated list.

Enter a weight for the new control. The default is 1.0. This value indicates the weight (between 0 and 1)
assigned to this control. When compliance and risk scores are rolled up, values are calculated based on the

percentage this control's weight contributes to the total weight of controls at the same level in a hierarchy.

5. Click Save to create the new control, or Cancel to return to viewing controls.
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Create a Questionnaire

RiskVision has provided many default questionnaires that can be used directly in a program to meet your assessment objectives. If the default
questionnaires don't meet your needs, you can copy them into a custom-defined group under the Controls and Questionnaires group and modify the
questionnaire details, as needed. If the default questionnaires will not produce effective results, you can create a custom questionnaire. However, we
recommend testing the content thoroughly before deploying it. To create a new questionnaire, you must have Control View and Control Author
permissions.

To create a questionnaire:
1. Open RiskVision Policy Manager.
2. Go to Content > Controls and Questionnaires.
3. Expand the Organization Content folder, then click the Questionnaires group.

4. Click New Questionnaire.

5. Enter a name and description, then click the Type dropdown list and select a questionnaire type.

New Questionnaire

Step 1: Name and Description ' = required

2. Additional Text Enter a name for the new questionnaire and optionally add a description, type, and categories to make
A the guestionnaire more useful in the future.
3. Questions

q Hame*
4. Review

Howy often you make sure that vour entities are totally secured?

Deseription

Create different Guestionnaires to assess entities.

Type!

Clazsification w

Author
Administratar
Categories

Cancel Y o > |

The Basic Details tab of the New Questionnaire wizard.

The questionnaire type will determine the pages you see in the New Questionnaire wizard. If you select Contract Awareness Campaign, you
will see Contracts, Text, and Review. For Policy Awareness Campaign, you will see Policies, Text, and Review.

6. Optional: To assign a category to this questionnaire, click+. Click the checkbox for all desired categories, then click OK. If the default categories
do not apply to the questionnaire you are trying to create, enter a category name, then click Add.
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Select one or more Categories X

= .H Categories
D LLE Access contral
D LLE Aszet management
D LLE Business continuity management
D LLE Communications and operations management
D LLE Compliance
D LLE Human resources security
D LLE Information security incident management

D LLE Organization of information security
D LLE Physical and environmental security
D LLE Risk assessment and treatment

D LLE Security policy

D LLE Information =ystems acquisition, development and maintenance

Enter a categary name to add it to the list above

Al

m Cancel

7. Click Next.

8. Expand the Organization Content folder and click the checkbox next to the policies you want to attest in the questionnaire.

9. Click >>to move the policies into the Selected Policies box.
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New Questionnaires X

1. Details Step 2: Policy Chooser * = required
Select policies to attest in the questionnaire.
3. Text Available Policies Selected Policies
4. Review EI" Organization Content ~ a Deployed policy
= Y Policies
| endmnd gea "D
L,
= e
D a Deployed policy
Dﬂdraﬂ policy
® Pl e
- B v e e
- » -— o |
. - T g
. - - . s = I
- & el et %
J e 1Iee 1]
) .
|
) S
§ ey Py
J '
§ -
| ww—— A
Show Draft policies
" cancel  <sack | ([(Z5D
10. Click Next.

11. Enter text in the Introduction Text field, which will appear at the beginning of the questionnaire,and the Closing Text field, which will appear
at the end. For example, you can provide an explanation to stakeholders as to why they should answer the questionnaire. To enter text, click in

the rectangle box area to open the text editor.

12. Click Next.
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New Questionnaires X

1. Details Step 3: Introduction & Closing * = required
2. Policies Enter introduction & closing text.
Introduction Text
4. Review Welcome to the policy attestation
Closing Text

Click to enter text

'.Canoelj i{Backj

13. Verify the controls and the number of questions for a control. Click Back to navigate to the previous wizard pages if you have to make changes
to the entered information. Click Finish when the information you have entered is correct.
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New Questionnaires X

1. Details Step 4: Review and Confirm *=required
2. policies Review the summary and complete the wizard.
3. Text

Name New Policy

Owner Administrater

Canen e D

The Add Risk If unselected, property is set to false, by default.

To change the Add Risk If unselected property to true:
1. Navigate to the agiliance.properties file located at the ||lserverlconfig directory.
2. Change the following property to true:
com.agiliance.risk.addToRiskWhenUnchecked. flag.show=true
3. Optional: If you want to be able to give a risk score for each choice, add the following property to the agiliance.properties file:

com.agiliance.risk.useClassificationSurveyRisk=true
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Create New Questions

You can create a new question on the fly while creating a questionnaire, or after a questionnaire is created. In both scenarios, you must first ensure
that controls are present in the questionnaire. Creating a new question requires you to have Control View and Control Author permissions.

To create a new question:
1. Open RiskVision Policy Manager.

2. Open the New Question wizard using one of the following options:
o Go to Content > Controls and Questionnaires. Expand the Organization Content group under the Controls & Questionnaires group,
and click a Questionnaires group to open. Click a questionnaire or content pack, then click a control, and then clickNew Question.

o On the Questions tab of the New Questionnaire wizard, select a control and click New Question.

3. Enter a name and text for the question. Optionally, enter the description, weight, reference numbers, help text, and assessment procedures.

@Questiun Details 2 Answers 3 Dependencies 4 | Classification

Step 1: Add Questions ' = required
Enter the title and the tex for the question, and optionally specify weight, help text, assessment procedures, and a description.

Hame'

Security Program

(uestion text*

Did you sttend the security program session sz part of induction programme?

Description

I Click ta enter text

Weight
[1.0

Reference Humbers

Help text

I Click ta enter text

Assessment Procedures

I Click ta enter text

Cancel = Back m

4. Click Next.

5. Click the Answer Type dropdown and select the type of answer that you want to make available for stakeholders to answer the question. You
can select radio button, text box, check box, table, time series, or date.

o When the Answer Type selected is Radio buttons, Check boxes, or Table, the wizard will prompt you to select Use the Answer
Choice Template or Create Answer Choice.
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@ Question Details @ Answers 3 Dependencies 4 | Classification

Step 2: Specify Answers ' = required

Question can be of type such as radiohutton, checkhboy, tex, etc. Select appropriate gquestion type and then pravide corresponding answer
choices.

Question Title Security Program

Answer Type | Radio buttons '

O Use the Answer Choice Template
& Create Answer Choices
Answer Choices

Mews | | Edit || Delete | Fiter by |- Show all - v | Refresh [B

. Choice Evidence Exception Comment Deficiency . Add risk if
D Ehipicelica =lletauit Score Required Required Required Required ishScare un-selected
'ﬂ Mo survey guestion choices found.

cancel <gack | ([(ED

m  Use the Answer Choice Template: A dropdown list containing default templates will appear. Select a template to see the
answer choices. To create a new template:

Click +.

Enter a title and description for the new template.

m Click New and edit as needed.

Click OK and ensure that the new template is selected in the dropdown list.

m Create Answer Choices: If selected, perform the following steps:
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Question Choice Editor X

Choice Text*

Choice Score*

Is Default O Yes @ Mo

Evidence Required () Yes @ Mo

Evidence Description |

Exception Required () Yes @ Mo
Comment Required () Yes @ Mo

Implementation Required ) Yes (@ Mo

Risk Score*

| Cancel

1. Click New.

2. Enter the following details:
®  Choice Text: Enter the answer to the question. For example, enter "Yes" as one of the answers to the question.

m  Choice Score: Enter a positive numeric value between 0 and 10.

= |s Default: Select to use the default answer choice.

» Evidence Required: Select 'Yes' if you want stakeholders to attach evidence for their answer choice.

= Evidence Description: Enter a description for the evidence.

m  Exception Required: Select 'Yes' if you want stakeholders to create an exception for their answer choice.

m  Comment Required: Select 'Yes' if you want stakeholders to add a comment for their answer choice.

= |mplementation Required: Select 'Yes' if you want stakeholders to enter a deficiency for their answer choice.

m Risk Score: Enter a positive numeric value between 0 and 10.
= Click OK to add the answer choice.
When the Answer Type selected is Table, the questionnaire is in tabular format. To configure the table format:
1. Go to the Table Configure section.

2. Click Add Columns and Add Rows to add the required number of columns and rows. Enter the required Column Name and
Row Name to be displayed on the table when answering the questionnaire.

When the answer type selected is Text box, the wizard will not require you to add answer choices.

When the answer type selected is Time Series, the wizard will require you to select the Collection Frequency Formats, and units of
metric.

When the answer type selected is Date, the wizard will not require you to add answer choices.

The answers will appear in the Questionnaire window in the order they appear in the Answer Choices section. To change the order,
click the upward or downward arrow in the answer choice row.
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[ Answer Choices

1-20f2

(o | (a1 ] [eite | Fiter by [ Show al | [ Refesn |
[ ves Mo 10 No No Mo No 0 No i3
] ne No 0 No No No No 10 No t 1}

Renaming choice text will not clear the answer choices of a question in target questionnaires. If you have to rename the choice text,
delete the choice text you would like to change first, then create new choice text to replace the deleted text.

6. Click Next.

7. Optional: Add dependent questions for Radio buttons and Checkboxes answer types. Use the answer choices you created in the Answers
wizard page to prompt stakeholders to answer additional questions, or add questions that are answered automatically if a particular answer
choice is selected.To add questions to be prompted or answered automatically, click Add or Remove Questions. Select questions in the
Available Questions box, then click the arrow pointing right to move them into the Selected Questions box. Click OK.

@ Question Details @ Answers @ Dependencies 4 | Classification
Step 3: Specify Dependencies (Optional) ' = required

This step is optional. Select an answer choice and then select dependent questions to prompt. Also, yvou can specify automatic answering
ofthe dependent questions.

R

When response choice is | Yes w |

Then

Prompt the following questions

[ Lol or Remove Guestions ]

GQuestion Title Question Text

ﬂ Mo euestion found.

Auto answer the followving guestions

[ Al or Remove Guestions ]

Question Title Question Text

ﬂ Mo guestion found.

%)
' cancel <Back m

8. Click Next.

9. Optional: Configure a classification rule if the answer type is Radio buttons, Textbox, Table, or Checkboxes. Click Add, then click If the
Selected Answer is and select an answer. Select Set Attribute or Add Risk.

309



@ Question Details @ Answers @ Dependencies G) Classification

Step 4: Configure Classification Rules (Optional) ' =required
Configure classification rdles far the gquestion. Classification canfiguration allows you to set underlying attributes based on the rule
candition.

1-20f2

| add || Delste | Fitter by | - Show all - v || Retrezh [[E

|:| Selected Answer 4 Attribute Type Attribute Value

[ Ha Risk Identification Risk Human error, Improper security

practices

|:| ez Classification Criticality 5

[ Cancel ] [ < Back ] E

e |f Set Attribute is selected, select the attribute and its value, then enter a value in the To field.

New Classification X

ﬂ Please zelect a guestion answer choice first. Then select a classification type and an attribute. Enter
the clazsification value.

If the selected Answer is * |‘r‘es

W
(®) Set sttribute ) Add Risk
Set the value of * | Classification v | criticality v
To* |5| (in numeric value)

m Cancel

e |f Add Risk is selected, expand the Risks folder, select risks, and then click OK.

10. Click Finish.
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11. Click Yes to add more questions or No to exit the confirmation box.
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Select Domain-Specific Controls

Policy authors identify risks in different domains that significantly impact their organization. Creating a control using the content wizard provides the
freedom to select appropriate industry standards, frameworks, and regulatory controls. A user can choose a regulation to build controls that can be
enforced implicitly within a domain. Stakeholders use the content pack to assess the standard controls and subcontrols by performing various
workflow stage actions such as draft, test, and approve prior to control deployment.

To select domain-specific controls:

1. Open RiskVision Policy Manager.

2. Go to Policies > Controls and Questionnaires, and select the desired controls group.

3. Click Actions > New Controls with Content Wizard.

. Frameworks
. Domains

. Filters

Cancel

Create New Controls by Content Wizard

Step 1: Select Regulations

Start with the Regulations that impact yaur arganization. (Chaoices marked by * are not currently

installed atyour site. Please contact Agiliance Sales to purchase additional content.)

Select one or more regulations  Select 411 Clear Al
e 1as0

CeaseL

[ california Privacy Law - G4 1386

Fhda

oL act (15 USC Sec. 6501-6509) 16 CFR 314

fHIPA,

[ sarbanes Oxley

[ eredt card Reguistions - PCI

D Privacy Standards and Regulations
[ other Standards and Framewarks

< Back

' =required

The Regulations page in the Create New Controls by Content Wizard.

4. Select one or more regulations, then click Next.
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Create New Controls by Content Wizard X

1. Regulations Step 2: Select Frameworks ' = required

_ For each selected regulation, choose one or more frameworks vou want to use for the contrals.

. {Framewark chaices marked by * are nat currently installed atyour site. Please contact Agiliance Sales
3. Domains to purchase additional framework content)

4. Filters FISMA  Select &Il Clear &1

FIShA®
MIST 5P 800-53 (2007)*
MIST 5P 300-53 (2009)
HIPAA  Zelect &l Clear &1
MIST B00-66*
MIST 800-66 (2003) with HITECH Act*
HIP&A& [Part 164 - Security and Privacy

Agiliance 17799*

Agiliance 17799 HIGH_LEVYEL

( Cancel | [ = Back ) m

The Frameworks page.

5. Click the checkbox next to all frameworks related to the regulations selected in the previous step.

6. Click Next.
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Create New Controls by Content Wizard X

1. Regulations Step 3: Select Domains ‘= required
2. Frameworks Select Domains to assess for each selected Regulation and Framewark.

b FISMA: HIST SP 800-53 (2009)  Select &l Clear Al 2
4. Filters [JEestended #ssessment Procedures

Information Security Programs
O Management Control Class
O Operstional Control Class
[ rechnical control Class
HIPAA: Agiliance 17799 HIGH_LEVEL  Select &1 Clear &l
D 04 - Risk azsessment and trestment
D 05 - Security palicy
D 05 - Organization of information security
D 07 - Azzet management
D 05 - Human resources security
D 05 - Physical and environmertal security
D 10 - Communications and operations management
041 - access contral
12 - information systems acouizition, development and maintenance
143 - Informetion =security incident management

[T14 - Business continuity management

1z remmlisnce

bd
Cancel <Back m

The Domain page.

7. Click Select All to choose all the domains related to a framework, or select specific domains that are applicable to one of the assessments. For
example, to assess the security-related risks in your organization, you might choose the Information Security Programs domain.

8. Click Next to display.
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Create New Controls by Content Wizard

1. Regulations Step 4: Select Filters ' =required
2. Framewaorks You can filter contrals and sub cantrals to wark on using one ar more options.
S0cnalns Control Types Subcontrol Types
b O Key Controls Only ® al Subcartrols
Control organization O CP level Subcortrols (Primary’) anly
[htake copy of controls (not recommended) O o Subcontrols
D Merge multiple regulatory controls into & single AutoManual controls
tree O auto anly
O Manual only

® Beth

@ Keep redundant controls for reporting

O Drop redundant controls

Cancel = Back m

The Filters page.

To match your business objective, you might want to run concise assessments by using various filters such as subcontrol types, control
organization, auto/manual controls, and redundancy controls.

9. Click Finish.

tﬂ] Content Pack: NISTpack Ul Group: MIST SP 800-53 (2009) |_‘|| Group: Information Security Programs
LY Group: Information Security Programs

Group

Trtle Informstion Security Programs

N The Federsl Information Security Management Act (FISMA) requires organizations to develop and implement sn organization-vwide informstion security program to sddress
infarmation security for the information and information systems that support the operations and assets of the organization, including those provided or managed by another
organization, contractor, or other source. The information security program management (Ph) cortrols described in this Appendiz, complement the security controls in
Appendix F and focus on the organization-wide informstion security requirements that are independent of any particulsr information system and are essential for managing
informeation security programs. Organizetions document program management controls in an organizetion-wice information securty program plan. The organization-wide
=ecurity program plan supplements the individual security plans developed for each organizstional information system. Together, the security plans or the indivicual
informeation systems and the security plan for the information security program cover the totslity of security controls employed by the organization

Tags Target Entity's NiA
Applications Preferred
ownership

Author Agiliance
Group Details N4
Identifier M

Mewe Control Ohbjective Mewy Gugstionnaire Mewy Contral I More Actions... - Fitter by

D Type Order . Title

O 1= 1 P-10 SECURITY AUTHORIZATION PROCESS

D 1= 2 PM-09 RISK MAMAGEMENT STRATEGY

O 1= 3 PM-11 MISSIONBUSINESS PROCESS DEFIMITION

Fl 1= 4 Ph-06 INFORMATION SECURITY MEASIURES OF PERFORMANCE
O 1= El P-05 INFORMATION S STEM INVENTORY
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Configurable Control Testing

Flexible tests and documentation-type controls are designed to be self-documenting, providing a central place to find audit work, such as test scripts,
walk-throughs, and evidence.

This type of control includes a design test and can have an unlimited number of effectiveness tests associated with it. Assessments can include
ordinary controls and flexible types. Questionnaire responders can add effectiveness tests dynamically, but these tests will only apply to that
particular assessment. Likewise, users with sufficient privileges can create tickets to mitigate deficiencies found when testing controls.

A particular role might be permitted to view effectiveness tests, but not to manage them, and to have no permissions regarding design tests.

Control Assessment-type programs can be used, and the content can include the Control Effectiveness Testing workflow. This workflow has stages
for Control Design, Audit, Certify, and Closed.

To create a control for configurable control testing:

1. Go to the Content menu, then click Controls and Questionnaires.

2. Select a writable group in the Organization Content tree, then click New Control.

w

. Complete the name and other fields. Click theFlexible Tests and Documentation radio button.

4. Click the Frequency and Classification dropdown lists and select a value.

New Control: Controls @ save @ cancal

Title* INew control with design and effectiveness tesis

Sta%:rl;:gg: Click to enter text

General

Identifier |

Control Type ~, Predefined Subcontrols (Contrel will have a set of subcontrols as children. New subcentrels cannet be added during assessment.
-

! Predefined Single Subcenfrol {Confrol is same as the subconfrol, which will be presented at the control level during assessment.)

(® Flexible Tests and Documentation (Contrel will allow creation of fests and decumentation on-the-fly during assessment.)

Frequency | Daily v]
Classification | Key control activity v

The Create a new Control screen.

5. Click Save.

To convert an existing control into an audit-friendly control:
1. Open the Content menu, then click Controls and Questionnaires.
2. Select the group or content pack containing the control to be converted.
3. Check the box next to the controls to be converted.
4. Click More Actions > Convert to Controls with Flexible Tests.

5. Make a copy or export the original control if you want to preserve the old type. A design test